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ABOUT THIS MANUAL

This section contains an overview of the information in this document, including the 
following:

• “MIP 5000 VoIP Radio Console Overview”

• “This Manual”

• “Other Manuals and Reference Material”

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

MIP 5000 VOIP RADIO CONSOLE OVERVIEW

The Motorola MIP 5000 VoIP Radio Console system is a radio dispatch system 
composed of MIP 5000 Gateways and MIP 5000 VoIP Radio Console positions 
connected together using an IP computer network. Each MIP 5000 Gateway provides 
the interface between the IP network and the two-way radio. Each MIP 5000 VoIP 
Radio Console position provides a user-friendly graphical user interface (GUI) to 
control a two-way radio system over an IP network. The MIP 5000 VoIP Radio Console 
position consists of an off-the-shelf computer with speakers and a microphone, the 
Windows® operating system (Microsoft® Windows® XP Professional, Vista Business, 
or Windows 7) and Motorola MIP 5000 VoIP Radio Console software.

The MIP 5000 system supports up to 128 MIP 5000 Gateways and up to 100 MIP 5000 
VoIP Radio Console positions. The backbone of the system can be any managed local 
area network (LAN) or wide area network (WAN) that uses IP and supports multicast 
addressing. Each MIP 5000 Gateway provides the interface to a single radio channel. 
Each MIP 5000 VoIP Radio Console position provides access to up to 24 radio channels 
at a time for a single dispatcher, depending on the software license purchased. Different 
combinations of channels can be accessed at a console position at different times by 
loading different console configuration files.

The MIP 5000 system is configured by a Console System Database Manager (CSDM) 
program that can be run on a computer anywhere on the network.
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THIS MANUAL

This manual describes how to use the program to control radio communications.

NOTE

This manual assumes that you already know how to use Microsoft 
Windows. Your Windows documentation describes the general operation of 
the Windows user interface, therefore it is not repeated in this manual.

Chapter 1, describes your console:

• How the screen displays the control for radio communications

• How to press buttons, use menus, and resize windows

Chapter 2, explains how to perform specific tasks; for example:

• How to log in and log out and how to get on-line help

• How to make radio calls, issue pages and make patches

Chapter 3, provides detailed information about each control, button and indicator on 
the console.

Chapter 4, provides detailed information about each command in the menu bar.

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

OTHER MANUALS AND REFERENCE MATERIAL

Related manuals and reference material include:

• MIP 5000 VoIP Radio Console Supervisor Manual (6881013Y33)

• MIP 5000 VoIP Radio Console Installation and Configuration Manual (6881013Y35)
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CHAPTER

1

MIP 5000 VOIP RADIO CONSOLE 

. . . .

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
USER INTERFACE 1

This section is a general overview of the common features and functions of the 
Motorola MIP 5000 VoIP Radio Console program. It includes procedures to customize 
the main window elements.

It is highly recommended that you read this before using your console for radio 
communications.

The common features and functions include:

• “Main Window Layout” on page 1-2

• “Radio Channel Control” on page 1-16

• “Using MIP 5000 Windows” on page 1-32
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. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

MAIN WINDOW LAYOUT

Figure 1-1, “Typical Main Window Layout,” shows a typical screen configuration in the 
MIP 5000 VoIP Radio Console program. The components of the main window are 
described in the following sections:

• “Title Bar” on page 1-3

• “Menu Bar” on page 1-3

• “Toolbar” on page 1-3

• “Status Bar” on page 1-4

• “Miscellaneous Window” on page 1-5

• “Activity Log Window” on page 1-5

• “Multiple Tab Window” on page 1-10

• “Information Window” on page 1-11

• “Patch Window” on page 1-12

• “Volume Window” on page 1-13

• “Notices” on page 1-14

FIGURE 1-1  TYPICAL MAIN WINDOW LAYOUT

NOTE

Your screen might look different, depending on how your system has been 
configured.
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TITLE BAR

The title bar shows the currently loaded user configuration. During the trial period, the 
title bar also displays the time remaining in the trial, after which the program exits.

FIGURE 1-2  TITLE BAR

FIGURE 1-3  TITLE BAR DURING TRIAL PERIOD

MENU BAR

The menu bar contains the drop-down menus for the MIP 5000 VoIP Radio Console. 
The menus are: Console, Edit, View, Tools and Help.

FIGURE 1-4  MENU BAR

Chapter 4, “Menu Commands” describes the menu bar and the operator menu 
commands in more detail.

TOOLBAR

The toolbar contains function buttons that perform specific functions within the 
MIP 5000 VoIP Radio Console. The supervisor assigns resources to the toolbar. All of 
the feature/functions resources available on the console can be placed into the toolbar 
except controls.

The toolbar can be positioned anywhere on the MIP 5000 VoIP Radio Console screen. 
The toolbar can float over the other windows or be docked within the main screen.

NOTE

It is recommended that you put the toolbar in its own row or column (and 
not docked inside other windows in the main screen) to ensure maximum 
visibility of the toolbar buttons.

If you are unable to view the toolbar, contact the supervisor.
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FIGURE 1-5  EXAMPLE OF A TOOLBAR

STATUS BAR

The MIP 5000 VoIP Radio Console includes the Status Bar at the bottom of the program 
window. Figure 1-6, “Status Bar Diagram with Key,” shows:

1. The purpose of, or instructions for, a screen component (instant help)

2. The current status of your console (system messages)

3. If the supervisor has not disabled the Show RTCP alarm feature, this field shows:

Network Audio status: a green background indicates normal operation; a yellow 
background indicates a network audio error; the NET indicator flashes on a 
yellow background if the error affects this console;

Place the pointer over the NET indicator to see the source of the error. Report 
errors to your supervisor.

If the supervisor has disabled the Show RTCP alarm feature, this field always 
indicates normal operation, whether there is an error or not.

4. Clear button; this button does the following:

• Clears the system messages in the status bar

• Clears all channels that are members of an active Multiple Selection

5. The VU (Volume Unit) meter (to indicate signal strength of incoming and 
outgoing select audio)

The VU meter is not affected by paging tones generated internally by the 
MIP 5000 VoIP Radio Console. Paging tones generated by an external pager 
connected to a USB jackbox, however, cause the VU meter to react as if the tones 
were valid voice audio.

FIGURE 1-6  STATUS BAR DIAGRAM WITH KEY
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MISCELLANEOUS WINDOW

The Miscellaneous window stores frequently used Radio Channel controls and/or 
function buttons. This window allows critical resources to be viewed at all times. The 
supervisor assigns resources to this window. 

This window can be positioned anywhere on the main window. The Miscellaneous 
window floats over the other windows or can be docked within the main window.

If you are unable to view the window, contact the supervisor.

FIGURE 1-7  MISCELLANEOUS WINDOW

ACTIVITY LOG WINDOW

The Activity Log window lists all the incoming radio activity for the console as the 
signals arrive. It also lets you quickly re-establish communications with previous 
callers by selecting the entry and pressing the Transmit button. This window is where 
you respond to emergency alarms (silence the alarm, acknowledge the call, and clear 
the emergency).

FIGURE 1-8  ACTIVITY LOG WINDOW 

A record of all DTMF Selective Calls appears in the Activity log window of every 
console with access to the channel, including consoles not targeted by the DTMF 
Selective Call. 

Emergency calls or alarms appear in the activity log as red highlighted calls with 
Emerg Call or Emerg Alarm listed under the Type column.
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Four possible tabs separate the activities in this window: All Calls, Emergency, Select 
and Unselect lists. If configured, each tab list displays the Channel, the Caller ID 
(identification), the Type of call, the time the call started (Time On), the time the call 
ended (Time Off), and the Qualifier for the call. The supervisor determines which tabs 
and columns are visible. See “Activity Log Window Settings” on page 2-16 for 
configuration information.

NOTE

The caller ID and the call type for the following categories of mobile radios 
do not appear in the Activity Log:

• MCS 2000 III

• CDM1550 LS+

The Caller ID and Type columns remain blank for calls from these radios. 
Instead, the received identification for these radios appears briefly in the 
label area of the Radio Channel control each time the mobile operator 
presses the PTT button.

PTT IDs appear in the Activity Log window for XTL5000 Consolette radios 
connected to Digital MIP 5000 gateways. Emergency Call and Emergency 
Alarm call types also appear in the Activity Log window for this model of 
radio. Both MDC 1200 and ASTRO ID types are supported.

When a PTT ID call originates from an Astro Spectra radio, the Caller ID 
appears in decimal format in the Activity Log window and in hexadecimal 
format on the radio itself.

TABLE 1-1  ACTIVITY LOG CALL TYPES 

Type Origin

Ptt ID PTT ID

Call Alert Call Alert

Voice Alert Voice Alert

Selective Call DTMF Selective Call

Emerg Alarm Emergency Alarm

Emerg Call Emergency Call

Acked Emerg Emergency Alarm or Emergency Call acknowledged by a dispatcher

Clear Emerg Emergency Alarm or Emergency Call cleared by a dispatcher

Status: XXX User Status with received status code or ID

Message: XXX Message with received status code or ID

Vehicle: XXX Vehicle status with received vehicle ID
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QUALIFIER COLUMN FOR MOTOTRBO CALLS

The supervisor can enable the display of the Qualifier column in the Activity Log 
window for MOTOTRBO radio information. 

NOTE

No Qualifier is given for AC Stopped, PC Stopped, PC Failed, GC Stopped, 
CA Received, Emerg Alarm, and Emerg Call.

NOTE

Table 1-2 shows the following short forms for Call Events: PC (Private 
Calls), GC (Group Calls), and AC (All Calls).

PC Started Private Call Initiated on MOTOTRBO™ radio connected to gateway 
or Private Call Initiated on another MOTOTRBO radio not connected 
to gateway

PC In 
Progress

Private Call In Progress for MOTOTRBO radio

PC Stopped Private Call Ended for MOTOTRBO radio

PC Failed No Acknowledgement of Private Call initiated by MOTOTRBO 
radio

GC Started Group Call Initiated on MOTOTRBO radio connected to gateway or 
Group Call Initiated on another MOTOTRBO radio not connected to 
gateway

GC In 
Progress

Group Call In Progress for MOTOTRBO radio

GC Stopped Group Call Ended for MOTOTRBO radio

Call Alert 
Sent

Call Alert Initiated on MOTOTRBO radio connected to the gateway

CA Received Call Alert Initiated on MOTOTRBO radio not connected to the 
gateway

CA Failed No Acknowledgement of Call Alert initiated by MOTOTRBO radio

AC Started All Call Initiated on MOTOTRBO radio connected to gateway or All 
Call Initiated on another MOTOTRBO radio not connected to 
gateway

AC Stopped All Call Ended for MOTOTRBO radio

TABLE 1-1  ACTIVITY LOG CALL TYPES (CONTINUED)

Type Origin
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TABLE 1-2  MOTOTRBO ACTIVITY LOG EVENTS IN DIGITAL MODE WITH QUALIFIERS 

Event Origin Caller ID Column Type Column
Time On/Off 

Columns
Qualifier 
Column

Call Events

Start of incoming 
private/group/all 
call

Caller ID or Alias PC Started

AC Started

Time On = Time Off <

GC Started Time On = Time Off < Group ID (no 
aliasing)

Incoming private/
group call in 
progress

Caller ID or Alias PC In Progress

GC In Progress

Time On != Time Off

Time Off is 
displayed when the 
remote subscriber 
releases the PTT 
button

<

Start of outgoing 
private/group/all 
call

Console Name PC Started Time On = Time Off > Callee ID or 
Alias

GC Started Time On = Time Off > Group ID (no 
aliasing)

AC Started Time On = Time Off >

Outgoing private/
group call in 
progress

Console Name PC In Progress

GC In Progress

Time On != Time Off

Time Off is 
displayed when the 
console operator 
releases the PTT 
button

>

Private/group/all 
call ended

N/A PC Stopped

GC Stopped

AC Stopped

Time On = Time Off N/A

Outgoing private 
call not 
acknowledged

N/A PC Failed Time On = Time Off N/A

Call Alert Events

Incoming call alert 
received

Caller ID or Alias CA Received Time On = Time Off N/A

Outgoing call alert 
sent successfully

N/A CA Sent Time On = Time Off Callee ID or 
Alias

Outgoing call alert 
sending failed

N/A CA Failed Time On = Time Off Callee ID or 
Alias
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The Activity Log window can be positioned anywhere on the MIP 5000 VoIP Radio 
Console screen. The Activity Log window can float over the other windows or be 
docked within the main window.

The supervisor can configure what appears in the Activity Log window.

If you are unable to view the window, contact the supervisor. 

Emergency Events

Incoming emergency 
alarm

Caller ID or Alias Emerg Alarm

Acked Emerg

Clear Emerg

Time On = Time Off N/A

Incoming emergency 
call

Caller ID or Alias Emerg Alarm

Acked Emerg

Clear Emerg

Time On = Time Off N/A

TABLE 1-2  MOTOTRBO ACTIVITY LOG EVENTS IN DIGITAL MODE WITH QUALIFIERS (CONTINUED)

Event Origin Caller ID Column Type Column
Time On/Off 

Columns
Qualifier 
Column
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MULTIPLE TAB WINDOW

The Multiple Tab window consists of multiple pages with labeled tabs at the bottom. 
Each tabbed page holds buttons and controls that have been placed there by the 
supervisor. Clicking a tab makes the page it is attached to active, giving you access to 
the features and functions stored on that page. The tabs lets the supervisor arrange 
buttons and controls by task or frequency of use. This is the only window that cannot 
be removed from the main program window.

FIGURE 1-9  MULTIPLE TAB WINDOW

The Miscellaneous and Multiple Tab windows hold the majority of the functions that 
allow you to control all communications. If a resource is on multiple tabs, each resource 
on each tab shows the activity on that resource.

TAB INDICATORS

The tabs visible at the bottom of the Multiple Tab window can be set to change color 
when a call arrives on a radio channel whose control is on a tabbed page that is not 
currently visible. For an emergency radio call, the tab turns red and an aid symbol 
appears.

FIGURE 1-10  TAB INDICATORS
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INFORMATION WINDOW

The Information Window contains the default Page History window and the Radio 
Text window, which is available only for MOTOTRBO channels.

PAGE HISTORY TAB

The Page History tab logs all the pages sent from this console. This window contains 
the following information about the paged calls: type, paging format, code, radio 
channel involved in the page, frequency of the radio channel, status of the page, voice 
annotation and duration of the page.

If a page includes voice annotation, there is an entry for the sent page followed by an 
additional entry for the voice annotation. A voice annotation entry has “Voice Ann” in 
the Type column while the other columns contain no information. For page lists, an 
entry appears for each page in the list, but if there is voice annotation associated with 
any of the pages, only one voice annotation entry appears at the end after all of the 
pages are sent. 

An asterisk beside a page in the Type column indicates that this page was sent with a 
Single Page button.

Successful pages appears in the Page History tab as black text with Pass under the 
Status column; pages that are not successfully transmitted appear in the Page History 
window in red text with Fail under the Status column.

The Page History tab can be positioned anywhere on the MIP 5000 VoIP Radio Console 
main window. The Page History tab can float over the other windows or be docked 
within the main window.

If you are unable to view the window, contact the supervisor.

Page history records for each day are stored in a text file named yyyymmdd.PHF, where 
yyyy is the four-digit year, mm is the two-digit month, and dd is the two-digit day of the 
month. The page history file can be viewed with Notepad or any word processing 
program. A new file is started each day at midnight. There is no practical limit to the 
number of page history files that can be stored.

FIGURE 1-11  PAGE HISTORY TAB
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RADIO TEXT TAB

The Radio Text tab displays a channel’s control head text from an associated 
MOTOTRBO Radio Channel control. 

After you have activated reception of the radio text (by dragging and dropping the 
Radio Channel control into the Radio Text tab), the tab automatically updates with new 
text as it arrives, whether or not the particular MOTOTRBO Radio Channel control is 
selected. Special characters displayed in the radio control head appear in the Radio Text 
window.

NOTE

For a description of the special characters, see “MOTOTRBO Special 
Characters” on page 1-26.

To activate display of the text, you drag and drop the MOTOTRBO Radio Channel 
control to the Information Window. The Radio Text tab opens automatically. The 
association between the Radio Text tab remains until the channel is unmapped, a 
configuration file is loaded, or the radio text tab is removed. The Radio Text tab 
displays MOTOTRBO control head text only.

FIGURE 1-12  RADIO TEXT TAB

PATCH WINDOW

A Patch window lets you group together a set of Radio Channel controls and/or a Call 
Director control so all parties on the radio channels and/or that Call Director in the 
patch can hear and speak to each other. A patch can be thought of as a kind of 
conference call. Up to 16 channels or Call Director calls can be included in a patch.

You can add Radio Channel controls and a Call Director control, activate, transmit and 
clear a patch. MIP 5000 supports one Patch window without memory  
(Patch w/o M) and 10 Patch windows with memory (Patch #, where # can be a number 
from 1 to 10). A deactivated Patch with memory retains its channels after it has been 
activated. A deactivated Patch without memory does not retain its patches after 
reactivation.
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FIGURE 1-13  PATCH WINDOW 

VOLUME WINDOW

This window allows you to adjust the select, unselect and headset ear piece speaker 
volumes. This window can be left floating on your main window or docked alongside 
or between other windows, depending on how your screen has been configured by the 
supervisor.

With the volume controls available on the main window, you can adjust volume levels 
at any time.

FIGURE 1-14  VOLUME WINDOW

NOTE

The Volume Window has no effect on headsets with built-in automatic gain 
control (AGC). Use the controls on these headsets to change the volume.

AGC maintains the sound volume at a predefined level, canceling any 
increase in alarm tone volume through the Escalert feature on MOTOTRBO 
radios.

To change the volume of a speaker, select the slider for that speaker and drag it left or 
right. Moving the slider to the right increases the volume, moving it the left reduces the 
volume. The number to the right of the slide control shows the associated numeric 
volume level (0 - 15).
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NOTICES

When MIP 5000 VoIP Radio Console has important information to communicate to 
you, it displays a notice in the middle of the screen. 

The following notices can appear:

• MIP 5000 HASP Key

• Jackbox Upgrade

MIP 5000 HASP KEY

When first started, the MIP 5000 VoIP Radio Console program is able to run for a 30-
day trial period without being licensed. During the trial period a console can access up 
to 24 channels, depending on the number of channels in the system. The current status 
of the MIP 5000 license can be seen on the About dialog box.

A HASP key is required to license the number of channels required. A HASP key is a 
security dongle that plugs into a USB port. If no HASP key is present after the trial 
period, the notice below appears and you are prevented from logging in. If you see this 
notice on your console, contact your Supervisor.

FIGURE 1-15  MIP 5000 HASP KEY NOTICE — TRIAL PERIOD HAS ENDED

If the HASP license manager service does not respond in the time allotted, the notice 
below appears and you are prevented from logging in.

FIGURE 1-16  MIP 5000 HASP KEY NOTICE — LICENSE NOT AVAILABLE
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If the HASP key is removed, a 10-day grace period allows the console to run until the 
HASP key can be replaced. The grace period ends immediately if you exit the program. 
The notice below appears when you try to exit the MIP 5000 VoIP Radio Console 
program any time after the HASP key has been removed. 

FIGURE 1-17  MIP 5000 HASP KEY NOTICE — EXIT WHILE HASP KEY REMOVED

You can click Cancel to return to the login screen. If you click Exit to close the program, 
a second warning appears, as shown below.

FIGURE 1-18  MIP 5000 HASP KEY NOTICE — EXIT NO HASP KEY FINAL WARNING

If you click Exit, the 10-day grace period that follows removal of the HASP key ends 
and the MIP 5000 VoIP Radio Console program can only be restarted after a valid 
HASP key has been inserted.

JACKBOX UPGRADE

The firmware in a USB jackbox can be set up for upgrade while in service. If a jackbox 
connected to your console finds a firmware upgrade on your console, it displays a 
Jackbox Upgrade notice.

If you see the following notice on your console, contact your supervisor or the system 
administrator.
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FIGURE 1-19  MIP 5000 USB JACKBOX UPGRADE NOTICE

Click OK to close the notice.

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

RADIO CHANNEL CONTROL

In the MIP 5000 VoIP Radio Console, each Radio Channel control represents one 
console audio channel. The control lets you manage the use of a radio channel with 
buttons and indicators, which enable you to make common channel adjustments and to 
monitor the status of the radio channel. The mobile and MOTOTRBO controls also 
have a keypad. The MIP 5000 VoIP Radio Console program contains the following 
types of Radio Channel controls:

• Analog Radio Channel control

• Mobile Radio Channel control

• MOTOTRBO Radio Channel control

The program can have up to 24 Radio Channel controls, depending on the software 
license purchased.

The Radio Channel control contains the buttons and indicators for the associated radio 
channel. It demonstrates the more common channel feature/function adjustments and 
lets you monitor the radio channel status.

FIGURE 1-20  RADIO CHANNEL CONTROL LAYOUT
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Only one radio channel per console audio channel can be selected at a time (unless you 
have multi-selected channels or multiple channels in a patch). A Radio Channel control 
can appear in more than one place in the console user interface, but each instance 
represents the same radio channel.

It is only possible to select frequencies (radio channels) installed on the base station(s) 
connected to the specific console audio channel, and only one radio channel frequency 
per audio channel can be active at a time. All transmit, receive, and monitor functions 
apply to the frequency, or frequencies, of the selected radio channel. Although the 
console is capable of full-duplex operation, the configuration of the base station 
channel, as simplex, half-duplex or full-duplex (different transmit and receive 
frequencies), determines whether the console can transmit and receive at the same 
time. 

Most of the areas of the Radio Channel control are configurable. The features/functions 
and frequencies of the Radio Channel control are initially set through the CSDM (so if a 
feature is not available to you, it might not have been set at the CSDM). From the 
console, you can choose from the available features/functions and assign frequency, 
button, and indicator aliases through the console. A supervisor sets up and configures 
channels using commands available only to supervisors.

TYPES OF RADIO CHANNELS AND CONTROLS: 
ANALOG, MOBILE, AND MOTOTRBO

Radio channels controlled using Local MIP 5000 gateways and Tone MIP 5000 
gateways are sometimes referred to as “analog” channels because the signaling (tone 
codes, for example) used to control them is continuous in nature. Radio channels 
controlled using Digital MIP 5000 gateways are sometimes referred to as “mobile” 
radios because the digital signals used to control them are transmitted by a mobile 
radio set rather than a base station. 

Analog channels offer a smaller range of commands to dispatchers than digital 
channels, and this range is practically the same from one base station to the next. A 
single type of Radio Channel control is able to serve for both tone-controlled and local-
controlled base stations. 

Mobile channels can provide a greater range of commands to dispatchers, and the 
selection of commands vary from one model of mobile radio to another. To 
accommodate this variability, the Radio Channel control for mobile radio channels acts, 
to a certain degree, as an imitation of the control head of a mobile radio. All the buttons 
available on a control head and all the indicators that can be displayed on a control 
head are reproduced in simplified form on the Radio Channel control. A supervisor is 
able to apply aliases to the buttons and indicators that appear on the Radio Channel 
control so that they have the same names as those on the control head.
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The MOTOTRBO gateway is controlled using a unique MOTOTRBO signaling type. 
The MOTOTRBO Radio Channel control reproduces the control head of the 
MOTOTRBO radio, enabling the console user to perform virtually all the same tasks as 
radio users. MOTOTRBO radio channels receive and transmit on both analog and 
digital radio frequency channels. As a result, the MOTOTRBO shortcut menus and 
indicators are unique to MOTOTRBO radios.

The three types of Radio Channel controls differ in the following respects:

RADIO CHANNEL CONTROL COMPONENT 
DESCRIPTIONS

LABEL AREA

The label area at the top of the Radio Channel control, uniquely identifies the name of 
the radio/channel, the frequency (radio channel), status and the caller unit 
identification number (or Alias if available)/MDC message. The analog Radio Channel 
control has a two row label area, in which each row contains two lines. If the available 
information for a channel does not require all four lines, the information display is 
resized to accommodate the actual number of lines. For example, two lines are shown 
using a larger font that occupies two lines; three lines are shown as one line with a 
larger font and two lines with smaller fonts. 

Each multi-frequency channel can be configured at the CSDM with up to 16 
frequencies. A supervisor can also assign frequency names (aliases) in the program. 

When a Radio Channel control that is mapped to a console fails, it appears dimmed 
and a red X appears in the label area of the Radio Channel control. When the Radio 
Channel control is reactivated or the failure is corrected, the Radio Channel control 
returns to its normal state.

Analog Radio Channel 
Controls

Mobile Radio Channel 
Controls

MOTOTRBO Radio 
Channel Controls

• Standardized shortcut 
menu

• Shortcut menu varies by 
radio model

• MOTOTRBO radio-
specific shortcut menu 

• Standardized indicators • Indicators vary by radio 
model

• MOTOTRBO radio-
specific indicators

• Maximum of two rows 
in label area

• Maximum of three lines 
in label area

• Maximum of three lines 
in label area
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FIGURE 1-21  FAILED RADIO CHANNEL CONTROLS

ANALOG RADIO CHANNELS

The analog Radio Channel control has two rows in its label area. Each row can display 
either one line of full-size text or two lines of half-size text. The radio channel name is 
displayed in full-size text on the first row whenever there are no inbound 
transmissions.

If the channel uses multiple frequencies, the frequency name is displayed in full-size 
text on the second row whenever there are no inbound transmissions. The channel 
name of multi-frequency channels and the frequency name are displayed in half-size 
text whenever a PTT ID is received.

When a PTT ID is received, it is displayed in the second row; over a whole row if no 
inbound call information (such as status, message number, or call type) is received at 
the same time. If a text message (such as MDC or STAT-ALERT messaging) is received, 
the PTT ID is displayed on the first line of the second row at half size. If an inbound call 
information is received, it is displayed on the second line of the second row.

FIGURE 1-22  ANALOG RADIO CHANNEL CONTROLS — ALL FULL-SIZE TEXT

Channel Name only — One 
Frequency, No PTT ID, No 
Inbound Call Information

Channel Name and 
Frequency Name — No PTT 

ID, No Call Information
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FIGURE 1-23  ANALOG RADIO CHANNEL CONTROLS — WITH HALF-SIZE TEXT

MOBILE RADIO CHANNELS

The mobile Radio Channel control has three rows if configured with the Display 
Channel Name option. Otherwise, it has two rows. The second and third rows display 
either text from the mobile radio control head connected to the Digital MIP 5000 
Gateway or text sent by the calling subscriber radio, depending on the type of radio 
and its configuration. When the Display Channel Name option is disabled, these items 
shift up to replace the row that had been used for the channel name.

FIGURE 1-24  MOBILE RADIO CHANNEL CONTROLS — WITH DISPLAY CHANNEL NAME

Channel Name and 
Frequency Name with 
PTT ID or Caller ID — 

No Inbound Call 
Information

Channel Name with 
PTT ID or Caller ID 
and Inbound Call 

Information— One 
Frequency

Channel Name and 
PTT ID or Caller ID — 

One Frequency, No 
Inbound Call 
Information

Channel Name and 
Frequency Name with 

PTT ID or Caller ID 
and Inbound Call 

Information

Channel Name with a Single 
Line of Radio Control Head 

(RCH) Text from unit 
connected to gateway

Channel Name with Two Lines 
of Radio Control Head (RCH) 
Text from unit connected to 

gateway
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FIGURE 1-25  MOBILE RADIO CHANNEL CONTROLS — WITHOUT DISPLAY CHANNEL NAME

MOTOTRBO RADIO CHANNELS

The MOTOTRBO Radio Channel has three rows if configured with the Display 
Channel Name option. Otherwise, it has two rows that displays text from mobile radio 
control head connected to the MOTOTRBO Gateway. 

When the Display Channel Name option is disabled, these items shift up to replace the 
row that had been used for the channel name. 

FIGURE 1-26  MOTORBO RADIO CHANNEL CONTROLS — WITH AND WITHOUT DISPLAY 
CHANNEL NAME

NOTE

Text from the MOTOTRBO radio head text display also appears in the 
MOTOTRBO keypad and the Radio Text tab of the console Information 
Window after the Radio Channel control is dragged and dropped into the 
tab.

Single Line of Control Head 
Text (RCH) from unit 

connected to gateway

Two Lines of Radio Control 
Head text (from subscriber 
unit) or Control Head Text 

(from unit connected to 
gateway)

Channel Name with two lines 
of Control Head Text (from 
unit connected to gateway)

Two lines of Control Head Text 
(from unit connected to 

gateway)
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Text displays in MOTOTRBO contain special characters that represent the characters 
that appear in the radio control head. For a complete list of characters, see 
“MOTOTRBO Special Characters” on page 1-26.

INDICATOR AREA

The indicator area in the center of the Radio Channel control, has two fixed and eleven 
configurable indicator spaces. The Call and Transmit indicator spaces are not 
configurable. 

Many of the function buttons work with the Radio Channel control to activate their 
entitled function on the selected radio channel. Thus, many of the indicators show the 
use and status of this Radio Channel control. For example, when a patch is active, a 
patch indicator appears on the Radio Channel control(s) that is/are involved in the 
patch.

BUTTON AREA

The button area at the bottom of the Radio Channel control provides you with a 
possible combination of four buttons that allow you to control common radio channel 
and frequency adjustments. The Mute and Instant Transmit buttons are not 
configurable. Some radios types do not have the Up and Down buttons. For radios that 
have the Up and Down buttons, a supervisor can assign them to perform many 
different functions or remove them from the control.

RADIO CHANNEL SHORTCUT MENU

When you click on the indicator area of the Radio Channel control, a shortcut menu 
appears. The shortcut menu contains the controls specific to the radio. A supervisor can 
assign or remove controls on the shortcut menu. A Keypad View/Command View 
indicator in the Close Shortcut Menu area enables you to toggle between the Keypad 
and list of commands on mobile and MOTOTRBO controls.
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FIGURE 1-27  RADIO CHANNEL SHORTCUT MENU

A channel-specific shortcut menu units allows you, for example, to adjust the channel 
volume, display the patch state of this radio channel, accesses previous radio callers 
(Unit ID), plus change and/or enable/disable the various indicators.

NOTE

Activating feature buttons (or commands) can sometimes affect an indicator. 
The buttons control either MIP 5000, base station or radio features. For 
further information about buttons, controls, and indicators, see “Buttons, 
Controls and Indicators” on page 3-1.

KEYPAD

MIP 5000 VoIP Radio Console features two types of keypads, depending on the Radio 
Channel that it is associated with:

• Mobile Keypad

• MOTOTRBO Keypad

Both types are accessible directly from the Radio Channel control Shortcut Menu 
through the Keypad View toggle button.
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FIGURE 1-28  KEYPAD ACCESS

MOBILE KEYPAD

The mobile keypad is a numerical keypad for entering numbers (for instance, unit IDs). 

FIGURE 1-29  MOBILE KEYPAD

NOTE

The keypad cannot be used to dial telephone numbers.

MOTOTRBO KEYPAD

The MOTOTRBO keypad contains features that enable you to navigate the 
MOTOTRBO radio menu, enter text messages, and display radio and operator-
generated text. 
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FIGURE 1-30  MOTOTRBO KEYPAD

NOTE

Among the alphanumeric keys is the key. A long press on the key puts 
the Radio Channel control text in CAPS-LOCK mode.

The keypad displays text from the radio control head. The Left Arrow and Right 
Arrow command keys enable you to scroll through messages that appear on the radio 
console display. Although the MOTOTRBO radio supports multiple languages, the 
appearance of characters from some languages—such as Chinese, Japanese, and 
Korean—might not be displayed properly in the keypad text display on the console.

FIGURE 1-31  MOTOTRBO KEYPAD LEFT ARROW AND RIGHT ARROW KEYS

Other command keys enable you to navigate through the Radio Channel control menus 
and lists in the Text Display:

• The Menu key opens a list of high-level menu items that can be navigated using 
arrow keys on the keyboard. 

FIGURE 1-32  MOTOTRBO KEYPAD MENU KEY

• The OK key indicator confirms the intended action and enables selection of a sub-
menu item. 
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FIGURE 1-33  MOTOTRBO KEYPAD OK KEY

• The Back/Home key returns you to the top of the menu in the MOTOTRBO 
keypad.

FIGURE 1-34  MOTOTRBO KEYPAD BACK/HOME KEY

NOTE

The commands invoked by the Keypad keys can be configured to appear in 
the Shortcut menu.

MOTOTRBO SPECIAL CHARACTERS

To accurately display the text from the MOTOTRBO radio console head, the label area 
of the Radio Channel control reproduces special characters from the control head text 
display.

TABLE 1-3  MOTOTRBO SPECIAL CHARACTERS AND DESCRIPTIONS  

MOTOTRBO Character Description

Group Call/All Call

Private Call

PC Call

Dispatch Call
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Sent Successfully

Send Failed

In-Progress

Tick

Scan 1

Scan 2

Contacts (Normal as shown)

Selected Contacts appear in brackets [ ]

Disabled Contacts appear with a diagonal bar \ 
through image

Scan (Normal as shown)

Selected Scan appear in brackets [ ]

Disabled Scan appear with a diagonal bar \ 
through image

Zone (Normal as shown)

Selected Zone appear in brackets [ ]

Disabled Zone appear with a diagonal bar \ 
through image

Messages (Normal as shown)

Selected Messages appear in brackets [ ]

Disabled Messages appear with a diagonal bar 
\ through image

TABLE 1-3  MOTOTRBO SPECIAL CHARACTERS AND DESCRIPTIONS  (CONTINUED)

MOTOTRBO Character Description
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Call Log (Normal as shown)

Selected Call Log appear in brackets [ ]

Disabled Call Log appear with a diagonal bar \ 
through image

Utilities (Normal as shown)

Selected Utilities appear in brackets [ ]

Disabled Utilities appear with a diagonal bar \ 
through image

TABLE 1-3  MOTOTRBO SPECIAL CHARACTERS AND DESCRIPTIONS  (CONTINUED)

MOTOTRBO Character Description
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ACCESSING THE RADIO CHANNEL CONTROL 
SHORTCUT MENU

Use this procedure to access the Radio Channel control shortcut menu:

ADJUSTING THE RADIO CHANNEL VOLUME 
(SHORTCUT MENU)

To adjust the volume for this radio channel, use the volume slide control located at the 
top of the Radio Channel shortcut menu or, if configured, the Up/Down volume 
buttons on the Radio Channel control. See “Increasing and Decreasing the Radio 
Channel Control Volume” on page 2-27 for the procedure.

PROCEDURE 1-1  HOW TO ACCESS THE RADIO SHORTCUT MENU 

1 Choose the channel state indicator area on the Radio Channel control.

OR 

Use SHIFT + F10 on your keyboard when the focus is on this channel.

Result: The radio shortcut menu appears.

NOTE

Features/functions are only available on radio channels that 
have been enabled at the CSDM. However, their availability 
also depends on the type of radio channel and mobile model.
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ACTIVATING RADIO CHANNEL CONTROL FEATURES 
(SHORTCUT MENU)

Follow this procedure to adjust the channel features available on the Radio Channel 
shortcut menu:

PROCEDURE 1-2  HOW TO CHANGE RADIO CHANNEL FEATURES (SHORTCUT MENU) 

1 Access the Radio Channel control shortcut menu.

2 If a feature has a drop down menu associated with it, a down arrow 
appears beside the feature name. Choose the desired feature’s down arrow 
to access the drop down menu and choose the desired option from the list. 
The option is now activated.

OR

To enable/disable features choose the name area of the desired indicator:

2.1 If the name area is depressed, this indicates that this feature is active 
(enabled). On some features, the shortcut menu indicator changes to 
reflect the features state.

This feature appears in the status area of the Radio Channel control.
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2.2 If the name area is not depressed (appears normal), this indicates that 
this feature is not active (disabled).

This feature’s indicator is removed from the status area of the Radio 
Channel control; plus on some features, the shortcut menu indicator 
also changes to reflect the feature’s new state.

PROCEDURE 1-2  HOW TO CHANGE RADIO CHANNEL FEATURES (SHORTCUT MENU) 
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USING MIP 5000 WINDOWS

The main window types in the MIP 5000 VoIP Radio Console are:

• Miscellaneous window

• Activity Log window

• Multiple Tab window

• Information Window

• Volume window

PROCEDURE 1-3  HOW TO HIGHLIGHT AND ACTIVATE MIP 5000 WINDOWS

1 To activate any type of window, click a blank area on the window.

2 To choose a single tab in the Multiple Tab window, click the desired tab, 
located at the bottom of the screen. 

3 The text on the tab at the bottom of the window identifies the window’s 
state: 

• If the window is active and the current focus, the tab text becomes 
bold

• If the window is inactive or not the focus, the tab text is normal
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1 To activate any type of window, click a blank area on the window.

2 To choose a single tab in the Multiple Tab window, click the desired tab, 
located at the bottom of the screen. 

3 The text on the tab at the bottom of the window identifies the window’s 
state: 

• If the window is active and the current focus, the tab text becomes 
bold

• If the window is inactive or not the focus, the tab text is normal
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USING THE CONSOLE 2

The Motorola MIP 5000 VoIP Radio Console lets you perform specific tasks. The tasks 
include:

• “Getting Started” on page 2-2

• “Basic Radio Operations” on page 2-9

• “Multiple Selection of Radio Channels” on page 2-33

• “Patching” on page 2-37

• “Call Director” on page 2-45

• “Paging” on page 2-48

• “Additional Communications Features” on page 2-67

NOTE

This document assumes that you already know Microsoft Windows. This 
document does not repeat the general operation of the Windows user 
interface that is described in your Windows documentation.

NOTE

Features and functions of the Motorola MIP 5000 VoIP Radio Console 
system can be enabled or disabled depending on the specific needs of your 
system, as determined by the supervisor and the console system database 
manager. Check with the supervisor to see what is available on your system.

NOTE

Labels for Radio Channel controls and other screen features are configurable 
and might not appear exactly as illustrated in this section.
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GETTING STARTED

This section describes what you need to know to start and end a session with the 
MIP 5000 VoIP Radio Console. Included are:

• “Starting the Program” on page 2-2

• “Logging In” on page 2-3

• “Loading a New Configuration” on page 2-5

• “Logging Out” on page 2-6

• “Exiting the Program” on page 2-8

STARTING THE PROGRAM

Normally, the MIP 5000 VoIP Radio Console program is up and running with the login 
screen waiting for you to log in. If this is not the case, start the MIP 5000 VoIP Radio 
Console program from Windows as described below.

PROCEDURE 2-1  HOW TO START THE CONSOLE PROGRAM 

1 Click the Windows Start button and select Programs > Motorola > MIP 
5000 > Console.

OR

Double-click the MIP 5000 VoIP Radio Console shortcut on your desktop.

Result: The Welcome dialog box appears. You might need to wait for the 
HASP license manager service to start before you can log in. If the HASP 
license manager service does not respond, a message appears. See 
“MIP 5000 HASP Key” on page 1-14 for more information.
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LOGGING IN

Log in to the MIP 5000 VoIP Radio Console as described below.

2 When the HASP license manager has started, the program prompts you to 
log in.

3 If you see the following warning message instead of the login dialog box, 
notify your supervisor that the HASP key for this console is missing.

PROCEDURE 2-2  HOW TO LOG IN 

1 If your system does not include a keyboard, click the Keyboard button.

Result: A software version of the keyboard appears. You can use either the 
standard computer keyboard or the software version to type your user 
name. On the software keyboard, point and click a key to type the 
corresponding character.

PROCEDURE 2-1  HOW TO START THE CONSOLE PROGRAM (CONTINUED)
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2 In the User name text box, type your user name (up to 12 alphanumeric 
characters).

If an error occurs during your log in, a second Status area (error status) 
appears below the Status area, to inform you of the error.

NOTE

You can log in with a new user name (type user name and click 
Login). The login dialog box displays a Reset button and a list 
of configuration files. You choose a configuration file that will 
automatically load whenever you log in with that user name.

3 Click the Login button.

OR

Press the Enter key on your keyboard.

Result: The MIP 5000 VoIP Radio Console program begins.

NOTE

The first time that you log in, a dialog box appears from which 
you choose the configuration file that you want to load.

NOTE

The last configuration file open and saved with the same user 
name is the configuration file that loads on subsequent logins. 

PROCEDURE 2-2  HOW TO LOG IN (CONTINUED)
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LOADING A NEW CONFIGURATION

Once you are logged in (with either the default or a previously loaded configuration), 
you can change to another saved configuration at any time. The supervisor might have 
created a number of customized configuration files for you to chose from.

Different configuration files might, for example, make different sets of channels 
available at the console. Consult your supervisor for information on the configurations 
available and the circumstances under which they are to be used.

PROCEDURE 2-3  HOW TO LOAD A NEW CONFIGURATION 

1 Choose Load Configuration from the Console menu. 

Result: The Open dialog box appears.

NOTE

Files are stored in a pre-determined location (no browsing).

2 Choose the desired configuration from the Available Files list.

3 To load the chosen configuration, either double-click your choice or click 
Open. 

Result: You return to your main screen and the chosen configuration loads.

This can take a few moments depending on the complexity of the 
configuration.
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LOGGING OUT

You can log out of the MIP 5000 VoIP Radio Console program, which is different from 
quitting the program. Logging out closes the current session but does not stop the 
program from running. To exit the program, see “Exiting the Program” on page 2-8.

PROCEDURE 2-4  HOW TO LOG OUT 

1 Choose Logout from the Console menu.

Result: The Console logout dialog box appears asking if you are sure that 
you want to log out.

OR, if you made changes to your program settings, go to step 3.

2 Click Yes to log out.

Result: The Login dialog box appears.

OR

Click No to remain in your current session.

Result: The Console logout dialog box closes.

3 If you made changes to your program settings (for example speaker 
volume) a Some settings changed area appears asking if you want to save 
the console configuration file.
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4 Under Some settings changed:

Click Yes to save your changes.

OR 

Click No to continue with your log out process without saving your 
changes, then skip to step 6

NOTE

You must make a choice or you cannot continue with the log 
out process.

Result: If you click Yes, the Save As dialog box appears. 

5 Keep the same file name or type a new file name and click Save to save the 
configuration file.

Result: If you kept the same file name, you must click Yes to confirm 
replacement of the existing file. The Yes button on the Console logout 
dialog box becomes active.

6 Click Yes to log out.

Result: The Login dialog box appears.

OR

Click No to remain in your current session.

Result: The Console logout dialog box closes.

PROCEDURE 2-4  HOW TO LOG OUT (CONTINUED)
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EXITING THE PROGRAM

Usually, you do not exit the MIP 5000 VoIP Radio Console program, but you log out, 
leaving the log in dialog box displayed. (See “Logging In” on page 2-3).

PROCEDURE 2-5  HOW TO LOG OUT AND EXIT THE MIP 5000 VOIP RADIO CONSOLE 
PROGRAM 

1 Choose Logout from the Console menu. 

Result: A dialog box appears asking if you are sure that you want to log 
out.

NOTE

You cannot use the Close button (the box with an X at the 
upper right of the MIP 5000 VoIP Radio Console window) or 
ALT+F4 to exit from the program, as it is disabled.

2 Click Yes to log out. 

Result: The log in dialog box appears.

3 Choose the Exit button to completely close the MIP 5000 VoIP Radio 
Console program.
2-8 6881013Y34-D    OCTOBER 2010



MIP 5000 VOIP RADIO CONSOLE OPERATOR MANUAL  BASIC RADIO OPERATIONS
. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

BASIC RADIO OPERATIONS

Basic radio operations include:

• “Selecting a Radio Channel” on page 2-10

• “Selecting a Radio Channel Frequency” on page 2-11

• “Selecting Transmission Targets on MOTOTRBO Channels” on page 2-14

• “Transmitting on a Radio Channel” on page 2-19

• “Receiving on a Radio Channel” on page 2-21

• “Responding to an Emergency Alarm” on page 2-23

• “Identifying Previous Callers Using the Unit ID Queue” on page 2-26

• “Using the Base Intercom” on page 2-27

• “Increasing and Decreasing the Radio Channel Control Volume” on page 2-27

• “Muting the Audio of a Radio Channel” on page 2-30

• “Muting the Audio of All Unselected Channels” on page 2-31

• “Sending an Alert Tone over the Selected Radio Channels” on page 2-32
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SELECTING A RADIO CHANNEL

When you choose a radio via a Radio Channel control, you receive its audio on the 
select speaker or the operator headset(s). Each Radio Channel control represents one 
gateway connected to one radio channel. In the normal mode of operation (that is, 
when no patch or multiple selection is active), there is always one radio channel 
selected.

PROCEDURE 2-6  HOW TO SELECT A RADIO CHANNEL 

1 Click the label area of the desired Radio Channel control. 

Result: The Radio Channel control label changes color to indicate that the 
radio is selected. The control border is highlighted when the radio is first 
selected to indicate that the radio is in focus. The radio remains selected 
even when it is no longer in focus, that is, the Radio Channel control is still 
selected when you are on another tab in the Multiple Tab window.

NOTE

Colors are configurable.

PROCEDURE 2-7  HOW TO “UNSELECT” A SELECTED RADIO CHANNEL 

1 Click the radio channel label area on a Radio Channel control other than 
the currently selected one. 

Result: The previously selected Radio Channel control label changes its 
color to indicate that the radio is unselected.The currently selected Radio 
Channel control label changes its color to indicate that the radio is 
selected.
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SELECTING A RADIO CHANNEL FREQUENCY

For channels configured with multiple frequencies, you must choose one of the radio 
frequencies to use for communication. The current or selected frequency appears on the 
Radio Channel control. The MIP 5000 VoIP Radio Console supports up to 16 
frequencies per multi-frequency radio channel.

There are two ways to choose the radio channel frequency:

• Using the Radio Channel shortcut menu

• Using the Up/Down frequency buttons in the button area of the Radio Channel 
control (if configured)

FIGURE 2-1  EXAMPLE OF THE RADIO CHANNEL FREQUENCY

NOTE

You cannot change any radio channel (frequency) while any console is 
transmitting on the channel. A yellow transmit indicator, as shown below, is 
visible when another console is transmitting on the channel. You must retry 
after the transmission is completed.
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PROCEDURE 2-8  HOW TO SELECT RADIO CHANNEL FREQUENCY (SHORTCUT METHOD) 

1 Access the Radio Channel control shortcut menu. (Choose the indicator 
area on the Radio Channel control, or use SHIFT+F10 on your keyboard 
when the focus is on this Radio Channel control.) 

Result:  The Radio Channel control shortcut menu appears.The shortcut 
list contains the available frequencies, including the frequency aliases, if 
configured.

2 From the Radio Channel control shortcut menu, choose the Frequency 
drop-down menu.

3 From the Frequency drop-down menu, choose from the available multi-
frequency channels. (If configured on your system, one to 16 multi-
frequencies are available.) 

Result: The Radio Channel control shortcut menu remains open until you 
choose the Close (X) button (top right of shortcut menu) or until you click 
on another area of the main screen. The Frequency indicator on the radio 
channel indicator area changes to reflect the new radio channel 
(frequency). In addition, on revisiting the Frequency drop-down menu, a 
dot appears beside the chosen frequency. 
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PROCEDURE 2-9  HOW TO SELECT RADIO CHANNEL FREQUENCY (BUTTON METHOD) 

1 If configured, use the Up/Down buttons in the button area of the Radio 
Channel control to adjust the radio channel (frequency). Use the Up (+) 
frequency button to move the radio channel (frequency) up in the list or 
use the Down (-) frequency button to move the radio channel (frequency) 
down in the list of available frequencies. 

Result: If the Frequency indicator is present in the indicator area of the 
Radio Channel control, it reflects the change in radio channel (frequency), 
along with the frequency name/alias on the Radio Channel control. In 
addition, on viewing the Frequency drop-down menu, a dot appears 
beside the chosen frequency.
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SELECTING TRANSMISSION TARGETS ON 
MOTOTRBO CHANNELS

A MOTOTRBO channel offers different ways of selecting the target of a transmission 
before you transmit audio or a Quick Text message. 

• One Touch Call— Directly initiates a predefined Private Call, Group Call, a Call 
Alert, or a Quick Text message. See “How to Transmit Audio Using a One Touch 
Dial” on page 2-14 and “How to Transmit Quick Text—One Touch Dial” on page 
2-15.

• Contacts List — Directly initiates a Private Call, Group Call, or All Call from the 
Contacts List. See “How to Transmit Audio Using the Contacts List” on page 2-17.

• Manual Dial — Directly initiates a Private Call, Radio Check, Remote Monitor, 
Call Alert, or Radio Enable or Disable from the Keypad. See “How to Transmit 
Using Manual Dial” on page 2-18.

The One Touch Call button is a programmable button on the MIP 5000 VoIP Radio 
Console. Contact your supervisor about its availability.

NOTE

For information about transmitting on a channel, see “Transmitting on a 
Radio Channel” on page 2-19.

USING THE ONE TOUCH CALL

The One Touch Call button is a pre-programmed shortcut command mapped to one 
pre-defined subscriber alias or subscriber ID and call type, such as a Private Call, 
Group Call, or Call Alert. Clicking a shortcut command (Mic No-Dot, Mic 1-Dot, 2-Dot, 
P1-P4) the call associated with the One Touch Call button. Contact your supervisor 
about whether a shortcut command button is mapped directly to a pre-defined contact.

You can also send a Quick Text message using a One Touch Dial command. The text is 
pre-programmed in the command but can be edited before transmission. See “How to 
Transmit Quick Text—One Touch Dial” on page 2-15.

PROCEDURE 2-10  HOW TO TRANSMIT AUDIO USING A ONE TOUCH DIAL

1 Access the MOTOTRBO Radio Channel control shortcut menu. (Choose 
the indicator area on the Radio Channel control, or use SHIFT+F10 on your 
keyboard when the focus is on this Radio Channel control.) 
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2 From the Radio Channel control shortcut menu, choose a pre-programmed 
command mapped to an alias or ID. 

3 Transmit using one of the transmission controls described in “Transmitting 
on a Radio Channel” on page 2-19.

PROCEDURE 2-11  HOW TO TRANSMIT QUICK TEXT—ONE TOUCH DIAL 

1 Access the MOTOTRBO Radio Channel control shortcut menu. (Choose 
the indicator area on the Radio Channel control, or use SHIFT+F10 on your 
keyboard when the focus is on this Radio Channel control.) 

2 From the Radio Channel control shortcut menu, click the Keypad View 
button.

Result: The MOTOTRBO Keypad opens.

PROCEDURE 2-10  HOW TO TRANSMIT AUDIO USING A ONE TOUCH DIAL
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USING THE CONTACTS LIST

You choose a pre-defined subscriber alias or ID from a list of contacts that appear in the 
MOTOTRBO display and transmit to the target using any of the transmission methods 
described in “Transmitting on a Radio Channel” on page 2-19.

3 Click the Menu key.

4 Click the Left Arrow key or the Right Arrow key until the Messages item 
appears in the Text Display and select the item by clicking the OK key.

5 Click the Left Arrow key or the Right Arrow key until Quick Text appears 
and click the OK key.

6 Click the Left Arrow key or the Right Arrow key until the desired message 
appears and click the OK key.

7 Edit the message directly in the Text Display. When you are finished, click 
the OK key.

8 Click the Left Arrow key or Right Arrow key until Send appears and click 
the OK key.

Result: The Contacts list appears in the Text Display.

9 Click the Left Arrow key or Right Arrow key until you see the desired 
contact Alias or ID, and click the OK key to send the message.

PROCEDURE 2-11  HOW TO TRANSMIT QUICK TEXT—ONE TOUCH DIAL (CONTINUED)
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USING MANUAL DIAL

You can edit or type the subscriber ID directly in the MOTOTRBO Keypad before 
transmitting the audio message. 

PROCEDURE 2-12  HOW TO TRANSMIT AUDIO USING THE CONTACTS LIST

1 Access the MOTOTRBO Radio Channel control shortcut menu. (Choose 
the indicator area on the Radio Channel control, or use SHIFT+F10 on your 
keyboard when the focus is on this Radio Channel control.) 

Result: The shortcut menu opens.

2 From the Radio Channel control shortcut menu, click the Keypad View 
button.

Result: The MOTOTRBO Keypad opens.

3 Click the Menu key. 

4 Click the Left Arrow key or Right Arrow key until the Contacts item 
appears in the Text Display and select the item by clicking the OK key.

5 Click the Left Arrow key or Right Arrow key until the desired contact 
appears and click the OK key.

6 Transmit using one of the transmission controls described in “Transmitting 
on a Radio Channel” on page 2-19.
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PROCEDURE 2-13  HOW TO TRANSMIT USING MANUAL DIAL

1 Access the MOTOTRBO Radio Channel control shortcut menu. (Choose 
the indicator area on the Radio Channel control, or use SHIFT+F10 on 
your keyboard when the focus is on this Radio Channel control.) 

Result: The shortcut menu opens.

2 From the Radio Channel control shortcut menu, click the Keypad View 
button.

Result: The MOTOTRBO Keypad opens.

3 Click the Menu key. 

4 Click the Left Arrow key or the Right Arrow key until the Manual Dial 
item appears in the Text Display and select the item by clicking the OK 
key.

Result: The Text Display shows the subscriber ID of the last call dialed.

5 Using the keypad, either edit the ID or type another ID. You can erase the 
current ID by using the Right Arrow key.

6 Transmit using one of the transmission controls described in 
“Transmitting on a Radio Channel” on page 2-19. 
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TRANSMITTING ON A RADIO CHANNEL

There are several ways to transmit on a radio channel. You can transmit by pressing one 
of the following PTT buttons:

• Instant Transmit button

• Common Tx button

• Microphone or headset PTT button (if available)

• Footswitch PTT pedal (if available)

The Instant Transmit button can be used to transmit on any channel, whether it is 
selected or not. The other methods only transmit on the currently selected channel.

For a multi-frequency Radio Channel Control, the transmission occurs on the currently 
selected frequency regardless of the method used.

The transmit queue can affect your radio transmission. For additional information, see 
“Additional Communications Features” on page 2-67.

PROCEDURE 2-14  HOW TO TRANSMIT ON ANY RADIO CHANNEL (INSTANT TRANSMIT) 

1 To transmit on a radio channel whether it is selected or not, click and hold 
the Instant Transmit button on the desired radio channel.

Result: The Transmit indicator appears, to show that you are transmitting 
on this radio channel.

2 Talk into your microphone or headset while holding the Instant Transmit 
button.

3 To stop transmitting, release the button.
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A transmit timeout for console transmissions can be set in the CSDM for any 
radio channel. When a transmit timeout is configured, you can transmit for a 
certain length of time and then you are timed out by the system. If a timeout 
is configured, a transmit error indicator appears on the Radio Channel 
control and a soft beep is sounded. A five-second timeout warning appears 
in the Status bar of the main window five seconds before the end of the 
timeout period.

FIGURE 2-2  RADIO CHANNEL CONTROL SHOWING TRANSMIT ERROR INDICATOR

FIGURE 2-3  STATUS BAR SHOWING 5-SECOND TIMEOUT WARNING
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RECEIVING ON A RADIO CHANNEL

Each Radio Channel Control includes a Call indicator, which shows any call activity on 
that radio channel. This indicator is in the upper left-hand corner of the Radio Channel 
control.

• If the call comes in on a radio channel that is selected at your console:

• A green Call indicator appears

• If applicable, the Unit ID or alias of the radio from which the transmission 
originated appears on the Radio Channel control in the label area 
(depending on your configuration, the Unit ID appears at the beginning or 
at the end of a transmission)

• You hear the audio on your select speaker or headset

• You transmit with any PTT button (Instant Transmit, Common Transmit)

• If the call is on a radio channel that is not selected at your console but is selected at 
another Dispatcher’s console:

• A yellow Call indicator appears

• If applicable, the Unit ID or alias of the radio from which the transmission 
originated appears on the Radio Channel control in the label area 
(depending on your configuration, the Unit ID appears at the beginning or 
at the end of a transmission)

• You hear the audio on your unselect speaker

• You can transmit with the Instant Transmit button

• If the call is on a radio channel that is not selected at any console:

• A green Call indicator appears

• If applicable, the Unit ID or alias of the radio from which the transmission 
originated appears on the Radio Channel control in the label area 
(depending on your configuration, the Unit ID appears at the beginning or 
at the end of a transmission)

• You hear the audio on an unselect speaker

• You can transmit with the Instant Transmit button
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NOTE

In addition to the call indicators listed above, an incoming call might also 
cause a yellow Transmit Busy indicator to appear. This occurs for some 
types of radio (such as the Consolette) that include a “PTT BSY” signal in 
their transmissions.

NOTE

If configured, the Call indicator takes a few seconds to disappear after the 
transmission is terminated. The supervisor can set a time delay for the Call 
indicator using the User Preferences command.

PROCEDURE 2-15  HOW TO RESPOND TO A CALL INDICATOR 

1 Click the Radio Channel control. (This selects the Radio Channel control.)

Result: The Call indicator remains green on your console but changes to 
yellow on other consoles.

Listen to the audio on your select speaker or headset.

2 Use any PTT button (Instant Transmit, Common Transmit) to transmit on 
that radio channel.

3 When the call is complete. The Call indicator disappears.
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RESPONDING TO AN EMERGENCY ALARM

A unique emergency code identifies an incoming emergency alarm on a Radio Channel 
Control. When this option is enabled (at the CSDM) and the system receives an 
emergency radio alarm:

• An audible alarm sounds at the console(s) where the radio channel is mapped

• The radio identification appears in red on the Radio Channel control

• Red outlines the Radio Channel control (color is configurable)

If an emergency alarm comes in on a Radio Channel control that is not visible on your 
currently displayed Multiple Tab window, the page tab, where the emergency Radio 
Channel control resides, changes to red and an aid symbol appears. Choose this tab to 
gain access to the Radio Channel control that is declaring an emergency. If the 
emergency alarm comes in on a Radio Channel control in the Miscellaneous window, 
red outlines the channel with the emergency (color is configurable).

Clearing an emergency alarm on a MOTOTRBO Radio Channel control requires 
attention to whether the alarm is in background or foreground. Putting an alarm into 
the background means that you can perform another task on the MOTOTRBO Radio 
Channel control without clearing the alarm. You can clear an emergency alarm on a 
MOTOTRBO Radio Channel control only when the alarm is in the foreground. To 
switch an emergency alarm between background and foreground, short-press the 
Back/Home button followed by a short-press on the programmed emergency button 
(P1-P4, Mic No-Dot, Mic 1-Dot, or Mic 2-Dot).

PROCEDURE 2-16  HOW TO ACKNOWLEDGE AN EMERGENCY ALARM 

1 Go to the Activity Log window and choose the red emergency alarm from 
the list. (The emergency alarm appears in the All Calls and the Emergency 
tabs. If the channel is selected, the alarm also appears in the Select and 
Unselect tabs.)

If configured, the Activity Log window shows the time, radio channel and 
caller identification of the emergency alarm.
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2 To stop the audible alarm, click the ACO button (alarm cut off). 

Result: The alarm sound is silenced. The radio channel outline changes 
from red to yellow (these colors are configurable) and the red highlighted 
text in the Activity Log window, Type column changes from Emerg Alarm 
to Acked Emerg (acknowledged emergency). 

NOTE

When you click the ACO button to deactivate an alarm, the 
audible alarm turns off at all consoles. You must acknowledge 
the alarm (with the ACO button) before you can clear the alarm 
(with the CLR (Clear) button).

NOTE

If a new emergency alarm occurs, the red radio identification 
for the new emergency alarm appears on the Radio Channel 
control. The audible alarm starts or restarts where the Radio 
Channel control is active and the new emergency is added to 
the Activity Log window.

3 Proceed with your emergency alarm procedures. 

NOTE

You can transmit from the Activity Log window by selecting 
the emergency alarm from the Activity Log window list and 
using the Transmit button at the top of the window to 
communicate with the caller reporting the emergency.

4 When the emergency alarm ends, click the CLR (Clear) button in the 
Activity Log window.

Result: The emergency alarm is removed from the Emergency tab and the 
text changes to say Clear Emerg under the Type column. The Radio 
Channel control changes back to its original color.

5 Repeat as necessary to clear all of the alarms.

PROCEDURE 2-16  HOW TO ACKNOWLEDGE AN EMERGENCY ALARM (CONTINUED)
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NOTE

If the attempt to clear the alarm from a MOTOTRBO radio is unsuccessful, 
you can manually clear the alarm with the following actions:

• Short press the Back/Home control (See “Back/Home Control” on 
page 3-6.) then

• Long press the programmed emergency button (e.g., P1-P4, Mic No-
Dot, Mic 1-Dot, or Mic 2-Dot) when the emergency alarm is in the 
foreground.
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IDENTIFYING PREVIOUS CALLERS USING THE UNIT ID 
QUEUE

The Unit ID is the identification or alias for the recent radio activity on the radio 
channel. The Radio Channel Control shortcut menu identifies the unit identifications 
(caller ID) for the previous calls under the Unit ID Queue drop-down menu.

For an incoming radio call; the program's caller ID feature identifies the calling party. 
When a mobile or MOTOTRBO radio user presses the PTT (on a mobile radio with a 
unit ID) that ID is sent on the radio channel along with their voice transmission. The 
console receives that mobile’s ID and extracts the associated alias (name) from the 
Caller ID database (see “Caller ID Command” on page 4-20). The console then displays 
the alias on the Radio Channel control (in the label area) and you know who is making 
the call. If no alias is defined, the console displays the ID.

The supervisor activates the Unit ID Queue option and sets the number of unit 
identifications displayed on the Radio Channel control.

FIGURE 2-4  UNIT ID QUEUE DROP DOWN MENU

PROCEDURE 2-17  HOW TO IDENTIFY PREVIOUS CALLERS USING THE UNIT ID QUEUE 

1 Access the Radio Channel control shortcut menu. (Click the indicator area 
on the Radio Channel control, or press SHIFT+F10 on your keyboard when 
the focus is on this Radio Channel control.)

Result: The Radio Channel control shortcut menu appears.

2 Choose the Unit ID Queue drop down menu.

Result: The previous callers on this radio channel appear in the list.
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USING THE BASE INTERCOM

The Base Icom button lets you transmit to a base station without having to key that 
station. For instance, you can talk to maintenance or other personnel located at the base 
station. The currently selected radio channel makes the intercom call to the base station 
only; it is not transmitted out from the base station. 

FIGURE 2-5  BASE ICOM BUTTON

If a parallel unit (that is, a remote deskset) is associated with the single base station 
radio channel, you can communicate with the parallel unit dispatcher.

INCREASING AND DECREASING THE RADIO CHANNEL 
CONTROL VOLUME

The Radio Channel Control shortcut menu contains the volume controls for that Radio 
Channel control. 

You can adjust the volume of the Radio Channel control with the Volume Slide control 
or if configured, with the Up/Down volume buttons in the button area of the Radio 
Channel control.

Base Icom – Inactive Base Icom – Active

PROCEDURE 2-18  HOW TO USE THE BASE INTERCOM 

1 Click and hold the Base Icom button. 

Result: The Transmit indicator appears on the selected Radio Channel 
control.

2 While still holding the Base Icom button, speak into your microphone.

Result: The audio transmits to the currently selected base station, and the 
Transmit indicator remains on the selected Radio Channel control.

3 Release the Base Icom button to end the call.
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NOTE

In an emergency situation, the radio channel volume increases to a value set 
by the supervisor (maximum 15). The volume returns to the pre-emergency 
setting after you clear the emergency. A supervisor can also specify a change 
in volume level for the radio channel when it is selected.

PROCEDURE 2-19  HOW TO INCREASE AND DECREASE THE VOLUME 

1 Access the Radio Channel control shortcut menu. (Click the indicator area 
on the Radio Channel control, or press SHIFT+F10 on your keyboard when 
the focus is on this Radio Channel control.)

Result: The Radio Channel control shortcut menu appears.

2 To adjust the volume for this radio channel, use the Volume Slide control 
located at the top of the Radio Channel control shortcut menu.

• Increase the volume by moving the slider to the right. The volume 
number increases, as does the volume. If the volume indicator is present 
in the indicator area of the Radio Channel control, it also reflects the 
increase in volume level.

• Reduce the volume by moving the slider to the left. The volume number 
decreases, as does the volume. If the volume indicator is present in the 
indicator area of the Radio Channel control, it also reflects the decrease in 
volume level.
2-28 6881013Y34-D    OCTOBER 2010



MIP 5000 VOIP RADIO CONSOLE OPERATOR MANUAL  BASIC RADIO OPERATIONS
OR, 

If configured, use the Up/Down volume buttons in the button area of the 
Radio Channel control to adjust the volume. Use the Up (+) button to 
increase the volume or use the Down (-) button to decrease the volume. If 
the volume indicator is present in the indicator area of the Radio Channel 
control, it also reflects the increase/decrease in volume level.

PROCEDURE 2-19  HOW TO INCREASE AND DECREASE THE VOLUME (CONTINUED)
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MUTING THE AUDIO OF A RADIO CHANNEL

The Mute button lets you temporarily mute the audio for any individual radio channel. 
The volume level of the muted audio is set at the CSDM for each console user.

FIGURE 2-6  MUTE BUTTONS

Inactive Active

PROCEDURE 2-20  HOW TO MUTE A SPECIFIC RADIO CHANNEL’S AUDIO 

1 Click the Mute button on a selected or unselected Radio Channel control.

Result: The audio immediately mutes, and a red prohibitory sign appears 
on the Mute button.

NOTE

If a red prohibitory sign with no sound waves appears on the 
radio channel Mute button, this indicates that the All Mute 
button is muting the radio channel(s). 

2 To return the audio to its original volume, click the Mute button again. 

Result: The radio channel returns to the pre-muted volume and the red 
prohibitory sign disappears from the Mute button.

NOTE

You can still select and transmit on a radio channel that is muted 
or all muted (all unselected channels) without taking the mute 
off. This selected radio channel then operates at the pre-muted 
volume.
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MUTING THE AUDIO OF ALL UNSELECTED CHANNELS

The All Mute button temporarily mutes all audio at the unselect speakers so you can 
concentrate on the audio at the select speaker. The All Mute button includes an 
automatic timer that cancels the all mute status if you forget to do so. The automatic 
timer and the mute audio level are set at the CSDM (the default is 30 seconds).

FIGURE 2-7  ALL MUTE BUTTON

PROCEDURE 2-21  HOW TO MUTE THE AUDIO OF ALL UNSELECTED CHANNELS 

1 Click the All Mute button. 

Result: The sound waves disappear on the All Mute button and all 
unselected audio is immediately muted. A red prohibitory sign (plus a 
speaker with no sound waves) appears on the radio channel Mute button 
indicating that the All Mute button is muting the radio channel(s). Any 
individual radio channels that were previously muted, change to red 
prohibitory signs (with sound waves).

2 To return the unselected audio to its original volume, either click the All 
Mute button again or wait for the default mute interval to expire.

Result: The radio channel unmutes, the red prohibitory sign disappears 
from the Mute button, and the radio channel operates at the default 
volume. (Previously muted radio channels (individually) stay muted.)
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SENDING AN ALERT TONE OVER THE SELECTED 
RADIO CHANNELS

The Alert # button lets you transmit an alert tone to the selected radio channels; you 
might use this feature, for example, to let listeners know that you are about to make an 
urgent announcement. There are three different alert tones available on the MIP 5000 
VoIP Radio Console system.

• Tone 1: continuous 1004 Hz tone

• Tone 2: alternating 800 and 1500 Hz tones

• Tone 3: a pulsing 1004 Hz tone

PROCEDURE 2-22  HOW TO SEND AN ALERT TONE OVER SELECTED RADIO CHANNELS 

1 Choose the radio channel(s) (the alert tone can be sent on multi-selected 
channels and over a patch).

2 Click and hold the desired Alert # button. 

Result: A Transmit indicator appears beside the Alert symbol. All selected 
radio channels show a Transmit indicator and receive the alert tones. You 
hear the alert tones in your headset or over the select speaker. The alert 
tones are sent for the time that you hold the Alert # button.

3 When the tone signal ends, a green Transmit (talkdown) indicator still 
remains. This indicator demonstrates that your PTT is keyed for a specific 
time (set in the CSDM) and you can send your voice message for the 
duration that the Transmit (talkdown) indicator is present. If you require 
more time for your message, use the Common Transmit button and speak 
into your headset. To talk on one specific radio channel, use the Instant 
Transmit button.
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MULTIPLE SELECTION OF RADIO CHANNELS

The MSel button lets you choose more than one radio channel at the same time and 
store these selected channels in memory. There are up to eleven buttons per console, ten 
with memory and one without memory. You can include up to 16 Radio Channel 
controls in an MSel # button (with memory). The number of Radio Channel controls an 
MSel w/o M button (without memory) can hold is equal to the number of radio 
channels licensed at this console. You hear the incoming audio from each of those radio 
channels on the select speaker, and you can transmit to all of those radio channels at the 
same time. Multiple selection is local to your console; the multi-selected channels 
cannot hear each other.

Depending on your systems configuration, the MIP 5000 VoIP Radio Console can save 
Multiple Selections either with memory or without:

• With memory — saves up to 16 channels for future reference (10 MSel # buttons 
(with memory) are available)

• Without memory — provides a temporary way to choose more than one radio 
channel at a time, for instance, to perform an all points broadcast (one  
MSel w/o M button (without memory) is available)

Multiple selection operations include:

• “Creating or Adding to a Multiple Selection” on page 2-34

• “Activating and Deactivating a Multiple Selection” on page 2-35

• “Transmitting on a Multiple Selection” on page 2-35

• “Deleting a Multiple Selection” on page 2-36

• “Transmitting an APB” on page 2-36

NOTE

Each Instant Transmit button transmits on a single radio channel, regardless 
of whether the multiple selection is active or not. This functionality is in 
contrast to that of a patch, where the Instant Transmit button transmits to all 
radio channels included in the patch.

NOTE

Multiple selection is local to your console; the effects will not be noticed at 
any other consoles or on the radio channels. In contrast, patching has global 
effects; that is, what you do with the patch at your console is reflected at 
other consoles with indicators. 
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CREATING OR ADDING TO A MULTIPLE SELECTION

Creating a new multiple selection and adding channels to an existing one involves the 
selection of more than one channel. For information about selecting channels, see 
“Selecting a Radio Channel” on page 2-10.

If you add a channel that is already a member of a patch, the system attempts to add all 
patch members to the multiple selection. When the number of multiple selection 
members is greater than 16, the remainder are still selected but a warning message is 
displayed on the status bar indicating that not all selected channels are members of the 
multiple selection.

PROCEDURE 2-23  HOW TO CREATE OR ADD TO A MULTIPLE SELECTION 

1 Click the desired MSel # button. 

Result: The button background changes from gray to blue indicating that it 
is active.

2 Choose all of the desired radio channels that you want for this multiple 
selection.

Result: The blocks in the button change from white to light green 
indicating that this MSel # button now contains the channels that you 
chose. The system automatically saves the contents.

3 Continue with your normal call procedures.
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ACTIVATING AND DEACTIVATING A MULTIPLE 
SELECTION

TRANSMITTING ON A MULTIPLE SELECTION

To transmit on an active MSel # button (For multi-frequency Radio Channel controls, 
you must also choose the frequency [radio channel] on which you want to 
communicate.), follow this procedure:

PROCEDURE 2-24  HOW TO ACTIVATE A MULTIPLE SELECTION 

1 Click the desired MSel # button.

Result: The background of the activated MSel # button changes from gray 
to blue (with light green blocks)

PROCEDURE 2-25  HOW TO DEACTIVATE A MULTIPLE SELECTION 

1 Click the desired active MSel # button. 

Result: The button background changes from blue to gray indicating that it 
is now inactive.

PROCEDURE 2-26  HOW TO TRANSMIT ON AN ACTIVE MSEL # BUTTON 

1 Ensure the desired MSel # button is active (background is blue instead of 
gray).

2 Use the Common Transmit or the associated APB # button to transmit on 
the active MSel #. 

3 Speak into your headset.
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DELETING A MULTIPLE SELECTION

To remove one or more radio channels from a multiple selection is the same procedure 
as completely deleting a saved multiple selection, therefore, you can edit a multiple 
selection with a similar method.

TRANSMITTING AN APB

The APB # button transmits over the radio channels stored in an associated multiple 
selection with memory, whether it is active or not. There are ten available APB # 
buttons (one for each MSel # with memory button).

FIGURE 2-8  APB (ALL POINTS BULLETIN) # BUTTON
 

PROCEDURE 2-27  HOW TO TRANSMIT ON AN NON-ACTIVE MSEL # BUTTON 

1 Choose the corresponding APB # button for the desired MSel # button, 
where the # is the same for both buttons.

2 Speak into your headset.

PROCEDURE 2-28  HOW TO DELETE OR REMOVE CHANNELS FROM A MULTIPLE SELECTION 

1 Activate the desired MSel # or MSel w/o M button. 

2 Unselect all of the radio channels that you want to remove from this 
multiple selection by clicking the radio channel label area or click the Clear 
button in the status bar to remove all the radio channels.

Result: If you remove all of the radio channels, the blocks in the button change 
from light green to white, indicating that this MSel # or MSel w/o M button is 
now empty. 

NOTE

This operation never results in no radio channel being selected. 
At least one radio channel is always selected.

Inactive State Active State
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PATCHING

A patch is a set of up to 16 channels grouped together in a way that permits you to 
control them as if they were a single channel. A patch is global to all consoles; that is, a 
patch is available to each console with access to at least one of the radio channels in the 
patch. A patch can be thought of as a kind of conference call.

Patching topics include:

• “Creating and Saving a Patch” on page 2-38

• “Activating and Deactivating a Patch” on page 2-40

• “Transmitting on a Patch” on page 2-42

• “Modifying a Patch” on page 2-43

• “Clearing a Patch” on page 2-45

Items to remember when dealing with patches:

• An active patch is reflected at every console that is mapped to at least one radio 
channel in the patch. Any console involved in this patch can receive and transmit 
audio only on the patched radio channels that are available at that console

• One console initiates a patch, which can be used globally at other consoles, but 
the controlling/editing features are limited to the console where the patch was 
created

PROCEDURE 2-29  HOW TO TRANSMIT AN APB 

1 Choose and hold the desired APB # button that is associated with the 
MSel # button (with memory) to which you want to transmit.

NOTE

You do not need to activate the MSel # button to use the APB 
feature.

Result: The APB # button changes to the active state (white Transmit 
indicator with a red background on the button).

2 Send your message and release the APB # button when your message is 
complete.

Result: The APB # button returns to the inactive state (red Transmit 
indicator with a gray background).
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• Each consoles has 10 independent patches with memory and one patch without 
memory, therefore more than one console can have the same Patch # active. The 
only restriction is that you cannot use the same active channel in multiple active 
patches. See “Patch # Button” on page 3-39 and “Patch w/o M Button” on page 
3-42 for more information.

• Patching has global effects; patches affect other consoles and the radio channels. 
In comparison, multiple selection is local to your console; the effects are not 
noticed at any other consoles or on the radio channels.

• If you mute a Radio Channel control involved in an active patch, then all Radio 
Channel controls included in that patch are muted.

• When a patch entity (such as a channel or Call Director) receives an incoming call, 
it generates an automatic PTT (or VoxPTT) on the other channels in the patch. The 
Timeout feature does not apply to a VoxPTT.

• For information about Call Director calls and patches, see “Adding Call Director 
Calls to a Patch” on page 2-42 and “Call Director” on page 2-45.

CREATING AND SAVING A PATCH

Creating and saving a patch (keeping it in memory) is a drag-and-drop procedure. 

PROCEDURE 2-30  HOW TO CREATE AND SAVE A PATCH 

1 Open one of the available Patch windows, either by clicking a Patch # 
button on the main window or by selecting a Patch Window # from the 
View menu. 

Result: The Patch window appears.
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2 Click and drag the desired Radio Channel controls into the Patch window.

Result: The radio channel name appears in the Patch list and the patch 
automatically becomes active.

NOTE

To add a Call Director call to the patch, see “Adding Call 
Director Calls to a Patch” on page 2-42. 

3 Use the Close button to close the Patch window.

Result: The patch is automatically saved.

NOTE

A closed patch remains active unless you deactivate it, see 
“Activating and Deactivating a Patch” on page 2-40.

PROCEDURE 2-30  HOW TO CREATE AND SAVE A PATCH (CONTINUED)
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ACTIVATING AND DEACTIVATING A PATCH

PROCEDURE 2-31  HOW TO ACTIVATE AND DEACTIVATE A PATCH 

1 Open the desired Patch window, either by clicking the Patch # button on the 
main window or by selecting the Patch Window # from the View menu. 

Result: The Patch window appears with the saved radio channels.

NOTE

A patch automatically activates when you add the first radio 
channel. 
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2 Click the Patch Activate button at the bottom left-hand corner of the Patch 
window or drag a new or current Radio Channel control into the Patch 
window.

Result: The patch shows that it is active when:

• The Patch Activate button changes from gray to green

• The radio channel indicators in the Patch window change color
• On your console, a green Patch indicator appears on the radio channels 

included in the patch.

• On other consoles, a yellow Patch indicator appears on the Radio 
Channel controls included in the patch

3 To deactivate the patch, select the Patch Activate button again.

PROCEDURE 2-31  HOW TO ACTIVATE AND DEACTIVATE A PATCH (CONTINUED)
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ADDING CALL DIRECTOR CALLS TO A PATCH

Patches can contain active Call Director calls. To include a Call Director call in a patch, 
you must first place the call. Call Director calls must be active (off hook) when you add 
them to a patch.

After a patch is deactivated, the Call Director is removed from the patch. Only the 
patched channels remain.

See “Call Director” on page 2-45 for more information about handling Call Director 
calls.

TRANSMITTING ON A PATCH

For multi-frequency Radio Channel controls, you must also choose the frequency 
(radio channel) on which you want to communicate. You can change the frequency of a 
Radio Channel control already included in a patch, but the radio channels remains on 
that frequency even after it has been removed from the patch.

PROCEDURE 2-32  ADDING CALL DIRECTOR CALLS TO A PATCH 

1 The patch automatically activates when you add the first element, but 
ensure that the desired Patch window is open. (The patch must be 
activated to accept Call Director calls.)

2 Click and drag the desired active Call Dir control into the Patch window. 

Result: The Call Dir name appear in the Patch list.

NOTE

Call Director calls must be active (not on hold) when you add 
them to the patch.

PROCEDURE 2-33  HOW TO TRANSMIT ON A PATCH 

1 Click the desired Patch # button.

2 If the patch is not active/selected, activate the patch by clicking on the 
Patch Activate button located at the bottom left-hand corner of the Patch 
window.
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MODIFYING A PATCH

Modifying a patch includes removing or adding a radio channel or Call Director call.

To add a Call Director call, see “Adding Call Director Calls to a Patch” on page 2-42.

To remove elements from an existing patch, follow this procedure:

3 Click and hold the Transmit button located to the right of the Patch 
Activate button. 

OR

Use any PTT button (Instant Transmit, Common Transmit) on one of the 
channels included in the patch.

4 Speak into your microphone or headset.

5 To stop transmitting, release the PTT button.

PROCEDURE 2-34  HOW TO ADD A RADIO CHANNEL TO AN EXISTING PATCH 

1 Click the desired Patch # button and activate, if necessary. 

Result: The Patch window appears.

2 Click and drag the desired Radio Channel controls into the Patch window. 

Result: The radio channel name appears in the Patch list.

PROCEDURE 2-33  HOW TO TRANSMIT ON A PATCH (CONTINUED)
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PROCEDURE 2-35  HOW TO REMOVE ELEMENTS FROM AN EXISTING PATCH 

1 Click the desired Patch # or Patch w/o M button

2 Choose the desired radio channel or Call Director name from the Patch list 
contained in the Patch window. 

3 Press the Delete key on your keyboard.

OR

Drag the chosen name(s) from the Patch list to the border area of the Patch 
window.

Result: The radio channel and/or Call Director name(s) disappear from 
the Patch list.
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CLEARING A PATCH

To clear a patch completely (to free it up for a new patch) remove all the radio channels 
and Call Director from a patch until nothing remains in the patch. Follow the 
procedures contained in “Modifying a Patch” on page 2-43 (removing channels and 
Call Director calls).

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
CALL DIRECTOR

When the Call Director feature is enabled, your console is connected to a Call Director 
interface that receives telephone calls from a separate telephone system. 

The Call Director allows you to use the MIP 5000 VoIP Radio Console headset or the 
console speaker and microphone to communicate with calls from the Call Director 
interface. It also allows you to create a patch that includes the Call Director interface as 
well as radio channels.

NOTE

The specific operating instructions for the Call Director vary, depending on 
the type of interface in use. For instructions on using the Call Director, 
consult the original documentation provided by the manufacturer of the 
interface (such as telephone set or 9-1-1 system).

Call Director topics include:

• “Call Director Operation” on page 2-45

• “Exiting a Call Director Call” on page 2-46

• “Using Call Director to Create a Patch” on page 2-47

CALL DIRECTOR OPERATION

Call Director operations fall into two categories:

• Category 1: The operator headset is in use

• Category 2: The operator headset is not in use

NOTE

For full-duplex operation, use the operator headset for Call Director 
communications rather than the supervisor headset.
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FIGURE 2-9  CALL DIR CONTROL

NOTE

In both categories, activating any radio PTT routes operator audio to the 
radio channel, and mutes audio to the Call Director interface.

CATEGORY 1: HEADSET IN USE

To use the Call Director, you choose a line on the Call Director interface:

• You are in full duplex communication with the line

• The system routes the Call Director audio to the headset

• The system directs your voice from the headset microphone to the Call Director 
interface

• The use of the Call Dir control is not required

• The system routes the select audio back to the Select speaker, if configured

CATEGORY 2: HEADSET NOT IN USE

To use the Call Director, you choose a line on the Call Director interface:

• The Call Director communication is half duplex

• The system routes the Call Director audio to the Select speaker

To speak to the receiving end, you use the Call Dir control:

• The system routes the operator audio to the Call Director interface

• The system mutes the Call Director audio to prevent feedback

EXITING A CALL DIRECTOR CALL

This procedure is site-specific.

The Call Dir control is a way to connect to, and talk with, a caller on a completely 
separate telephone system. Therefore, to exit the call, you must disconnect the call from 
the originating telephone system.
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USING CALL DIRECTOR TO CREATE A PATCH

If the Call Director feature is enabled on your console, you can create a patch that 
includes a Call Director interface call, as well as, calls on radio channels.

CREATING A PATCH WITH CALL DIRECTOR

You can create a patch with the Call Director interface.

COMMUNICATING WITH A PATCHED CALL DIRECTOR CALL

Communicating with a patched Call Director call is the same as transmitting on a 
normal patch. See “Transmitting on a Patch” on page 2-42.

PROCEDURE 2-36  EXITING A CALL DIRECTOR CALL 

1 Release the call (line) directly through the originating telephone 
equipment.

2 Verify that this ends the Call Director communication. (Call Dir control 
returns to inactive state with no indicators, dial tone, etc.).

PROCEDURE 2-37  CREATING A PATCH WITH CALL DIRECTOR 

1 Open the Patch window by clicking the Patch # button.

2 Click and drag the active Call Dir control into the Patch window.

Result: The patch indicator appears on the Call Dir control.

The Call Dir control name appears in the Patch list. The system routes the 
Call Director audio to the Unselect speaker or the Select speaker, 
depending on the patch select state.

If no headset is connected, your microphone is not live with the Call Director 
and full duplex communication is not possible. If a headset is connected, you 
are in full duplex communication with the Call Director, but need to use a 
transmit button (footswitch, Instant Tx, Common Tx, external PTT, etc.) 
rather than just speaking into the microphone to transmit on the radio 
channel(s).
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REMOVING A CALL DIRECTOR CALL FROM A PATCH 

To remove a Call Director call from a patch:

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

PAGING

The MIP 5000 VoIP Radio Console provides integrated paging features. Paging types 
include generic (using any tone sequence), customized or pre-programmed; including 
STAT-ALERT signaling, if configured. The MIP 5000 VoIP Radio Console sends the 
page signal over all selected radio channels, with the exception of the first Note below. 
You can define the specific radio channel and frequency through which a page is 
transmitted. While a page is transmitting, the console cannot perform any other 
transmissions.

NOTE

Mobile radio channels do not support MIP 5000 VoIP Radio Console paging. 
To page on a mobile radio channel, an external pager must be used. The 
external pager must first be configured at the CSDM for any radio channel it 
must support.

NOTE

If a radio channel is selected as a result of being in an open multiple 
selection or an active patch, you cannot page on this channel when Steering 
— Channel is set to Selected. To send a page on such a channel, you must 
steer it to this channel by choosing this channel from the Steering — 
Channel list.

NOTE

The supervisor or system administrator designates the customized paging 
formats at the CSDM.

PROCEDURE 2-38  REMOVING A CALL DIRECTOR CALL FROM A PATCH 

1 Open the Patch window by clicking the Patch # button.

2 Choose the Call Dir control name in the Patch list. To remove the Call 
Director, either drag it to the border of the window or choose Delete on 
your keyboard.

Result: The Call Dir indicator disappears from the list.

If the headset is connected, you regain full duplex communications with 
the Call Director.
2-48 6881013Y34-D    OCTOBER 2010



MIP 5000 VOIP RADIO CONSOLE OPERATOR MANUAL  PAGING
NOTE

On MOTOTRBO Radio Channel controls, paging is only available when 
selected in an analog mode, not a MOTOTRBO mode.

MIP 5000 VoIP Radio Console provides three different paging mediums:

• Manual Page: gives you complete flexibility in choosing the paging and signaling 
tones and the dialing code; plus access to STAT-ALERT messaging (call and voice) 

• Paging List: gives you access to pre-programmed lists that lets you send pages 
and signaling tones to multiple receivers

• Single Page: gives you quick, one button access to single or group pages

Paging topics include:

• “Manual Page” on page 2-50

• “STAT-ALERT Signaling” on page 2-54

• “Paging with a Programmed List” on page 2-58

• “Paging with a Single Page Button” on page 2-65

• “Viewing Page History Information” on page 2-67

NOTE

When using programmed pages, which specify that the page transmits on 
the “selected channel”, ensure that you have a channel selected that is not 
involved in a multiple selection or an active patch. The pages in a list are 
sent whether a channel is selected or not. Therefore, a page failure results for 
each page sent in the programmed pages list, if a channel is not selected. 

NOTE

A page is not placed in the transmit queue behind another page. If you have 
two separate pages to send, you must wait for the first one to complete 
before initiating the second one.

If you send a page using an external pager, check the indicators on the 
external pager to see if the page has completed before issuing another page 
of any kind.
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MANUAL PAGE

To page with the Man Page button, follow this procedure:

PROCEDURE 2-39  HOW TO PAGE WITH THE MAN (MANUAL) PAGE BUTTON 

1 Choose the radio channel for paging.

2 Click the Man Page button or choose Manual Page from the Tools menu.

Result: The Paging and Signaling dialog box appears.

3 From the available tabs, choose the kind of paging tone: Custom, Moto 1+1, 
Moto 2+2, GE X, GE Y, GE Z100, GE Z400, MOTO 5, KNOX, DTMF, etc. 
Plus, a variety of customized formats are set at the CSDM.

NOTE

The tab contents/keypad changes to reflect the codes for each 
kind of paging tone.
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4 To define one specific radio channel and frequency for the page, go to the 
Steering area. Highlight the desired radio channel and frequency using the 
drop-down menus. 

• Channel — displays the available radio channels on the console. One of 
the choices in the list is Selected. Choosing this option steers the page to 
all the radio channels that are selected at the console. In this case, the 
frequency scroll lists are forced to Default and cannot be changed as long 
as Channel is set to Selected

• Frequency — presents the following choices: Default, Frequency 1 
through Frequency 16. The available options depend on the frequencies 
available on the radio channel that you selected under Channel (above)

Choosing Default steers the page to the frequency that is currently used by 
the system for the radio channel. Choosing Frequency 1 through Frequency 
16 steers the page to that particular frequency of the radio channel.

NOTE

The MIP 5000 VoIP Radio Console uses the default value if you 
do not choose an entry.

If a radio channel is selected as a result of being in an open 
multiple selection or an active patch, you cannot page on this 
channel when Steering — Channel is set to Selected. To send a 
page on such a channel, you must steer it to this channel by 
choosing this channel from the Steering — Channel list.

PROCEDURE 2-39  HOW TO PAGE WITH THE MAN (MANUAL) PAGE BUTTON (CONTINUED)
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5 Use the keypad to dial the paging code or tone sequence.

If required, use the Clear and Back buttons to remove any mistyped characters.

NOTE

After you have typed the maximum number of digits for the 
code or sequence, the program does not accept any more digits.

OR

Choose an alias in the MDC Unit Alias area and click the Select Alias 
button. Alternatively, you can double click in the list to choose the alias 
(This list is maintained in the Caller ID database). 

NOTE

MDC unit aliases are only available for selection if the Steering 
area identifies a channel configured for STAT-ALERT signaling. 
They are never available when the Selected channel is specified.

Result: The code appears in the Code field.

6 The Status area shows the status of the page. Click the Clear button to clear 
the Status area.

7 To transmit the paging/signaling sequence, click the Send button. 

Result: The dialog box remains open and the Transmit indicator appears 
on the selected Radio Channel control(s) and on the Man Page button.

Click the Abort button to cancel this page but stay in the dialog box.

OR

Click Close to return to your main window.

PROCEDURE 2-39  HOW TO PAGE WITH THE MAN (MANUAL) PAGE BUTTON (CONTINUED)
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8 The Transmit indicator on the Radio Channel control disappears, if there is 
no talkdown (this is also known as voice annotation delay and it is set in 
the CSDM) associated with this page.  
The Transmit indicator on the Radio Channel control remains, if a 
talkdown time is associated with this page.

Result: If configured, a green Talkdown indicator appears in the Status 
area of the Paging and Signaling dialog box. For the duration that this 
indicator appears you can transmit without pressing the Common 
Transmit button or the Instant Transmit button.

• If you need to transmit, on the selected Radio Channel control, for longer 
then the duration of the Talkdown indicator, click the Common Transmit 
button or the Instant Transmit button and speak into your headset. If 
your page is steered to an unselected Radio Channel control, you must 
choose the Radio Channel control before continuing with your message

• To end the voice message, release the Common Transmit button or the 
Instant Transmit button

• If you talk longer than allowed (that is, when the transmit timeout occurs 
[set in the CSDM]), a Paging Aborted message appears in the Status area 
of the Paging and Signaling dialog box (or for as long as the PTT is 
held). A Transmit (error) indicator also appears on the Radio Channel 
control involved in the page when there is a transmit timeout

PROCEDURE 2-39  HOW TO PAGE WITH THE MAN (MANUAL) PAGE BUTTON (CONTINUED)
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STAT-ALERT SIGNALING

To send STAT-ALERT signals, the Radio Channel Control must be configured, at the 
CSDM, for STAT-ALERT (MDC 1200) signaling.

INCOMING SIGNALING

Whenever STAT-ALERT signaling is received on a frequency, that signaling is 
interpreted and appears on the Radio Channel control. The console provides for five 
types of incoming signaling:

• PTT ID — Mobile radios or consoles send a PTT ID whenever voice transmission 
begins or ends. The system matches an incoming mobile radio PTT ID to an alias 
in the Caller ID Alias database. If the system finds a match, the Alias appears in 
the label area of the Radio Channel control

• Status/Message — The system receives a status or message when a radio user 
activates a preset code, or when you manually request the mobile radio’s status. 
The system handles status/messages like PTT ID messages: the status/message 
appears on the Radio Channel control label area right below the PTT ID (if 
present)

• Call Alert — The system receives a Call Alert when a radio user calls a specific 
console. At that console, a tone sounds momentarily, and the label area of the 
Radio Channel control shows Call Alert and the originator ID. You clear the call 
alert condition by pressing the Clear button in the Activity Log window

• Emergency — The system receives an Emergency when a radio user activates the 
Emergency switch on their mobile radio. All consoles that have that Radio 
Channel control hear a tone, the radio identification appears in red and the Radio 
Channel control is outlined in red (Radio Channel control color is configurable). 
See “Responding to an Emergency Alarm” on page 2-23 for more information 
about handling an emergency call

NOTE

If configured on your console and an emergency call is received on a Radio 
Channel control that is not visible on your currently displayed Multiple Tab 
window, the page tab, where the emergency Radio Channel control resides, 
changes to red, and an alarm symbol appears. Choose this tab to gain access 
to the Radio Channel control that is declaring an emergency.

• Voice Alert — constitutes a Voice Selective Call, Individual Call and Unit to Unit 
Call (synonymous). This function sends a Voice Alert to a unit, causing it to 
unmute its speakers
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OUTGOING SIGNALING

Included in the Manual Paging types are STAT-ALERT functions: call alert, radio check, 
remote monitor, status request, manual RAC, radio enable/disable and repeater 
enable/disable. When a console initiates a STAT-ALERT (MDC) manual page to a 
specific mobile radio, the console expects an acknowledgement (ACK) from the mobile. 
Only a Voice Alert MDC page and a Call Alert to a Group do not expect an ACK.

The label area of the Radio Channel control shows different messages under the 
following circumstances for “STAT-ALERT” manual paging:

• When the console receives an ACK, the Status area states ACK Received

• If an ACK is not received within a pseudo-random wait time, the console re-
transmits the MDC page and the Status area states RETRY # <where # is the 
actual number of the times the page has been attempted (fixed at up to four 
attempts)>

• If an ACK has not been received after the fourth retry, the Status area states No 
ACK

NOTE

It is also possible to configure the Page List with various STAT-ALERT 
sequences. 
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SENDING STAT-ALERT SIGNALS

To send a STAT-ALERT, you must choose the STAT-ALERT type and the mobile ID to 
whom you want to send the STAT-ALERT MDC page.

For more information about STAT-ALERT, see “STAT-ALERT Signaling” on page 2-54.

PROCEDURE 2-40  HOW TO SEND STAT-ALERT MESSAGES 

1 Choose the radio channel that you want to use for paging.

2 Click the Man Page button or choose Manual Page from the Tools menu.

Result: The Paging and Signaling dialog box appears.

3 From the available tabs, choose the STAT-ALERT signaling type (for 
example, Call Alert or Voice Alert, etc.).

NOTE

The keypad changes to reflect the codes for each kind of paging 
or signaling type.
2-56 6881013Y34-D    OCTOBER 2010



MIP 5000 VOIP RADIO CONSOLE OPERATOR MANUAL  PAGING
4 Choose an alias in the MDC Unit Alias list (list automatically appears) and 
click the Select Alias button. (This list is maintained in the Caller ID 
database).

OR

Manually, type a code via the keypad area.

Result: The code appears in the Code area.

If required, use the Clear and Back buttons to remove any mis-typed characters.

NOTE

After you have typed the maximum number of digits for the code or 
sequence, the program does not allow you to add any more digits.

5 To define a specific Radio Channel control and frequency for the page, go 
to the Steering area. Highlight the desired Radio Channel control and 
frequency using the drop-down menus.

• Channel — displays the available Radio Channel controls on the console. 
One of the choices in the list is Selected. Choosing this option steers the 
page to all the radio channels that are selected at the console. In this case, 
the frequency scroll lists are forced to Default and cannot be changed as 
long as Channel is set to Selected

• Frequency — presents the following choices: Default, Frequency 1 
through Frequency 16. The available options depend on the frequencies 
available on the radio channel that you selected under Channel (above)

Choosing Default steers the page to the frequency that is currently used by 
the system for the radio channel. Choosing Frequency 1 through Frequency 
16 steers the page to that particular frequency of the radio channel

NOTE

The MIP 5000 VoIP Radio Console uses the default value, if you 
do not choose an entry.

NOTE

If a radio channel is selected as a result of being in an open 
multiple selection or an active patch, you cannot page on this 
channel when Steering — Channel is set to Selected. To send a 
page on such a channel, you must steer it to this channel by 
choosing this channel from the Steering — Channel list.

PROCEDURE 2-40  HOW TO SEND STAT-ALERT MESSAGES (CONTINUED)
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PAGING WITH A PROGRAMMED LIST

The system administrator, or an individual with the proper access level, prepares the 
pre-programmed lists. The MIP 5000 VoIP Radio Console provides access to these pre-
programmed lists. These tabs contain a unique list of participants (individuals or 
agencies). From the chosen tab, you choose the participants, which are then stacked in a 
paging queue.

For information about radio channel behavior when paging, see “Multiple Pages Radio 
Channel Behavior” on page 2-63.

6 The Status area shows the status of the page. Click the Clear button to clear 
the Status area.

7 To transmit the paging/signaling sequence, click the Send button. 

Result: The Transmit indicator appears on the selected Radio Channel 
control and in the Status area of the Paging and Signaling dialog box.

Click the Abort button to cancel this page but stay in the dialog box.

OR

Click Close to return to your main window.

8 The Transmit indicator on the Radio Channel control disappears, if there is 
no talkdown (this is also known as voice annotation delay and it is set in 
the CSDM) associated with this page.  
The Transmit indicator on the Radio Channel control remains, if a 
talkdown time is associated with this page.

Result: If configured, a green Talkdown indicator appears in the Status 
area of the Paging and Signaling dialog box. For the duration that this 
indicator appears you can transmit without pressing the Common 
Transmit button or the Instant Transmit button.

• If you need to transmit, on the selected Radio Channel control, for longer 
then the duration of the Talkdown indicator, click the Common Transmit 
button or the Instant Transmit button and speak into your headset. If 
your page is steered to an unselected Radio Channel control, you must 
choose the Radio Channel control before continuing with your message

• To end the voice message, release the Common Transmit button or the 
Instant Transmit button

• If you talk longer than allowed (that is, when the transmit timeout occurs 
[set in the CSDM]), a Paging Aborted message appears in the Status area 
of the Paging and Signaling dialog box (or for as long as the PTT is 
held). A transmit (error) indicator also appears on the Radio Channel 
control involved in the page when there is a transmit timeout

PROCEDURE 2-40  HOW TO SEND STAT-ALERT MESSAGES (CONTINUED)
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NOTE

The time it takes to transmit a page depends on the number of participants 
in the page.

NOTE

To update any of the page lists, see the system administrator or the 
supervisor.

NOTE

If a Radio Channel control is already active in an open multiple selection or 
active patch, typically, you cannot use this Radio Channel control for a page. 
You can use one specific radio channel involved in a multiple selection or an 
active patch, if you steer the page directly to that one specific Radio Channel 
control. 

NOTE

When using programmed pages, which specify that the page transmits on 
the “selected channel”, ensure that you have a channel selected that is not 
involved in a multiple selection or an active patch see Note above. The 
pages in a list are sent whether a channel is selected or not. Therefore, a page 
failure results for each page sent in the programmed pages list, if a channel 
is not selected.

PROCEDURE 2-41  HOW TO SEND A PAGE WITH THE PROGRAMMED LIST 

1 Choose the radio channel that you want to use for paging.

NOTE

You might not need this step, as some pages specify the radio 
channel and frequency required for transmitting the paging 
tones.
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2 Click the Page List button or choose Page List from the Tools menu. 

Result: The Paging Facility dialog box appears.

3 Click the tab for the page list containing the desired participants. 

Result: The chosen page list appears.

PROCEDURE 2-41  HOW TO SEND A PAGE WITH THE PROGRAMMED LIST (CONTINUED)
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4 Choose the desired participants for the page. 

Result: The chosen participants appear in the Stack area in the chosen 
order.

NOTE

When an asterisk appears beside a page in the Stack area, this 
indicates that this page is assigned to a Single Page button. See 
“Paging with a Single Page Button” on page 2-65 for more 
information.

NOTE

A Group page that appears dimmed in the Page Facility list 
indicates a failure. For example, if a channel of a single page 
within a group stops working, then the group is unavailable in 
the MIP 5000 VoIP Radio Console program. Consult with your 
system administrator to troubleshoot the problem.

NOTE

If the Group page sequence fails or is aborted, the Group label 
remains in the Stack list. Use the Page History window to see 
which pages were successfully transmitted. See “Information 
Window” on page 1-11 for more information.

PROCEDURE 2-41  HOW TO SEND A PAGE WITH THE PROGRAMMED LIST (CONTINUED)
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To remove a chosen participant:

• Under the tab list, click the highlighted participant a second time

Result: The highlighting disappears from that participant and the 
participant’s name is removed from the Stack area. 

OR

• Under the Stack area, click on the participant you want to remove and 
then choose the X (Delete) button from the top of the list

Result: The participant’s name disappears from the Stack area. 

To remove all chosen participants, click the Clear Stack button. 

Result: All highlights disappear from the chosen participants and all 
participants’ names are removed from the Stack area.

To rearrange the order of the participants in the paging stack list, click on 
the participant you want to move and then choose the Move Up Arrow 
and/or Move Down Arrow buttons from the top of the list. 

Result: The participant’s name moves accordingly in the Stack list.

5 Click the Send button. 

Result: The Transmit indicator appears on the Radio Channel control of 
the selected radio channel and in the Status area of the Paging Facility 
dialog box. As the console sends each individual participant’s page, they 
are individually removed from the paging stack.

OR

Click the Abort button, at anytime, to cancel the progress of the page stack.

NOTE

If a Radio Channel control is already active in an open multiple 
selection or active patch, you cannot use this Radio Channel 
control for a page, unless you steer the page directly to a specific 
Radio Channel control. 

NOTE

Any unsuccessful page participants remain in the stack after all 
of the pages are sent.

PROCEDURE 2-41  HOW TO SEND A PAGE WITH THE PROGRAMMED LIST (CONTINUED)
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MULTIPLE PAGES RADIO CHANNEL BEHAVIOR

When using the Page List or the group associated Single Page button and you send 
multiple pages that share a radio channel (and frequency), the radio channel stays 
keyed until the last page in the list or group is transmitted. You determine the order of 
the pages by either the page selection process or by using the Move Up Arrow and/or 
Move Down Arrow buttons that change the sequence of the pages.

The radio channel keys when it is needed to send the page in the paging sequence. The 
channel remains keyed until the last page in the sequence, using that channel (and 
frequency), goes out. If voice annotation (talkdown) is enable, the channel remains 
keyed until the voice annotation is finished. If the steering properties of a channel 
changes (that is, the frequency) in the paging sequence, plus there is voice annotation 
on one of the keyed channels, the paging sequence is delayed to allow for the voice 
annotation. After the voice annotation is completed, the keyed channels are de-keyed. 
The paging sequence then continues by keying the required channels to complete all of 
the remaining pages in the sequence.

Here is an example to help explain a multiple page sequence, you choose single pages 
in the following order:

6 You can send a voice message, after the Transmit indicator disappears 
from the Status area of the Paging Facility dialog box. The Transmit 
indicator remains on the selected Radio Channel control, if a talkdown 
time (this is also known as voice annotation delay and it is set in the 
CSDM) is associated with this page. 

Result: If configured, a green Talkdown indicator appears in the Status 
area of the Paging Facility dialog box. For the duration that this indicator 
appears you can transmit without pressing the Common Transmit button 
or the Instant Transmit button.

• If you need to transmit, on the selected Radio Channel control, for longer 
then the duration of the Talkdown indicator, click the Common Transmit 
button or the Instant Transmit button and speak into your headset. If 
your page is steered to an unselected Radio Channel control, you must 
choose the channel before continuing with your message.

• To end the voice message, release the Common Transmit button or the 
Instant Transmit button

• If you talk longer than allowed (that is, when the transmit timeout 
occurs), a Paging Aborted message appears in the Status area of the 
Paging Facility dialog box (or for as long as the PTT is held). A Transmit 
(error) indicator also appears on the Radio Channel control involved in 
the page when there is a transmit timeout.

PROCEDURE 2-41  HOW TO SEND A PAGE WITH THE PROGRAMMED LIST (CONTINUED)
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Then, based on the page sequence in Table 2-1, “Multiple Pages Radio Channel 
Behavior,”, the pages go out as:

• Sends Page 1 (Ch1 keyed using F1)

• Sends Page 2 (Ch3 keyed using F1)

• Sends Page 3 (Ch2 keyed using F1)

• Sends Page 4 (Ch1 stilled keyed from Page 1)

• Sends Page 5 (Ch3 stilled keyed from Page 2)

• Sends Page 6 (Ch2 stilled keyed from Page 3)

• Sends Page 7 (Ch1 stilled keyed from Page 1)

• Sends Page 8 (Ch3 stilled keyed from Page 2); now, since there is a change in 
frequency for Page 9, and some of the pages previously sent have voice 
annotation (talkdown) enabled, so a talkdown (voice annotation) period occurs 
and then, Ch1, Ch2 and Ch3 are de-keyed

• Sends Page 9 (Ch1 keyed using F2); since voice annotation (talkdown) is enabled, 
a talkdown period occurs and then Ch1 is de-keyed

TABLE 2-1  MULTIPLE PAGES RADIO CHANNEL BEHAVIOR 

Page Number Channel Frequency Voice Annotation (VA)

Page 1 Ch1 F1

Page 2 Ch3 F1 VA enabled

Page 3 Ch2 F1

Page 4 Ch1 F1

Page 5 Ch3 F1 VA enabled

Page 6 Ch2 F1 VA enabled

Page 7 Ch1 F1

Page 8 Ch3 F1

Page 9 Ch1 F2 VA enabled
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PAGING WITH A SINGLE PAGE BUTTON

The supervisor, or an individual with the proper access level, prepares the Single Page 
button. These buttons can be an individual page or set up as a group page under one 
button that is available on the console desktop. The MIP 5000 VoIP Radio Console 
provides access to up to 512 of these buttons. To avoid accident activation, some Single 
Page buttons require the Safety button. For those buttons, without safety enable, the 
page can not be sent.

When you send a page with a Single Page button, you can see the status of the page, if 
you have the Paging Facility (Page List button) dialog box open or through the Page 
History window.

In the Paging Facility dialog box, a larger text size that is bold with an asterisk 
indicates a group page under a Single Page button. Page names that are a normal text 
size, not bold and have an asterisk are Single Page buttons assigned to one, individual 
page. The names of the buttons on the desktop do not show a difference between a 
group or an individual page.

For information about radio channel behavior when paging, see “Multiple Pages Radio 
Channel Behavior” on page 2-63.

NOTE

For more information and to see all of the Single Page button states, see 
“Single Page Button” on page 3-53.

NOTE

When using programmed pages, which specify that the page transmits on 
the “selected channel”, ensure that you have a channel selected that is not 
involved in a multiple selection or an active patch. The pages in a list are 
sent whether a channel is selected or not. Therefore, a page failure results for 
each page sent in the programmed pages list, if a channel is not selected.

PROCEDURE 2-42  HOW TO PAGE WITH A SINGLE PAGE BUTTON 

1 Choose the radio channel that you want to use for paging.

NOTE

You might not need this step, as some pages specify the radio 
channel required for transmitting the paging tones.

NOTE

A mobile radio can only be paged using the currently selected 
channel.
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To page with a Single Page button with safety, see “Unlocking A Feature with the 
Safety Button” on page 2-81.

2 Click the Single Page button.

Result: The Transmit indicator appears on the Radio Channel control 
affected by this page and on the Single Page button.

(If the Paging Facility dialog box is open, a Transmit indicator appears in 
the Status area.)

If this is a tone page (not MDC signaling), you also hear the paging 
feedback tone in the select speaker or headset (if the paging tone feedback 
volume is set to soft or loud.

3 You can send a voice message, after the Transmit indicator on the button 
disappears (and if applicable, in the Status area of the Paging Facility 
dialog box). The Transmit indicator remains on the selected Radio Channel 
control, if a talkdown time (this is also known as voice annotation delay 
and it is set in the CSDM) is associated with this page. 

Result: If configured, a green Talkdown indicator appears on the button 
(and if applicable, in the Status area of the Paging Facility dialog box). For 
the duration that this indicator appears you can transmit without pressing 
the Common Transmit button or the Instant Transmit button.

• If you need to transmit, on the selected Radio Channel control, for longer 
then the duration of the Talkdown indicator, click the Common Transmit 
button or the Instant Transmit button and speak into your headset. If 
your page is steered to an unselected Radio Channel control, you must 
choose the Radio Channel control before continuing with your message.

• To end the voice message, release the Common Transmit button or the 
Instant Transmit button.

• If you talk longer than allowed a Transmit (error) indicator appears on 
the Radio Channel control involved in the page when there is a transmit 
timeout (also if applicable, a Paging Aborted message appears in the 
Status area of the Paging Facility dialog box (or for as long as the PTT is 
held)).

4 To abort the page, click the Single Page button once again.

OR

If the Paging Facility dialog box is open, click the Abort button to cancel 
this page.

PROCEDURE 2-42  HOW TO PAGE WITH A SINGLE PAGE BUTTON (CONTINUED)
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VIEWING PAGE HISTORY INFORMATION

The Page History window lists all of the pages sent from this console. 

To view this history, get the supervisor (if you don’t have reconfiguration privileges) to 
choose View>Information Window. The Page History window appears.

When you send a successful page, the page appears in the Page History window as 
black text with Pass under the Status column; pages that are not successfully 
transmitted appear in the Page History window in red text with Fail under the Status 
column.

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

ADDITIONAL COMMUNICATIONS FEATURES

This section describes various communications features; for example, the transmit 
priority, transmit queue and other radio communications features. The following 
communications features are described:

• “Understanding Transmit Priority” on page 2-68

• “Understanding the Transmit Queue” on page 2-68

• “Reserving a Radio Channel for Priority Transmissions” on page 2-69

• “Private Line/Tone-Coded Squelch Control” on page 2-71

• “Private Line/Tone-Coded Squelch Control” on page 2-71

• “Taking over Communication on a Radio” on page 2-73

• “Using Encryption Mode” on page 2-75

• “Using the Supervisory Button” on page 2-76

• “Establishing Communications Through a RAC-enabled Repeater” on page 2-77

• “Enabling or Disabling Repeater Function” on page 2-79

• “Unlocking A Feature with the Safety Button” on page 2-81

• “Viewing Radio Text” on page 2-82

• “Accessing Callers Through the Activity Log Window” on page 2-83

• “Adjusting Headset and Speaker Volumes” on page 2-84
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UNDERSTANDING TRANSMIT PRIORITY

To solve potential conflicts when system users attempt to transmit on the same Radio 
Channel control at the same time, a transmit priority scheme is built into the system. 
The table below shows the priority of the various transmissions with respect to the 
activity of the Supervisory button (activated [on] or not [off]). The Supervisory button 
increases the priority level when activated, see “Using the Supervisory Button” on page 
2-76 for more information.

NOTE

When two transmission requests have equal priority, then the first request 
received takes precedence. A page in progress cannot be interrupted by 
another transmission, even one of higher priority.

A parallel unit, if enabled, cannot interrupt another transmission. A parallel 
unit can only be interrupted using the Takeover feature, if enabled.

UNDERSTANDING THE TRANSMIT QUEUE

The transmit queue ensures that all communications on one radio channel can be 
eventually transmitted. The transmit queue is based on transmit priority (see 
“Understanding Transmit Priority” on page 2-68) but if two transmissions have the 
same priority then they are treated on a first come, first transmit basis.

You achieve your position in the line by holding down your PTT button (Instant 
Transmit, Common Transmit) until your position in the queue is met. 

TABLE 2-2  TRANSMIT PRIORITY 

PTT Source
Status of 

Supervisory 
Button

Relative 
Priority

Base Icom button OFF 0 (lowest)

Base Icom button ON 1

Common Tx button, footswitch or microphone PTT, 
Alert Tones

OFF 2

Instant Tx button, Patch, APB # button, Page OFF 3

Common Tx button, Alert Tones ON 4

Instant Tx button, Patch, APB # button, Page ON 5 (highest)
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RESERVING A RADIO CHANNEL FOR PRIORITY 
TRANSMISSIONS

The Mrk Tone button refers to radio channel marker tone, which marks a radio channel 
as reserved for priority transmissions by transmitting periodic tones.

When this feature is on, tones are sent on all selected radio channels every 10 seconds. 
The tones mark the radio channels as priority, and warn non-critical or unauthorized 
radio users not to transmit on these channels. 

The tones are not sent while the radio system is receiving or transmitting on those radio 
channels. The tones cause the Transmit indicator for the marked channels to appear.

NOTE

The tones are sent on all selected radio channels, including patches and 
multiple selections.

This feature toggles between sending periodic tones and not sending them.

PROCEDURE 2-43  HOW TO SEND MARKER TONES 

1 At your console, choose the Radio Channel control that you want to mark 
as priority. If you want to choose multiple Radio Channel controls, use the 
multiple selection or patching feature.

2 Choose the Mrk Tone button.

Result: On your console, the button changes to its active state (two red 
musical notes) and a tone signal begins transmitting to maintain the radio 
channel(s) as priority.

All other consoles, and your own, reflect this priority radio channel 
change. You see the Transmit indicator on the Radio Channel control(s) 
and you hear the marker tone.
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PROCEDURE 2-44  HOW TO STOP THE MARKER TONES 

1 At your console, if you want certain Radio Channel controls to remain 
marked, choose only the Radio Channel controls that you no longer want to 
be marked as priority.

Result: The unselected radio channels stop transmitting marker tones. The 
selected radio channels continue to transmit marker tones.

2 To remove the marker tone from all channels, choose the Mrk Tone button. 

Result: The button returns to its inactive state and the marker tone stops 
transmitting on the selected radio channel(s).
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PRIVATE LINE/TONE-CODED SQUELCH CONTROL

The Private Line feature uses the selected tone in the list for tone-coded squelch control 
on a radio channel. This feature appears in the Radio Channel Control and is available 
only if your system includes a multiple tone-coded Continuous Tone Coded Squelch 
System (CTCSS) and supports a maximum of six private lines per tone-control radio 
channel.

There are two ways to adjust the private line feature to use a different tone:

• Using the Radio Channel shortcut menu

• Using the Up/Down private line buttons in the button area of the Radio Channel 
control (if configured).

To change the code squelch of a radio channel using the shortcut menu, follow this 
procedure:

PROCEDURE 2-45  HOW TO CHANGE CODED SQUELCH (SHORTCUT METHOD) 

1 Access the Radio Channel control shortcut menu. (Click the indicator area 
on the Radio Channel control, or use SHIFT+F10 on your keyboard when 
the focus is on this Radio Channel control.)

Result: The Radio Channel control shortcut menu appears.
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To change the code squelch of a radio channel using the private line buttons, follow this 
procedure:

NOTE

You cannot change the selected PL tone while any console is transmitting on 
the channel. Retry after the transmission is completed.

2 From the Radio Channel control shortcut menu, choose the Private Line 
drop-down menu.

From the drop-down menu, choose the desired coded squelch. (If 
configured on your system using the CSDM, one to six coded squelch 
choices are available.)

Result: A tone signal is sent to keep the base station synchronized with the 
change.

The Radio Channel control shortcut menu remains open until you choose 
the Close (X) button (top right of shortcut menu) or until you click on 
another area of the main screen. The corresponding Private Line indicator 
appears on the Radio Channel control. On revisiting the Private Line drop-
down menu, a dot appears beside the chosen coded squelch. 

All other consoles, as well as your own, reflect this change.

PROCEDURE 2-46  HOW TO CHANGE CODED SQUELCH (BUTTON METHOD) 

1 If configured, use the Up/Down private line buttons in the button area of 
the Radio Channel control to adjust the coded squelch. Use the private line 
Up (+) button to move the coded squelch up in the list or use the private 
line Down (-) button to move the coded squelch down in the list. If the 
Private Line indicator is present in the indicator area of the Radio Channel 
control, it also reflects the change in coded squelch.

All other consoles, and your own, reflect this change.

PROCEDURE 2-45  HOW TO CHANGE CODED SQUELCH (SHORTCUT METHOD) (CONTINUED)
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DISABLING THE CODED SQUELCH/PRIVATE LINE

The Monitor button disables the coded squelch in a base station receiver, thereby 
allowing you to monitor the selected radio channel(s) before transmitting. Depending 
on how the Monitoring feature is configured in the CSDM, the coded squelch remains 
disabled until the next PTT on that channel or until the Monitor button is pressed again 
at any console. Check with the supervisor to see how the Monitoring feature is 
configured.

NOTE

You cannot perform this task while any console is transmitting on the 
channel. Retry after the transmission is completed.

TAKING OVER COMMUNICATION ON A RADIO

The Takeover feature takes over communication on a radio (using the Takeover feature 
on the Radio Channel shortcut menu) thus physically disconnecting all non-MIP 5000 
consoles (connected in parallel to the MIP 5000 console initiating takeover) from the 
radio transmitter (all transmit frequencies). Only the console initiating the Takeover 
can transmit.

PROCEDURE 2-47  HOW TO DISABLE AND ENABLE THE CODED SQUELCH 

1 Click the Monitor button. 

Result: It toggles between squelch enabled and disabled, if configured at 
the CSDM. The Monitor button (a gray speaker) briefly changes to reflect 
that the squelch is disabled (a yellow speaker with sound waves).

2 Listen on the Radio Channel control for radio activity. 

3 When the Radio Channel control is clear of radio activity, use one of the 
PTT buttons to transmit.

Result: The squelch is automatically enabled when you transmit. 

OR

To enable the squelch without transmitting, click the Monitor button.

Result: The squelch for this Radio Channel control is enabled.
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When the enabled Takeover indicator appears on all taken over Radio Channel 
controls, only the operator who initiated the takeover can transmit. If you select this 
feature while a parallel unit radio transmission is in progress, that transmission is 
immediately stopped.

Depending on your configuration, when the Takeover indicator is present:

• 4-wire — all parallel units continue to monitor the radio traffic on the receive 
frequency

• 2-wire — all parallel units are unable to transmit or receive

This feature is toggled between enable and disable. In the disable state, radio 
communication proceeds as normal and the disabled Takeover indicator is present.

NOTE

The indicator reflects the state of the communication on this radio channel, 
not the state of the parallel unit.

Takeover – Enabled Takeover – Disabled

PROCEDURE 2-48  HOW TO ENABLE THE RADIO CHANNEL CONTROL TAKEOVER 

1 Access the Radio Channel control shortcut menu. (Click the indicator area 
on the Radio Channel control, or use SHIFT+F10 on your keyboard when 
the focus is on this Radio Channel control.) 

Result: The Radio Channel control shortcut menu appears.
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USING ENCRYPTION MODE

The Encryption Mode feature enables or disable the transmission security feature on 
an radio channel control. The Coded command encodes the transmission so that the 
information in the transmission is secure (encrypted). The Clear command sends the 
transmission with no encryption.

NOTE

You cannot perform this task when a transmission is in progress. Retry after 
the transmission is completed.

2 From the Radio Channel control shortcut menu, choose Takeover. 

Result: The Takeover indicator changes to the enabled state on the Radio 
Channel control.

3 The Radio Channel control shortcut menu remains open until you choose 
the Close (X) button (top right of shortcut menu) or until you click on 
another area of the main screen. 

Result: A depressed button appears around Takeover. 

PROCEDURE 2-49  HOW TO DISABLE THE RADIO CHANNEL CONTROL TAKEOVER 

1 Access the Radio Channel control shortcut menu. The Radio Channel 
control shortcut menu appears.

2 From the Radio Channel control shortcut menu, choose Takeover.

Result: The Takeover indicator changes to the disabled state on the Radio 
Channel control.

On the shortcut menu, Takeover appears normal (no depressed button).

PROCEDURE 2-48  HOW TO ENABLE THE RADIO CHANNEL CONTROL TAKEOVER 
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USING THE SUPERVISORY BUTTON

The Supervisory button allows you to prioritize a PTT relative to the PTT of other 
MIP 5000 consoles. Keying a busy radio channel with a PTT of higher priority than the 
current PTT results in an override condition. For more information, see 
“Understanding Transmit Priority” on page 2-68. 

PROCEDURE 2-50  ENABLING OR DISABLING ENCRYPTION MODE 

1 Access the radio channel control shortcut menu. (Click the indicator area 
on the radio channel control, or use SHIFT+F10 on your keyboard when 
the focus is on this radio channel control.)

Result: The radio channel control shortcut menu appears.

2 From the radio channel control shortcut menu, choose the Encryption 
Mode drop-down menu. From the drop-down menu, choose the Clear or 
Coded (encrypted) command. 

Result: The indicator appears on the radio channel control (open lock – 
Clear; closed lock – Coded). 

3 The radio channel control shortcut menu remains open until you choose 
the Close (X) button (top right of shortcut menu) or until you click on 
another area of the main screen. 

Result: On the Encryption Mode drop-down menu, a dot appears beside 
the chosen security command.

4 Revisit the Encryption Mode command to change the security level 
(Coded back to Clear and vice-versa).
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ESTABLISHING COMMUNICATIONS THROUGH A RAC-
ENABLED REPEATER

You can enter a repeater access code (RAC) on a per Radio Channel control basis to 
establish communication through a RAC-enabled repeater, either manually or via pre-
programmed codes (MDC Unit Alias). The specific RAC chooses which repeater is 
accessed. The program stores the RAC in memory and uses it each time you transmit, 
so that each transmission accesses the same repeater.

PROCEDURE 2-51  HOW TO ACTIVATE THE SUPERVISORY BUTTON 

1 Choose the busy Radio Channel control(s) on which you want to invoke 
the Supervisor Transmit Priority feature.

2 Choose the Supervisory button. 

Result: The Supervisory button changes color to signify it is active. The 
busy Radio Channel control transmission becomes available to the 
Supervisor.

3 To deactivate the Supervisor Transmit Priority feature, choose the 
Supervisory button again. 

Result: The Supervisory button changes back to its inactive state (dimmed 
appearance).

PROCEDURE 2-52  HOW TO ASSIGN A RAC TO A CHANNEL 

1 Choose Enter RAC from the Tools menu. 

Result: The Enter RAC dialog box appears.

2 Choose a Radio Channel control from the Channel: drop-down menu. 
(Only Radio Channel control(s) configured for STAT-ALERT signaling 
(through the CSDM) appear in this list.)

Result: The MDC Unit Alias list displays all the MDC Unit aliases 
maintained in the Caller ID database. 
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3 Use the MDC Unit Alias area to enter a new RAC by choosing an alias 
from the list (choose the alias from the list then click the Select Alias 
button) or manually type a code via the Keypad area on the Enter RAC 
dialog box.

Result: The MDC Unit Alias or manually entered code appears in the 
Code area.

4 Use the Back and Clear buttons in the Code area to adjust the code if 
necessary.

5 Repeat step 2 through step 4, if required.

6 When you are done, click OK to save the newly entered RAC and close the 
Enter RAC dialog box.

OR

Click Cancel to close the Enter RAC dialog box without changing the 
RAC.

Result: You return to the main window.

PROCEDURE 2-52  HOW TO ASSIGN A RAC TO A CHANNEL (CONTINUED)
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ENABLING OR DISABLING REPEATER FUNCTION

The Repeat Disable feature on the Radio Channel shortcut menu enables and disables 
repeat function of the station. The Repeat Disable indicator is present on the Radio 
Channel Control: enable and disable (inactive/normal state). A repeater uses semi- or 
full-duplex radio channels. When the repeat feature is enabled, your radio channel 
retransmits (repeats) incoming (received) radio traffic, effectively extending the 
coverage area for all users on the radio channel. When the repeat feature is disabled, all 
units can still communicate back and forth with you but cannot hear any other unit 
(except you) on the radio channel.

The indicator is present when this Radio Channel control has access to the Repeat 
Disable feature. The indicator, typically, shows the indicator as repeater access inactive 
and then it changes to a new indicator when it is active.

NOTE

You cannot perform this task while any console is transmitting on the 
channel. Retry after the transmission is completed.

Repeat Disable – Active, repeat feature disabled Repeat Disable – Inactive (normal state)

PROCEDURE 2-53  HOW TO ACTIVATE THE REPEAT DISABLE FUNCTION 

1 Access the Radio Channel control shortcut menu. (Click the indicator area 
on the Radio Channel control, or use SHIFT+F10 on your keyboard when 
the focus is on this Radio Channel control.)

Result: The Radio Channel control shortcut menu appears.

2 From the Radio Channel control shortcut menu, choose Repeat Disable. 

Result: The Repeat Disable indicator changes on the Radio Channel 
control to the activated (active) indicator.
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3 The Radio Channel control shortcut menu remains open until you choose 
the Close (X) button (top right of shortcut menu) or until you click on 
another area of the main screen. 

Result: On the shortcut menu, a depressed button appears around Repeat 
Disable.

PROCEDURE 2-54  HOW TO DEACTIVATE THE REPEAT DISABLE FUNCTION 

1 Access the Radio Channel control shortcut menu. (Click the indicator area 
on the Radio Channel control, or use SHIFT+F10 on your keyboard when 
the focus is on this Radio Channel control.)

Result: The Radio Channel control shortcut menu appears.

2 From the Radio Channel control shortcut menu, choose Repeat Disable. 

Result: The Repeat Disable indicator changes on the Radio Channel 
control to the deactivated (normal, inactive state) indicator.

On the shortcut menu, a depressed button no longer appears around 
Repeat Disable (it appears normal).

PROCEDURE 2-53  HOW TO ACTIVATE THE REPEAT DISABLE FUNCTION (CONTINUED)
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UNLOCKING A FEATURE WITH THE SAFETY BUTTON

The Safety button prevents the operation of a specifically configured Single Page 
button on the console unless you activate the Safety button first.

In some systems, you must use the Safety button before using Single Page button (to 
ensure that you are not accidentally activating a page). In the page situation, the Single 
Page button with the safety feature enabled appears with an orange lock in the bottom 
right-hand corner.

To use the safety button:

 

Safety button Single Page button with safety feature

PROCEDURE 2-55  HOW TO USE THE SAFETY BUTTON 

1 Choose the Safety button.

NOTE

The Safety button times out if you do not choose a Single Page 
button.

Result: The Safety button changes to the closed lock (available) state.

2 Choose the specifically Single Page button that you want to activate.

Result: The Single Page button activates and the Safety button returns to 
the open lock (unavailable) state.

3 If required, repeat for the specifically configured Single Page button(s) 
that you want to activate.
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VIEWING RADIO TEXT

The Radio Text window displays text from the control head of the MOTOTRBO radio 
and the name of the Radio Channel control on which it is displayed. The window 
automatically updates with new text as it arrives on the Radio Channel control. 

NOTE

You can view radio text from the selected MOTOTRBO radio control head in 
the associated keypad (see “MOTOTRBO Keypad” on page 1-24) and the 
label area of the associated Radio Channel control (see “MOTOTRBO Radio 
Channels” on page 1-21).

PROCEDURE 2-56  HOW TO VIEW RADIO TEXT IN THE INFORMATION WINDOW 

1 Open the Radio Text window, by clicking a Radio Text tab on the 
Information Window. 

Result: The Radio Text window opens.

2 Click and drag the desired MOTOTRBO Radio Channel control into the 
Radio Text window.

Result: The name of the Radio Channel control and radio text appear in the 
window.
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ACCESSING CALLERS THROUGH THE ACTIVITY LOG 
WINDOW

The Activity Log window provides you with a view and access to a list of all radio 
channel activities at the console. For easier access, if configured, four tabs separate the 
window into All Calls, Emergency, Select and Unselect lists. Through this log, you 
reconnect with previous radio callers, acknowledge alarms and clear alarms, plus view 
information about the various calls.

NOTE

For more detailed information about handling emergency calls, see 
“Responding to an Emergency Alarm” on page 2-23.

PROCEDURE 2-57  HOW TO RETRANSMIT TO CALLERS VIA ACTIVITY LOG WINDOW 

1 Choose the desired tab in the Activity Log window. (If this window is not 
available on your main window, see the supervisor to add this window).

2 Scroll through the list, if required, to access the desired caller.

3 Click on the row of the caller with whom you want to connect. 

Result: The row becomes highlighted and the radio channel name appears 
at the top of the window, plus the Transmit button on the Activity Log 
window becomes active.
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ADJUSTING HEADSET AND SPEAKER VOLUMES

You can adjust the select and unselect speaker volumes and the operator and 
supervisor headset (if present) ear piece volumes using the Volume window. If it is not 
already displayed on your screen, ask a supervisor to use the Volume Window 
command on the View menu to make it available.

NOTE

MIP 5000 VoIP Radio Consoles can be operated with either standard 4- or 6-
wire headsets, each of which requires a USB jackbox, or with Windows-
compatible USB headsets.

Jackboxes or headsets are to be labeled Operator or Supervisor, according 
the assignment made during installation. To set the headset volume of an 
unlabeled jackbox or headset, you might need to try one slider, then the 
other.

4 Transmit to the selected channel via the Activity Log window Transmit 
button. 

Result: The Transmit indicator appears on the Radio Channel control 
associated with this channel and a Transmit indicator appears in the 
Activity Log window beside the Transmit button.

5 If an emergency occurs, the system puts the call under the Emergency tab 
and on the All Calls tab. To acknowledge the emergency, choose the red 
emergency call from the list and choose the ACO (Alarm Cut Off) button. 

NOTE

If the Emergency arrives on a selected Radio Channel control, 
the call will also appear under the Select or Unselected tab.

Result: The alarm sound stops.

6 When the emergency is over, use the CLR (Clear) button to clear the alarm 
from its emergency status.

PROCEDURE 2-57  HOW TO RETRANSMIT TO CALLERS VIA ACTIVITY LOG WINDOW 
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PROCEDURE 2-58  HOW TO ADJUST HEADSET AND SPEAKER VOLUME 

1 Choose Volume Window from the Tools menu. 

Result: The Volume window appears.

2 Choose the slide control for the speaker you want to adjust (Select, 
Unselect, Opr Hdst ear piece, or Supv Hdst ear piece) and drag the slider 
to control the volume of the speaker. 

Result: The associated speaker volume is adjusted according to the new 
setting.
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CHAPTER

3

BUTTONS, CONTROLS AND 

. . . .

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
INDICATORS 3

This section describes each button, control, and indicator that can appear on your 
Motorola MIP 5000 VoIP Radio Console. Keep in mind that your console displays only 
those configured by the supervisor.

With the information presented in this section, you should be able to design your own 
procedures for tasks specific to your job.

For easy reference, the buttons, controls and indicators are in alphabetical order, by 
their default names. 

NOTE

Supervisors can rename the function buttons on the console, therefore the 
button names that you see here might not be what you see on the console.

The function buttons listed in the table below can be renamed using the 
CSDM. Consult the Motorola MIP 5000 Installation and Configuration Manual 
(6881013Y35) for information on renaming buttons.

TABLE 3-1  RENAMEABLE FUNCTION BUTTONS/CONTROLS 

Alert # Button (3 total) All Mute Button APB # Button (10 total)

Base Icom Call Dir Control Common Tx

Manual Page Monitor Button Mrk Tone Button

MSel # Button (10 total) MSel w/o M Button Page List Button

Patch # Button (10 total) Patch w/o M Button Supervisory Button
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Table 3-2 “Button/Control/Indicator/Symbol Quick Reference Table” on page 3-66 is a 
quick reference table in alphabetical order based on the default names for the buttons, 
controls and indicators.

Most of the buttons, controls and indicators described in this section are available to all 
dispatchers. Some of the buttons, controls and indicators are available only to the 
supervisors. Any restrictions are included in the description of the button, control or 
indicator.
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. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

ALERT # BUTTON

The Alert # button transmits a special signal over the selected radio channels, including 
channels that are already keyed. The alert function allows you to inform the receiving 
end of an urgent radio transmission. Three tone frequencies are available:

• Alert 1: continuous 1000 Hz tone

• Alert 2: alternating 800 and 1500 Hz tones

• Alert 3: a pulsing 1000 Hz tone

During the alert tones, the Alert # button shows a red Transmit indicator on the button 
area. When the alert tone finishes, the indicator changes to a green Transmit (talkdown) 
indicator over the original indicator. This indicator demonstrates that your microphone 
is keyed for a specific time (set system-wide in the CSDM) and you can send your voice 
message for the duration that the Transmit (talkdown) indicator is present. You 
transmit your urgent message when the indicator is present. If you require more time 
for your message, use the Common Transmit button or Instant Transmit button and 
speak into your headset.

NOTE

The Alert # button sounds an error if no radio channel is selected.

An alert tone can be sent on channels in a multiple selection and over a patch.

NOTE

Supervisors can rename this function button on the console, therefore the 
button name that you see here might not be what you see on your console.

Red transmit Green transmit (talkdown)
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. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

ALL MUTE BUTTON

The All Mute button mutes all unselect radio channel audio at this console temporarily. 
The audio from the unselect speaker is reduced by 24 dB or entirely muted for 0 to 120 
seconds (set in the CSDM). A red prohibitory sign appears on the unselect Radio 
Channel control(s) to show that the All Mute button is muting these channels. 

By muting all unselect audio, you can concentrate on the audio at your select speaker 
or headset. When you want to hear the unselect audio again, you can either click the 
All Mute button again or wait for the automatic timer to turn it back on.

The All Mute button includes an automatic timer, so you can never forget to cancel it. 
After a few seconds, all unselect audio returns to its original volume. The duration of 
this automatic timer is set at the CSDM, and is the same for all consoles.

NOTE

Supervisors can rename this function button on the console, therefore the 
button name that you see here might not be what you see on your console.

RELATED FEATURES:

• “Mute Button” on page 3-33

All Mute – Inactive All Mute – Active

Channel that is muted with the Mute 
button (sound wave still present)

Channel that is muted with the All Mute 
button (no sound waves present)
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. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

APB # BUTTON

The APB # (All Points Bulletin) button transmits over the channels stored in an 
associated multiple selection with memory whether it is selected or not. There are ten 
available APB # buttons (one for each MSel # with memory button).

NOTE

Supervisors can rename this function button on the console, therefore the 
button name that you see here might not be what you see on your console.

RELATED FEATURES:

• “MSel # Button” on page 3-31

APB – Inactive APB – Active
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. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

BACK/HOME CONTROL

The Back/Home control returns you to the top of the menu in the MOTOTRBO keypad. 
The buttons operates with the following short press/long press functionality:

• Short press — Returns to the previous Menu level.

• Long press — Exits the Menu.

NOTE

You can invoke the Back/Home command function by using the - (minus) 
key, the Home key, and the Backspace key on the numeric keypad of the 
workstation keyboard.

RELATED FEATURES:

• “Menu/Home Indicator” on page 3-25
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. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

BASE ICOM BUTTON

The Base Icom (Intercom) button permits you to send audio to a base station without 
keying it.

An intercom call is made on the currently selected radio channel(s). If a parallel unit is 
associated with the single base station channel, you can communicate with the parallel 
unit dispatcher.

To place an intercom call to the selected base station, click and hold the Base Icom 
button, and talk into your headset. The Base Icom Transmit indicator (two red transmit 
icons in the middle of button) appears while this button is held. To end the call, release 
the Base Icom button, the Base Icom Transmit indicator disappears when it is released.

The Base Icom button cannot be included in a patch or a multiple selection. 

This button does not include an interface for incoming calls from the base station; 
incoming calls are seen as radio calls. 

NOTE

Supervisors can rename this function button on the console, therefore the 
button name that you see here might not be what you see on your console.

Base Icom – Inactive Base Icom – Active
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. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

CALL DIR CONTROL

The Call Dir (Call Director) control enables you to use the MIP 5000 VoIP Radio 
Console to communicate with telephone calls from a separate telephone system. When 
you enable this feature, your console connects to a Call Director interface that receives 
the separate system’s calls. The Call Dir control permits you to patch a call through the 
Call Director interface.

When the Call Dir control is inactive, the button shows a blue background. When a call 
is active and there is activity on the call, through the Call Dir control, the background 
changes to red and the transmit symbol appears over the telephone symbol (transmit 
state). When there is an error with a transmission, the yellow triangle with exclamation 
appears on the blue background button (error state).

NOTE

The specific operating instructions for the Call Director interface vary, 
depending on the type of interface in use. For instructions on using the Call 
Director interface, consult the original documentation provided by the 
manufacturer. 

NOTE

Supervisors can rename this function button on the console, therefore the 
button name that you see here might not be what you see on your console.

Call Dir Inactive Call Dir Off Hook Call Dir Transmit Call Dir Error
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. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

CALL INDICATOR

The Call indicator alerts you of an incoming call on the Radio Channel control where 
the Call indicator appears.

There are a few versions of the Call indicator, which help to distinguish the type of 
radio call, but they are all indicators of an incoming call:

These indicators appear whenever an incoming call is detected. An indicator appears 
below the label area in a Radio Channel control and to the left-hand side.

If the call is on a radio channel that is selected at your console:

• One of the green Call indicators appears
 

• The unit or alias ID (if applicable) of the radio from which the transmission 
originated appears on the Radio Channel control below the channel label 

• You hear the audio on your select speaker or headset

• You can transmit with any push-to-talk (PTT) button (Instant Transmit, Common 
Transmit button

Call 
Indicator 

Call Busy 
Indicator 
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If the call is on a radio channel that is not selected at your console but is selected at another 
console:

• One of the yellow Call indicators appears

• The unit ID or alias ID (if applicable) of the radio from which the transmission 
originated appears on the channel control below the channel label

• You hear the audio on your unselect speaker

• You can transmit with the Instant Transmit button

OR

You can choose that radio channel and transmit with the common PTT buttons 

If the call is on a channel that is not selected at any console:

• A green Call indicator appears showing that no-one has the Radio Channel 
control selected

• The unit ID or alias ID (if applicable) of the radio from which the transmission 
originated appears on the channel control below the channel label 

• If another console responds to this call by choosing the radio channel, your Call 
indicator turns yellow

• If you respond to this call by choosing that Radio Channel control:

• One of the green Call indicators appears at your console and a yellow Call 
indicator appears at all of the other consoles

• You hear the audio on your select speaker or headset

• You can use any PTT button (Instant Transmit, Common Transmit) to 
transmit on that channel

When the call is complete, the Call indicator disappears.

RELATED FEATURES:

• “Instant Transmit Button” on page 3-20

• “Common Tx Button” on page 3-12
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. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

CHANNEL SCROLL CONTROL

The Channel Scroll control can be configured on the shortcut menu of a MOTOTRBO 
Radio Channel control to move up and down through radio frequencies.

FIGURE 3-1  EXAMPLE OF A CHANNEL SCROLL CONTROL

CH+ Control CH- Control
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. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

COMMON TX BUTTON

The Common Tx (Transmit) button transmits audio to all selected channels when you 
click and hold this button, and talk into your microphone or headset.

This button is always available, even if the console is showing on-line help.

NOTE

Supervisors can rename this function button on the console, therefore the 
button name that you see here might not be what you see on your console.

RELATED FEATURES:

• “Instant Transmit Button” on page 3-20 

• Push-to-talk (PTT) pedal on a footswitch

• Push-to-talk (PTT) button on a desktop microphone
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. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

COMPANDING INDICATOR

The Companding indicator shows that transmissions on a channel are using 
companding to reduce noise. This indicator appears on the Radio Channel control.
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. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

CROSS MODE INDICATOR

This indicator tells you when the communicating radio channel control is in a different 
encryption mode than the received signal. This means one is encrypted (coded) while 
the other is not (clear). For example, you are transmitting in coded (encrypted) mode 
while the subscriber radio is transmitting without encryption (clear) or vice versa.

This indicator appears in the indicator area of the radio channel control, and you can 
change the encryption of the radio channel control with the Mode option on the radio 
channel control shortcut menu.

RELATED FEATURES:

• “Emergency Indicator” on page 3-16

Cross Mode Clear/Coded Indicator
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. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

DISPLAY SIZE INDICATOR

The Display Size indicator is on the Radio Channel control shortcut menu. Through 
the Display Size drop down menu, you can change the size of the Radio Channel 
control display. 

The available options are small, medium and full size. 

• Small is one row of indicators (the Call and Transmit indicators, plus one 
variable position) 

• Medium is two rows of indicators (the Call and Transmit indicators, plus one 
variable position, and one row of five variable indicator positions)

• Full size is three rows of indicators (the Call and Transmit indicators, plus one 
variable position, and then two rows of five variable indicator positions on each 
row (totaling eleven variable positions))

The Instant Transmit and Mute button are always present. The display size does not 
affect this area.

Small Medium Full size
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. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

EMERGENCY INDICATOR

The Emergency indicator shows that the MOTOTRBO Radio Channel is in Emergency 
mode.

RELATED FEATURES:

• “Responding to an Emergency Alarm” on page 2-23
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. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

ENCRYPTION MODE INDICATORS

The Encryption Mode feature lets you set the encryption mode of the transmit audio to 
Coded (encrypted) or to Clear (no encryption). This feature is available via the radio 
channel control shortcut menu.

NOTE

You cannot enable or disable Encryption Mode when a transmission is in 
progress. Retry after the transmission is completed.

RELATED FEATURES:

• “Cross Mode Indicator” on page 3-14

Clear Indicator (analog/mobile) Coded Indicator (analog/mobile)
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. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

EXIT/ESCAPE BUTTON INDICATOR

The Exit/Escape indicator corresponds to the Exit or Escape button on the mobile radio 
faceplate. This indicator appears on the radio channel control shortcut menu, next to 
the Exit/Escape command.

FIGURE 3-2  EXAMPLE OF EXIT/ESCAPE INDICATOR

Exit/Escape Indicator
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. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

FREQUENCY INDICATOR

The Frequency indicator displays the number associated to the frequency couple 
actually used for a radio channel. The multi-frequency option is available only if your 
system has multi-frequency transmitters. This feature controls the frequency used for 
multi-frequency transmission. 

The current frequency appears in the Radio Channel control, and if programmed with 
the Aliases, under the channel label. The number of the frequency appears near to the 
center of the indicator. 

The MIP 5000 VoIP Radio Console supports up to 16 frequencies per multi-frequency 
channel (each frequency can have its own alias). Each Radio Channel control is 
associated with one console audio channel to control one radio channel at a time (and 
it's associated frequencies).

FIGURE 3-3  FREQUENCY INDICATOR ON RADIO CHANNEL SHORTCUT MENU

NOTE

You cannot perform this task while any console is transmitting on the 
channel. Retry after the transmission is completed.
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. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

INSTANT TRANSMIT BUTTON

There is an Instant Transmit button on the Radio Channel control for each radio 
channel; when you choose and hold this button and talk into your microphone or 
headset, the audio is sent to this channel whether it is selected or not.

The Transmit indicator appears when you click this button, to indicate that a 
transmission is in progress.

NOTE

If this channel is included in an active patch, the audio is sent to all channels 
included in the patch.

NOTE

If this channel is included in a multiple selection, the audio is sent to only 
this particular radio channel.

RELATED FEATURES:

• “Common Tx Button” on page 3-12

• Push-to-talk (PTT) pedal on a footswitch

• Push-to-talk (PTT) button on a microphone
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. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

KEYPAD/COMMAND VIEW INDICATOR

The Keypad/Command View indicator on the Radio Channel control shortcut menu 
enables you switch between the Command View to the Keypad View. The Command 
View indicator appears in the Keypad. The Keypad View Indicator appears in the 
shortcut list.

FIGURE 3-4  KEYPAD/COMMAND VIEW INDICATOR 

Depending on the Radio Channel control type, one of two Keypads can appear for 
mobile and MOTOTRBO radios. The Generic Keypad displays for mobile radios. The 
MOTOTRBO Radio Channel control has its own type.

FIGURE 3-5  GENERIC KEYPAD AND MOTOTRBO KEYPAD VIEWS

RELATED FEATURES:

• “Radio Channel Shortcut Menu” on page 1-22

• “Keypad” on page 1-23
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. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

LEFT ARROW CONTROL

The Left Arrow control enables you to scroll backward among multiple text messages 
that display on the MOTOTRBO Radio Channel control label and text display of the 
keypad. This arrow key also enables you to scroll through menu options.

RELATED FEATURES:

• “Right Arrow Control” on page 3-47
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. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

MAN PAGE BUTTON

The Man (Manual) Page button brings up the Paging and Signaling dialog box. You 
can use it to send paging and signaling tones on the selected or specified (via steering) 
radio channel.

When you click this button, the Paging and Signaling dialog box appears: 

The Transmit indicator reflects the status on all consoles that include the radio 
channel(s) that are included in the page.

A Transmit indicator appears in the Status area of the Paging and Signaling dialog 
box, when a paging/signaling sequence is sent, that is, when you click the Send button 
on the Paging and Signaling dialog box of the Man Page button, plus a Transmit 
indicator appears on the Man Page button:

Man Page with Transmit indicator on button
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If configured, the Talkdown indicator (on the Paging and Signaling dialog box, Status 
area) appears when the Transmit indicator disappears, and shows that the talk down 
period has begun; you can choose Common Transmit to extend the transmission and 
talk on this channel. 

NOTE

If configured, the paging tones sent on a specific channel are heard at the 
transmitting console in the headset or on the select speaker; other consoles 
monitoring this channel hear the paging tones on their unselect speakers.

NOTE

Supervisors can rename this function button on the console, therefore the 
button name that you see here might not be what you see on your console.

NOTE

If a radio channel is selected as a result of being in an open multiple 
selection or an active patch, you cannot page on this channel when Steering 
— Channel is set to Selected. To send a page on such a channel, you must 
steer it to this channel by choosing this channel from the Steering — 
Channel list.

RELATED FEATURES:

• “Page List Button” on page 3-37

• “Single Page Button” on page 3-53

• “Talkdown Indicator” on page 3-58

Man Page with Talkdown indicator on button
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. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

MENU/HOME INDICATOR

The Menu/Home indicator corresponds to the Menu button on mobile radio faceplates. 
It appears on the Radio Channel control shortcut menu next to the Menu command.

On the MOTOTRBO Radio Channel control, the icon represents the Menu control, 
which opens a list of high-level menu items that can be navigated using arrow keys on 
the keyboard. You can invoke the Menu function by using the + (plus) key or Insert key 
on the numeric keypad of the workstation keyboard. The command can also be 
invoked by the Menu Context key (third key to the right of the Spacebar).

FIGURE 3-6  EXAMPLE OF MENU/HOME INDICATOR

RELATED FEATURES:

• “Back/Home Control” on page 3-6
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. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

MESSAGE INDICATOR

The Unread Message indicator shows that there is at least one unread text message in 
the Inbox of the associated MOTOTRBO Radio Channel control.

After the Inbox has reached its capacity, the Inbox Full indicator appears.
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. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

MOBILE COMMAND INDICATORS

Many of the buttons on the faceplates of mobile radios have LED indicators to show the 
status of the command initiated by the button. On the MIP 5000 VoIP Radio Console, 
the indicator LEDs are emulated by the Mobile Command LED indicators. These 
indicators appear on the Radio Channel control shortcut menu next to the command to 
which they correspond.

Command indicators can appear on the radio channel. If the command has not been 
assigned an alias, the indicator appears as a green square with a white letter 
corresponding with the letter assigned to the mobile radio faceplate button.

FIGURE 3-7  EXAMPLE OF MOBILE BUTTON/COMMAND INDICATORS

LED Off (dark green) LED On (pale green) LED Blinking (yellow)

Aliased Command Indicator
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. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

MONITOR BUTTON

The Monitor button disables the coded squelch in a base station receiver, thereby 
allowing you to monitor all activity on the selected channel(s) before transmitting. 
Depending on how the Monitoring feature is configured in the CSDM, the coded 
squelch remains disabled until the next PTT on that channel or until the Monitor 
button is pressed again at any console. Check with the supervisor to see how the 
Monitoring feature is configured.

When squelch is disabled, the indicator on the button briefly changes to a yellow 
speaker with sound waves instead of a gray speaker with no sound waves.

This coded squelch feature toggles between disabling and enabling the coded squelch, 
but the squelch is automatically enabled whenever a push-to-talk (PTT) is performed 
on a channel.

NOTE

Supervisors can rename this function button on the console, therefore the 
button name that you see here might not be what you see on your console.

NOTE

You cannot perform this task while any console is transmitting on the 
channel. Retry after the transmission is completed.

Monitor Button – Squelch enabled

Monitor Button – Squelch disabled
3-28 6881013Y34-D    OCTOBER 2010



MIP 5000 VOIP RADIO CONSOLE OPERATOR MANUAL  MONITOR INDICATOR
. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

MONITOR INDICATOR

The Monitor indicator on a MOTOTRBO Radio Channel control turns monitoring on 
and off. For other Radio Channel control types, the Monitor button is used.

When the monitoring feature is turned off, the following indicator appears.

RELATED FEATURES:

• “Monitor Button” on page 3-28
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. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

MRK TONE BUTTON

The Mrk (Marker) Tone button marks selected channel(s) for priority transmissions. A 
channel marker tone marks a channel as reserved for priority transmissions by sending 
periodic tones on the selected radio channel(s). A Transmit indicator appears on the 
selected radio channels when the tones are transmitting.

When this feature is active, tones are sent on all selected radio channels. The tones mark 
the radio channels as priority, and warn non-critical or unauthorized radio users not to 
transmit on these channels. The tone is 700 Hz for 0.5 seconds, every 10 seconds.

The tones are not sent while the radio system is transmitting on those channels.

NOTE

The tones are sent on all selected channels, including patches and multiple 
selections.

This feature toggles between sending, or not sending, periodic tones.

NOTE

Supervisors can rename this function button on the console, therefore the 
button name that you see here might not be what you see on your console.

NOTE

Any transmission from a MOTOTRBO Radio Channel control returns you to 
the Home menu item at the end of a call—not to the menu item that was 
selected at the start of the transmission (exception: Contacts menu). This is 
also the case with the transmission of marker tones.

It is recommended that you ensure the Marker Tone button is set to Inactive 
on the MOTOTRBO Radio Channel control for all consoles before you 
navigate the radio menu system. Otherwise, you will be returned to the 
Home menu item whenever the channel sends a marker tone.

Marker Tone – Inactive Marker Tone – Active
3-30 6881013Y34-D    OCTOBER 2010



MIP 5000 VOIP RADIO CONSOLE OPERATOR MANUAL  MSEL # BUTTON
. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

MSEL # BUTTON

The MSel (Multiple Selection) # button lets you choose more than one radio channel at 
the same time for transmission and reception.

The MSel # button has two versions:

• MSel w/o M (without memory) button is for single-use multi-selections, for 
example, channels that only need to be grouped once. The MSel group is deleted 
as soon as the MSel w/o M button is pressed again. There is one button of this 
type

• MSel # (with memory) is used for multi-selections that are re-used. There are ten 
buttons of this type available (maximum 16 radio channels)

If the multi-selection is active, you hear the incoming audio for all of the multi-selected 
channels on the select speaker or headset. To transmit to all of the channels at the same 
time, use the Common Transmit button. If the multi-selection is not active, you can use 
the associated APB # button to transmit on all of the channels that are saved in the 
associated MSel # button.

Only one multi-selection at a time can be active at a console. If one multi-selection is 
active, and you choose another one, the first multi-selection is automatically 
deactivated.

Whenever possible, use a multiple selection instead of a patch. Multi-selection uses fewer 
system resources and less memory than patching. Multi-selection is local to your console, 
so the effects are not noticed at any other consoles or on the radio channels. In comparison, 
patching has global effects, which affect other consoles and the radio channels.

Inactive with no 
resources in memory 
(gray background 
white boxes)

Inactive with resources 
in memory (gray 
background green 
boxes)

Active with no 
resources in memory 
(dark blue background 
white boxes)

Active with resources 
in memory (dark blue 
background green 
boxes)
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MSEL W/O M BUTTON CHAPTER 3: BUTTONS, CONTROLS AND INDICATORS
NOTE

Supervisors can rename this function button on the console, therefore the 
button name that you see here might not be what you see on your console.

RELATED FEATURES:

• “APB # Button” on page 3-5

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
MSEL W/O M BUTTON

The MSel w/o M button is the multiple selection without memory button. For more 
information see “MSel # Button” on page 3-31.

NOTE

Supervisors can rename this function button on the console, therefore the 
button name that you see here might not be what you see on your console.

RELATED FEATURES:

• “MSel # Button” on page 3-31
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. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

MUTE BUTTON

The Mute button mutes the incoming audio for this radio channel at this console. The 
outgoing audio is not muted. The Mute button is on the Radio Channel control.

NOTE

The receive audio is muted at this console only. If you want, you can still 
transmit on a muted Radio Channel control.

This button toggles between muting the audio (active) and returning the audio to its 
normal level (inactive). To change the mute status, click this button.

If you mute a channel involved in an active patch, then all channels included in that 
patch are muted.

If you mute a channel involved in an active multiple selection, the muting affects only 
that one channel.

The volume of the mute level is set in the CSDM for all consoles. The audio can be 
either turned down or turned off.

NOTE

If the speaker does not have sound waves with the prohibitory sign on the 
Mute button, this indicates that the All Mute button muted this (these) 
Radio Channel control(s).

RELATED FEATURES:

• “All Mute Button” on page 3-4 (mutes all unselect audio for this console)

Mute – Inactive Mute – Active
6881013Y34-D    OCTOBER 2010 3-33



MUTE R2 INDICATOR CHAPTER 3: BUTTONS, CONTROLS AND INDICATORS
. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

MUTE R2 INDICATOR

The Mute R2 feature lets you mute a second receiver using tone remote control. The 
second receiver option monitors the frequency of the radio.

You mute the second receiver on the Radio Channel control shortcut menu by clicking 
the Mute R2 feature. This feature lets you toggle the Mute R2 feature on and off.

When any console mutes the second receiver of any Radio Channel control, then the 
Mute R2 indicator appears at all other consoles that have that Radio Channel control.

NOTE

You cannot perform this task while any console is transmitting on the 
channel. Retry after the transmission is completed.
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. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

OK CONTROL

The OK control confirms the intended action and enables selection of a sub-menu item. 
The control is available on MOTOTRBO Radio Channel controls and mobile Radio 
Channel controls connected to a CDM 1550 LS+, a two-way radio model.

NOTE

You can invoke the OK control function by using the Enter key on the 
numeric keypad of the workstation keyboard.
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. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

OPTION INDICATOR

The Option indicator indicates the presence of optional equipment installed in the 
mobile radio or MOTOTRBO radio. The indicator appears on the Radio Channel 
control.

On MOTOTRBO Radio Channel controls, the following Optional indicator shows 
optional equipment has been disabled.
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. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

PAGE LIST BUTTON

The Page List button sends pre-programmed paging, signaling tones, and group pages 
over the selected or specified (via steering) Radio Channel control.

The Page List button brings up pre-programmed lists in the Paging Facility dialog box. 
You choose the single or group party or parties to be paged from these tabbed lists.

When group pages are created, they are listed in the Paging Facility dialog box in bold 
and at a larger text size, a group (or single) page assigned to a Single Page button is 
shown with an asterisk (demonstrates the Single Page button assignment).

When you press the Send button in the Paging Facility dialog box, a Transmit 
indicator appears on the Page List button during the paging tones. Then a Talkdown 
indicator appears on the button for the duration that a Talkdown indicator appears in 
the Status area of the Paging Facility dialog box.

Page List button talkdown indicator
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PAGE LIST BUTTON CHAPTER 3: BUTTONS, CONTROLS AND INDICATORS
NOTE

Supervisors can rename this function button on the console, therefore the 
button name that you see here might not be what you see on your console.

NOTE

When using programmed pages, which specify that the page transmits on 
the “selected channel”, ensure that you have a channel selected that is not 
involved in a multiple selection or an active patch. The pages in a list are 
sent whether a channel is selected or not. Therefore, a page failure results for 
each page sent in the programmed pages list, if a channel is not selected.

You cannot change the selected channel while paging is in progress, except 
by pressing an MSEL or Patch button. If you attempt to initiate a multiple 
selection or a patch while pages are being sent from the programmed pages 
list, the channels included in the multiple selection or patch become selected 
immediately, although the pages continue to be sent on the previously 
selected channel. When the select channel is changed in this way, inbound 
audio on channels in the multiple selection or patch can be heard on the 
select speaker, along with paging tone feedback until paging completes.

If you want to send more pages from the programmed page list, you must 
first select a single channel again. (You might need to deactivate a multiple 
selection in order to do that.)

NOTE

If a radio channel is selected as a result of being in an open multiple 
selection or an active patch, you cannot page on this channel when Steering 
— Channel is set to Selected. To send a page on such a channel, you must 
steer it to this channel by choosing this channel from the Steering — 
Channel list.

RELATED FEATURES:

• “Man Page Button” on page 3-23

• “Talkdown Indicator” on page 3-58

• “Single Page Button” on page 3-53
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. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

PATCH # BUTTON

The Patch # button activates the corresponding patch. There are two types of patches:

• Patch # buttons are patches saved in memory. These are for multi-use patches. Ten 
patches with memory are available

• Patch w/o M (patch without memory) button is a temporary patch. This patch is 
for a single use patch. One patch without memory is available

Before activating the patch, you must have existing elements in the patch with memory. 
To activate the patch, click the Patch # button.

If the patch has been activated but not selected, you hear the audio from all radio 
channels and consoles that are included in the patch on your unselect speaker.

If the patch has been activated and selected (for example, by choosing one of the radio 
channels included in that patch), you hear the audio for this patch on your select 
speaker or headset.

The Patch indicator on a Radio Channel control shows that the patch with that number 
is in use.

NOTE

An error message appears in the status bar when you are trying to activate a 
patch that cannot be activated.A radio channel cannot be included in more 
than one active patch. If one patch is already active that includes one or 
more of the radio channels in another patch, then you can activate the 
second patch but the radio channels already active in the first patch will not 
be included in the second patch. The second patch holds these active radio 
channels in memory for future use.

Patch – Inactive Patch – Active

Patch Without Memory – Inactive Patch Without Memory – Active
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NOTE

You can have more than one active patch at your console. You can have as 
many active patches as there are Patch # buttons on your console, provided 
there are no conflicts between patches (see previous Note).

NOTE

Supervisors can rename this function button on the console, therefore the 
button name that you see here might not be what you see on your console.

RELATED FEATURES:

• “Patch Indicators” on page 3-41
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. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

PATCH INDICATORS

The Patch indicator on a Radio Channel control shows that this radio channel is 
included in a patch.

Whenever this indicator appears, this radio channel is included in a patch. A patch is 
created with the Patch # button. The patch indicator corresponds to the active Patch # 
button; for example, if the Patch 1 indicator is present in the Radio Channel control, 
this indicates that Patch 1 is active. The corresponding number appears in the middle 
of the patch symbol.

A radio channel can be included in more than one patch, but only one of those patches 
can be active at a time.

RELATED FEATURES:

• “Patch # Button” on page 3-39

The yellow Patch Busy indicator appears on all channels that are involved in 
a patch that is active on another console. This indicator lets you immediately 
see at a glance that a channel is included in an active patch at another 
console.
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. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

PATCH W/O M BUTTON

The Patch w/o M button is the patch without memory button. For more information, 
see “Patch # Button” on page 3-39.

NOTE

Supervisors can rename this function button on the console, therefore the 
button name that you see here might not be what you see on your console.

RELATED FEATURES:

• “Patch # Button” on page 3-39
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. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

POWER LEVEL INDICATORS

The High Power and Low Power indicators show the transmit level for mobile and 
MOTOTRBO radios equipped to communicate this information. These indicators 
appear on the Radio Channel control.

High Power Low Power
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. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

PRIVATE LINE INDICATOR

The Private Line indicator displays the number of the tone-coded squelch assigned to 
the base station, radio channel and frequency being used for transmission. The private 
line feature assigns the selected sub-audible tone in the list for multiple tone-coded 
squelch control, and sends a tone to the base station to keep the base station 
synchronized with your system. 

This indicator is available only if the multiple private line feature is present on the 
Radio Channel control. Apply this feature through the Radio Channel control (shortcut 
submenu) or with the Up/Down Private Line buttons at the bottom of the Radio 
Channel control.

This Private Line function applies individually to each radio channel that is included in 
a patch or in a multiple selection.

Private Line Indicator on the shortcut menu:

NOTE

You cannot perform this task while any console is transmitting on the 
channel. Retry after the transmission is completed.
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. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

REPEAT DISABLE INDICATOR

The Repeat Disable indicator on a Radio Channel control indicates that repeat feature 
of this repeater is enabled or disabled. A repeater uses semi or full duplex radio 
channels. When the repeat feature is enabled, via the shortcut menu, your base station 
retransmits (repeats) incoming (received) radio traffic, effectively extending the 
coverage area for all users on the radio channel. When the repeat feature is disabled, all 
units can still communicate back and forth with you but cannot hear any other unit 
(except you) on the radio channel. 

The Repeat Disable functionality (type of signalling required) is programmed through 
the CSDM.

This feature applies individually to each radio channel that is a member of a patch or a 
multiple selection.

NOTE

You cannot perform this task while any console is transmitting on the 
channel. Retry after the transmission is completed.

Repeat Disable – Active, repeat feature disabled Repeat Disable – Inactive (Normal state)
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. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

RF MODE INDICATORS

The RF Mode indicator on a MOTOTRBO Radio Channel control shows the channel is 
either in Analog or Digital mode. The MOTOTRBO gateway controls both analog and 
digital channels, which puts the Radio Channel control in one of the two modes.

NOTE

The MOTOTRBO gateway cannot determine the RF mode during scan 
mode, therefore note the following behaviors:

• The RF Mode indicator on the MOTOTRBO Radio Channel control 
does not appear during scan mode.

• Paging continues to operate.

• The MOTOTRBO gateway will not send MDC PTT IDs when the 
MOTOTRBO channel is configured for STAT-ALERT at the CSDM.

RF Mode— Analog RF Mode— Digital
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. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

RIGHT ARROW CONTROL

The Right Arrow control enables you to scroll forward among multiple text messages 
that display on the MOTOTRBO Radio Channel control label and Text Display of the 
keypad. This arrow key also enables you to scroll through menu options.

RELATED TOPICS:

• “Left Arrow Control” on page 3-22
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RSSI INDICATOR CHAPTER 3: BUTTONS, CONTROLS AND INDICATORS
. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

RSSI INDICATOR

The RSSI indicator represents the signal strength of the MOTOTRBO radio. The 
number of bars shown on the indicator is proportional to the strength of the signal, 
where four bars represents the strongest. The indicator is displayed only when the 
Radio Channel is receiving.
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. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

SAFETY BUTTON

The Safety button prevents the operation of specifically configured Single Page 
buttons on the console, unless the Safety button is activated first.

In some systems, you must use the Safety button before using a Single Page button 
(for example, to ensure that you are not accidentally activating a page). In the page 
situation, the Single Page button with the safety feature enabled appears with an 
orange lock in the bottom corner.

NOTE

Supervisors can rename this function button on the console, therefore the 
button name that you see here might not be what you see on your console.

 

Safety – Available Safety – Unavailable

Single Page button with safety feature

PROCEDURE 3-1  HOW TO USE THE SAFETY BUTTON 

1 Choose the Safety button.

NOTE

The Safety button times out if you do not choose a Single Page 
button.

Result: The Safety button changes to the open lock (available) state.

2 Choose the specifically configured Single Page button that you want to 
activate.

Result: The Single Page button activates and the Safety button returns to 
the closed lock (unavailable) state.

3 Repeat if required for the specifically configured Single Page button(s) 
that you want to activate.
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SCAN CONTROL INDICATORS CHAPTER 3: BUTTONS, CONTROLS AND INDICATORS
. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

SCAN CONTROL INDICATORS

The Scan Control feature lets you scan through the available frequencies for the 
associated mobile or MOTOTRBO Radio Channel control. The feature is available 
through the shortcut menu and, in MOTOTRBO channels, through keypad menu 
navigation.

The indicator shows the state of this feature in the indicator area of the Radio Channel 
control. Different priority scans are supported: normal, Priority 1 and Priority 2.

You enable the feature by choosing Scan Control from the shortcut menu. You disable 
the feature by returning to the shortcut menu and choosing the option again.

NOTE

You cannot perform this task while any console is transmitting on the 
channel. Retry after the transmission is completed.

NOTE

The MOTOTRBO gateway cannot determine the RF mode during scan 
mode, therefore note the following behaviors:

• The RF Mode indicator on the MOTOTRBO Radio Channel control 
does not appear during scan mode.

• Paging continues to operate.

• The MOTOTRBO gateway will not send MDC PTT IDs when the 
MOTOTRBO channel is configured for STAT-ALERT at the CSDM.

Scan Indicator Priority 1 Scan Indicator

Priority 2 Scan Indicator
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. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

SCROLL INDICATORS

The Scroll Up and Scroll Down indicators correspond to the scroll buttons on the 
mobile radio faceplate. They appear on the Radio Channel Control shortcut menu, next 
to the Scroll Up and Scroll Down commands.

FIGURE 3-8  EXAMPLE OF SCROLL INDICATOR

Scroll Up Indicator Scroll Down Indicator
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. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

SECURE INDICATORS

Encrypted radio communication prevents unintended listeners from overhearing voice 
traffic on MCS 2000 III mobile radios and MOTOTRBO radios in digital RF mode. The 
Secure indicator shows whether the radio is transmitting in a Coded mode (secure) or a 
Clear mode (unsecure).

MOTOTRBO radios must have the privacy feature enabled on the digital channel to 
transmit a privacy-enabled (secure) transmission. The privacy feature is configured 
using the MOTOTRBO Customer Programming Software (CPS) and can be toggled on 
and off using a programmable button or from the radio Utilities menu, if configured.

Clear Indicator Coded Indicator 
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. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

SINGLE PAGE BUTTON

The Single Page button lets you send a single or group page from an assigned button. 
The single or group page name is the name of the button.

Up to 512 buttons are available for a single or a group page assignment. To avoid 
accident activation, some Single Page buttons require the Safety button. For those 
buttons, without safety enable, the page can not be sent. If there is an error while using 
the Single Page button with Safety, an error message appears in the Status Bar at the 
bottom of the program window (“The Safety button was not pressed. Please retry.”).

The Man Page and Single Page buttons are similar in appearance. One distinction is 
that the configurable label default background is purple on the Single Page button, 
while it is blue on the Man Page button.

The Man Page and Single Page buttons share the same Talkdown and Transmit 
indicators. The Single Page Error indicator briefly (2 seconds) appears when you press 
a page button while another page is in process.

Single Page – Available Single Page – Unavailable

Single Page – with Safety Available Single Page – with Safety Unavailable

Single Page – Error
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SINGLE PAGE BUTTON CHAPTER 3: BUTTONS, CONTROLS AND INDICATORS
NOTE

When using programmed pages, which specify that the page transmits on 
the “selected channel”, ensure that you have a channel selected that is not 
involved in a multiple selection or an active patch. The pages in a list are 
sent whether a channel is selected or not. Therefore, a page failure results for 
each page sent in the programmed pages list, if a channel is not selected.

NOTE

If a radio channel is selected as a result of being in an open multiple 
selection or an active patch, you cannot page on this channel when Steering 
— Channel is set to Selected. To send a page on such a channel, you must 
steer it to this channel by choosing this channel from the Steering — 
Channel list.

RELATED FEATURES:

• “Man Page Button” on page 3-23

• “Talkdown Indicator” on page 3-58

• “Safety Button” on page 3-49
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. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

SUPERVISORY BUTTON

The Supervisory button allows you to prioritize a PTT relative to the PTT of other 
consoles.

To activate the Supervisory feature, choose a Radio Channel control, then press the 
Supervisory button. To deactivate this feature and allow the other consoles to 
communicate with the selected radio channel, press the Supervisory button again.

NOTE

Supervisors can rename this function button on the console, therefore the 
button name that you see here might not be what you see on your console.

Supervisory – Active (color) Supervisory – Inactive 
(dimmed appearance)

Supervisory – Disabled (red 
prohibitory symbol)
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. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

TAKEOVER INDICATOR

The Takeover indicator on a Radio Channel control indicates that a MIP 5000 console 
has taken control of communication over that radio channel from any non-MIP 5000 
console. You enable the Takeover feature on the shortcut menu to physically disconnect 
all non-MIP 5000 consoles (connected in parallel to the MIP 5000 system) from the 
radio transmitter (all transmit frequencies).

When the Takeover indicator is present, only the console that enabled the takeover can 
transmit. If you chooses this feature while a parallel unit (for example, a remote desk 
set) radio transmission is in progress, that transmission is immediately stopped.

Depending on configuration, when the Takeover indicator is present:

• 4-wire — all parallel units continue to monitor the radio traffic on the receive 
frequency

• 2-wire — all parallel units are unable to transmit or receive

This feature toggles between disabling and enabling communication with the parallel 
unit (for example, a remote desk set). 

NOTE

The indicator reflects the state of the communication on this radio channel, 
not the state of the parallel unit (for example, a remote desk set).

Takeover – Enabled Takeover – Disabled
3-56 6881013Y34-D    OCTOBER 2010



MIP 5000 VOIP RADIO CONSOLE OPERATOR MANUAL  TALKAROUND INDICATOR
. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

TALKAROUND INDICATOR

For a radio normally communicating to the rest of the system via a repeater, the 
Talkaround indicator shows that a radio channel is being used to communicate directly 
to other radios on the system (usually using the same transmit and receive frequency) 
thus, talk around the repeater. This indicator appears on the Radio Channel control.
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TALKDOWN INDICATOR

There are two types of paging Talkdown indicators:

• A green Talkdown indicator that appears in the Status area of the Paging and 
Signaling (Man Page or Single Page button) and/or Paging Facility (Page List 
button) dialog boxes 

• Plus a similar Talkdown indicator that appears on the paging buttons (Man Page, 
Page List or Single Page button)

These indicators demonstrate that your microphone is keyed for a specific time (set in 
the CSDM) and you can send your voice message for the duration that the Talkdown 
indicator is present. If you require more time for your message, use the Common 
Transmit button or Instant Transmit button and speak into your headset.

RELATED FEATURES:

• “Man Page Button” on page 3-23

• “Page List Button” on page 3-37

• “Single Page Button” on page 3-53

• “Alert # Button” on page 3-3 (related function but different indicator)

Talkdown – in dialog boxes Talkdown – on buttons
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TONES DISABLE INDICATOR

The Tones Disable indicator shows that all tones have been turned off from the 
MOTOTRBO radio.
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TRANSMIT INDICATORS

The Transmit indicator shows that a radio channel is active and involved in a 
transmission. On a channel configured for Talk Permit, the talk permit tone sequence 
must be received at the console (from the radio) before the Transmit indicator appears.

The Transmit Busy indicator normally indicates that a radio channel is already being 
used at another console. It might also appear when calls from certain types of mobile 
radio (such as Consolette) are received because they include a “PTT BSY” signal in their 
transmissions. The Transmit Busy indicator is the same as the Transmit indicator 
except the background is yellow.

The Transmit Error indicator demonstrates that there is a problem with the 
transmission on this channel or that a transmit timeout has occured for this channel. It 
is a red indicator with a yellow triangle with exclamation icon.

RELATED FEATURES:

• Transmit indicator on “Man Page Button” on page 3-23

Transmit Active (red) Transmit Busy (yellow) Transmit Error (yellow 
triangle with exclamation)
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UNIT ID QUEUE INDICATOR

The Unit ID (identification) Queue indicator appears on the Radio Channel control 
shortcut menu. This feature lets you view the most recent radio callers to that radio 
channel. 

For an incoming radio call; the program's Caller ID feature identifies the calling party. 
When a mobile user presses the PTT (on a mobile radio with a unit ID) that ID is sent on 
the radio channel along with their voice transmission. The console receives that 
mobile’s ID and extracts the associated alias (name) from the Caller ID database (see 
“Caller ID Command” on page 4-20). The console then displays the alias on the Radio 
Channel control (in the label area) and you know who is making the call. If no alias is 
defined, the console displays the ID. The last received ID's display on the Unit ID 
Queue list of the shortcut menu.

The number of caller identifications that you see on the Unit ID Queue submenu is set 
by the supervisor.
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UP/DOWN BUTTONS

The Up/Down buttons on the Radio Channel control have various optional purposes.

The available options are:

• No up/down buttons

• Volume control—adjusts the select speaker volume)

• Frequency control—scrolls through the available frequencies)

• Private line control—scrolls through the available private lines)

• Scroll up/down control (mobile channels)—scrolls through mobile radio 
channels)

• Channel up/down control (MOTOTRBO channels)—scrolls through mobile radio 
channels

A supervisor assigns the Up/Down button function, by going to Edit > Channels 
Configuration > Controls tab > Assign up/down buttons to: area.

Analog Radio Channel Control

Mobile Radio Channel Control

MOTOTRBO Radio Channel Control
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The Up/Down buttons change to reflect what is assigned to the button:

Each of these options has corresponding indicators on the Radio Channel control.

RELATED FEATURES:

• “Volume Level Indicator” on page 3-64

• “Frequency Indicator” on page 3-19

• “Private Line Indicator” on page 3-44

• “Scroll Indicators” on page 3-51

Volume Frequency Private Line Scroll up/down
Channel up/down
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VOLUME LEVEL INDICATOR

The Volume Level indicator displays the volume level of the unselect speaker or select 
speaker.

To change the speaker volume, access the Radio Channel control shortcut menu. Use 
the Volume Slide control to choose the desired volume level. Or, if configured, use the  
Up/Down volume buttons on the Radio Channel control. When chosen, the volume 
level appears on an indicator on the Radio Channel control. The higher the number, the 
higher the volume.
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WILDCARD # INDICATOR

The Wildcard # function lets you send a tone (set in the CSDM) to the base station for 
controlling special functions.

NOTE

You cannot perform this task while any console is transmitting on the 
channel. Retry after the transmission is completed.

You cannot use this feature when a radio channel is busy.

This feature applies individually to each radio channel that is included in a patch or in 
a multiple selection.

PROCEDURE 3-2  HOW TO USE THE WILDCARD FEATURE 

1 Access the Radio Channel control shortcut menu. 

Result: The Wildcard # feature appears on the shortcut menu. 

2 Choose the Wildcard # item to initiate the special function. 

Result: A Wildcard # indicator appears on the Radio Channel control.

3 To turn this special feature off, access the Radio Channel control shortcut 
menu again. Choose the Wildcard # item. 

Result: The Wildcard # indicator disappears from the Radio Channel 
control.
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QUICK REFERENCE TABLE

TABLE 3-2  BUTTON/CONTROL/INDICATOR/SYMBOL QUICK REFERENCE TABLE 

Indicator/Symbol Feature/Function

Alert # button — see “Alert # Button” on page 3-3

Alert # button; error — see “Alert # Button” on page 3-3

Alert # button; transmit — see “Alert # Button” on page 3-3

Alert # button; transmit (talkdown) — see “Alert # Button” on page 3-3

All Mute button; disabled (not mute) — see “All Mute Button” on page 3-4

All Mute button; enabled — see “All Mute Button” on page 3-4

APB # button — see “APB # Button” on page 3-5

APB # button; active — see “APB # Button” on page 3-5

Back/Home indicator — see “Back/Home Control” on page 3-6

Base Icom button — see “Back/Home Control” on page 3-6

Base Icom button; Transmit indicator — see “Back/Home Control” on page 3-6

Call Dir control — see “Call Dir Control” on page 3-8

Call Dir control; Error indicator — see “Call Dir Control” on page 3-8
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Call Dir control; Off Hook indicator — see “Call Dir Control” on page 3-8

Call Dir control; Patched indicator — see “Call Dir Control” on page 3-8

Call Dir control; Transmit indicator — see “Call Dir Control” on page 3-8

Common Transmit button — see “Common Tx Button” on page 3-12

Companding indicator — see “Companding Indicator” on page 3-13

Display Size indicator — see “Display Size Indicator” on page 3-15

Emergency indicator — see “Emergency Indicator” on page 3-16

Encryption Mode indicator; Clear — see “Encryption Mode Indicators” on page 3-17

Encryption Mode indicator; Coded — see “Encryption Mode Indicators” on page 3-17

Exit/Escape indicator — see “Exit/Escape Button Indicator” on page 3-18

Frequency indicator (plain indicator; no number) — see “Frequency Indicator” on page 
3-19

Frequency indicator; Frequency 1 to 16 — see “Frequency Indicator” on page 3-19

High Power indicator — see “Power Level Indicators” on page 3-43

Inbox Full indicator — see“Message Indicator” on page 3-26

Instant Transmit button — see “Instant Transmit Button” on page 3-20

TABLE 3-2  BUTTON/CONTROL/INDICATOR/SYMBOL QUICK REFERENCE TABLE (CONTINUED)

Indicator/Symbol Feature/Function
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Low Power indicator — see “Power Level Indicators” on page 3-43

Man Page button — see “Man Page Button” on page 3-23

Man Page button; Talkdown — see “Man Page Button” on page 3-23

Man Page button; Transmit — see “Man Page Button” on page 3-23

Menu/Home Button indicator — see “Menu/Home Indicator” on page 3-25

Mobile Command LED Blinking indicator — see “Mobile Command Indicators” on page 
3-27

Mobile Command LED Off indicator — see “Mobile Command Indicators” on page 3-27

Mobile Command LED On indicator — see “Mobile Command Indicators” on page 3-27

Mobile Command indicator — see “Mobile Command Indicators” on page 3-27

Monitor button; squelch enabled — see “Monitor Button” on page 3-28

Monitor button; squelch defeated — see “Monitor Button” on page 3-28

Monitor indicator; monitoring active — see “Monitor Indicator” on page 3-29

Monitor indicator; monitoring inactive — see “Monitor Indicator” on page 3-29

Mrk Tone button — see “Mrk Tone Button” on page 3-30

Mrk Tone button; active — see “Mrk Tone Button” on page 3-30

TABLE 3-2  BUTTON/CONTROL/INDICATOR/SYMBOL QUICK REFERENCE TABLE (CONTINUED)

Indicator/Symbol Feature/Function
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MSel # button; active with memory — see “MSel # Button” on page 3-31

MSel # button; active with no memory — see “MSel w/o M Button” on page 3-32

MSel # button; inactive with memory — see “MSel # Button” on page 3-31

MSel w/o M (without memory) button — see “MSel w/o M Button” on page 3-32

Mute button; disabled — see “Mute Button” on page 3-33

Mute button; enabled — see “Mute Button” on page 3-33

Mute R2 indicator — see “Mute R2 Indicator” on page 3-34

Option indicator — see “Option Indicator” on page 3-36

Page List button — see “Patch # Button” on page 3-39

Page List button; transmit — see “Patch # Button” on page 3-39

Patch # button and indicator; Patch 1 to 10 — see “Patch # Button” on page 3-39 and “Patch 
Indicators” on page 3-41

Patch # button and indicator; without Memory — see “Patch w/o M Button” on page 3-42 
and “Patch Indicators” on page 3-41

Patch Busy indicator; Patch busy — see “Patch Indicators” on page 3-41

Priority 1 Scan indicator — see “Scan Control Indicators” on page 3-50

Priority 2 Scan indicator — see “Scan Control Indicators” on page 3-50

TABLE 3-2  BUTTON/CONTROL/INDICATOR/SYMBOL QUICK REFERENCE TABLE (CONTINUED)

Indicator/Symbol Feature/Function
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Private Line indicator; tone 1 to 8 — see “Private Line Indicator” on page 3-44

Repeat Disable indicator; enabled — see “Repeat Disable Indicator” on page 3-45

Repeat Disable indicator; inactive (normal) — see “Repeat Disable Indicator” on page 3-45

RF Mode; Analog — see “RF Mode Indicators” on page 3-46

RF Mode; Digital — see “RF Mode Indicators” on page 3-46

RSSI indicator — see “RSSI Indicator” on page 3-48

Safety button; unavailable — see “Safety Button” on page 3-49

Safety button; available — see “Safety Button” on page 3-49

Scan indicator — see “Scan Control Indicators” on page 3-50

Scroll Down indicator — see “Scroll Indicators” on page 3-51

Channel Scroll Down (CH-) control (MOTOTRBO) — see “Channel Scroll Control” on 
page 3-11

Scroll Up indicator — see “Scroll Indicators” on page 3-51

Channel Scroll Up (CH+) control (MOTOTRBO)— see “Channel Scroll Control” on page 
3-11

Secure indicator; clear — see “Secure Indicators” on page 3-52

Secure indicator; coded — see “Secure Indicators” on page 3-52

Single Page Button; available — see “Single Page Button” on page 3-53

TABLE 3-2  BUTTON/CONTROL/INDICATOR/SYMBOL QUICK REFERENCE TABLE (CONTINUED)

Indicator/Symbol Feature/Function
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Single Page Button; Error — see “Single Page Button” on page 3-53

Single Page Button; unavailable — see “Single Page Button” on page 3-53

Single Page Button; with Safety available — see “Single Page Button” on page 3-53

Single Page Button; with Safety unavailable — see “Single Page Button” on page 3-53

Supervisory button; active — see “Supervisory Button” on page 3-55

Supervisory button; disabled — see “Supervisory Button” on page 3-55

Supervisory button; inactive — see “Supervisory Button” on page 3-55

Takeover indicator; disabled — see “Takeover Indicator” on page 3-56

Takeover indicator; enabled — see “Takeover Indicator” on page 3-56

Talkaround indicator — see “Talkaround Indicator” on page 3-57

Talkdown indicator in dialog box — see “Talkdown Indicator” on page 3-58

Talkdown indicator on buttons — see “Talkdown Indicator” on page 3-58

Tones Disable indicator — see “Tones Disable Indicator” on page 3-59

Transmit Busy indicator — see “Transmit Indicators” on page 3-60

Transmit Error indicator — see “Transmit Indicators” on page 3-60

TABLE 3-2  BUTTON/CONTROL/INDICATOR/SYMBOL QUICK REFERENCE TABLE (CONTINUED)

Indicator/Symbol Feature/Function
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Transmit indicator — see “Transmit Indicators” on page 3-60

Unit ID Queue indicator — see “Unit ID Queue Indicator” on page 3-61

Unread Message indicator — see “Message Indicator” on page 3-26

Up/Down Frequency button(s) (with Mute and Instant Transmit buttons) — see “Up/
Down Buttons” on page 3-62

Up/Down Private Line button(s) (with Mute and Instant Transmit buttons) — see “Up/
Down Buttons” on page 3-62

Up/Down Scroll button(s) (with Mute and Instant Transmit buttons) — see “Up/Down 
Buttons” on page 3-62

Up/Down Volume button(s) (with Mute and Instant Transmit buttons) — see “Up/Down 
Buttons” on page 3-62

Volume Level indicator (0 to 15) — see “Volume Level Indicator” on page 3-64

Wildcard # feature — see “Wildcard # Indicator” on page 3-65

TABLE 3-2  BUTTON/CONTROL/INDICATOR/SYMBOL QUICK REFERENCE TABLE (CONTINUED)

Indicator/Symbol Feature/Function
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MENU COMMANDS 4

This section describes the operator commands on the MIP 5000 VoIP Radio Console 
menus and the dialog boxes associated with those commands.

NOTE

Some of these commands on the menu bar are only available to supervisors 
(password protected). After logging in, a supervisor can use the Allow 
Layout Reconfiguration command on the Edit menu to allow access to 
commands that permit reconfiguration of the MIP 5000 VoIP Radio Console 
workspace and assignment of resources.

As in most programs the menu bar is located at the top of the screen. Use the menu bar 
to:

• Log out of the system

• Save your customized screen configuration

• Access resources to customize your layout

• View the “About MIP 5000 VoIP Radio Console” information dialog box

The menu bar includes:

• “Console Menu” on page 4-2

• “Edit Menu” on page 4-5

• “View Menu” on page 4-7

• “Tools Menu” on page 4-13 

• “Help Menu” on page 4-23

FIGURE 4-1  MENU BAR
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CONSOLE MENU

The Console menu lets you:

• Load a configuration relevant to your work area and/or a user profile other than 
the default

• Save any changes to your configuration

• Save any changes to your configuration under another name

• Log out

The Console menu contains the following commands:

• “Load Configuration Command” on page 4-2

• “Save Configuration Command” for supervisors only

• “Save Configuration As Command” for supervisors only

• “Logout Command” on page 4-4

FIGURE 4-2  CONSOLE MENU

LOAD CONFIGURATION COMMAND

This command on the Console menu opens the Open dialog box where you can choose 
a specified, previously arranged configuration and /or user profile to load. 

The supervisor can customize configurations into geographical areas, for example 
North or South of the city, or in any manner relevant to your geographical area. Or a 
configuration can be the layout of your channels and main window.

See “Loading a New Configuration” on page 2-5 for more information.
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OPEN DIALOG BOX

Console > Load Configuration

You use this dialog box to select and open a specified, previously arranged console 
configuration and/or user profile file. The system administrator sets up a default 
location for these files in the Control Panel.

FIGURE 4-3  OPEN DIALOG BOX

AVAILABLE FILES LIST

Displays all files with a file extension of “cfg”. Highlight the desired configuration in 
the list before clicking the Open button. When you highlight the desired configuration, 
the file name appears in the File Name text box.

FILE NAME

Displays the file name of the highlighted file in the Available Files List.

BUTTONS

OPEN

Click the button to load the configuration file and close the dialog box.

CANCEL

Click the button to close the dialog box without loading a configuration.

SAVE CONFIGURATION COMMAND

The Save Configuration command is only available to supervisors. For more 
information, see the MIP 5000 VoIP Radio Console Supervisor Manual (6881013Y33).
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SAVE CONFIGURATION AS COMMAND

The Save Configuration As command is only available to supervisors. For more 
information, see the MIP 5000 VoIP Radio Console Supervisor Manual (6881013Y33).

LOGOUT COMMAND

This command on the Console menu opens the Logout dialog box where you log out of 
the current program session (without closing the program). See “Logging Out” on 
page 2-6 for more information.

LOGOUT DIALOG BOX

Console > Logout

You use this dialog box to log out of the current program session (without closing the 
program).

FIGURE 4-4  LOGOUT DIALOG BOX

BUTTONS

SOME SETTINGS CHANGED — YES

Click the button to save the modified settings in the current configuration file.

SOME SETTINGS CHANGED — NO

Click the button to continue the logout process without saving your changes.

YES

Click the button to log out.

NO

Click the button to remain in this session of the program.
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EDIT MENU

The Edit menu contains the following commands:

• “Allow Layout Reconfiguration Command” on page 4-5

• “Multiple Tab Window Command” for supervisors only

• “Resources Command” for supervisors only

• “User Preferences Command” for supervisors only

• “System Settings Command” for supervisors only

• “Shortcuts Command” for supervisors only

• “Channels Configuration Command” for supervisors only

• “Licensing Command” for supervisors only

FIGURE 4-5  EDIT MENU

ALLOW LAYOUT RECONFIGURATION COMMAND

The MIP 5000 VoIP Radio Console program starts with this feature disabled.

A supervisor can use this command to temporarily allow changes to the settings for a 
logged in operator. When selected, a dialog box appears asking for a supervisor 
password.

After a supervisor has entered the password, supervisor commands are available and a 
check mark appears on the Edit menu beside the Allow Layout Reconfiguration 
command.
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MULTIPLE TAB WINDOW COMMAND

The Multiple Tab Window command is only available to supervisors. For more 
information, see the MIP 5000 VoIP Radio Console Supervisor Manual (6881013Y33).

RESOURCES COMMAND

The Resources command is only available to supervisors. For more information, see 
the MIP 5000 VoIP Radio Console Supervisor Manual (6881013Y33).

USER PREFERENCES COMMAND

The User Preferences command is only available to supervisors. For more information, 
see the MIP 5000 VoIP Radio Console Supervisor Manual (6881013Y33).

SYSTEM SETTINGS COMMAND

The System Settings command is only available to supervisors. For more information, 
see the MIP 5000 VoIP Radio Console Supervisor Manual (6881013Y33).

SHORTCUTS COMMAND

The Shortcuts command is only available to supervisors. For more information, see the 
MIP 5000 VoIP Radio Console Supervisor Manual (6881013Y33).

CHANNELS CONFIGURATION COMMAND

The Channels Configuration command is only available to supervisors. For more 
information, see the MIP 5000 VoIP Radio Console Supervisor Manual (6881013Y33).

LICENSING COMMAND

The Licensing command is only available to supervisors. For more information, see the 
MIP 5000 VoIP Radio Console Supervisor Manual (6881013Y33).
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VIEW MENU

The View menu provides you with a list of the available windows you can activate, 
offers a means of rearranging resources that cannot be seen on any window and lets 
you focus the system on specific windows.

The viewable windows are Patch Window, Miscellaneous Window, Toolbar, Volume 
Window, Activity Log Window and Information Window.

The focusable windows are Multiple Tab Window, Miscellaneous Window, Toolbar, 
Activity Log Window and Information Window.

The Non-Visible Resources command lets you view the resources that might not be 
visible on a certain window or tab. A supervisor can cause these non-visible resources 
to rearrange themselves, so that they become visible on the console.

The View menu contains the following commands:

• “Patch Window Command” on page 4-9

• “Miscellaneous Window Command” for supervisors only

• “Toolbar Command” for supervisors only

• “Activity Log Window Command” for supervisors only

• “Information Window Command” for supervisors only

• “Volume Window Command” for supervisors only

• “Non-Visible Resources Command” on page 4-11

• “Focus in Multiple Tab Window Command” on page 4-12

• “Focus in Miscellaneous Window Command” on page 4-12

• “Focus in Toolbar Command” on page 4-12

• “Focus in Activity Log Window Command” on page 4-12

• “Focus in Volume Window Command” on page 4-13

• “Focus in Information Window Command” on page 4-13
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FIGURE 4-6  VIEW MENU
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PATCH WINDOW COMMAND

This command on the View menu lets you access a submenu where you can choose one 
of 10+1 specific patches. The Patch window you choose opens and becomes available 
for changes or activation.

FIGURE 4-7  PATCH SUBMENU

MISCELLANEOUS WINDOW COMMAND

This command is only available to supervisors.

A check box beside this command on the View menu indicates that the Miscellaneous 
window is currently open within the main window. 

This window allows Radio Channel controls and/or function buttons to be viewed at 
all times.

TOOLBAR COMMAND

This command is only available to supervisors.

A check box beside this command on the View menu indicates that the toolbar is 
currently open within the main window.

The toolbar contains buttons that perform specific functions for the MIP 5000 VoIP 
Radio Console program, such as muting all channels.
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ACTIVITY LOG WINDOW COMMAND

This command is only available to supervisors. For more information, see the MIP 5000 
VoIP Radio Console Supervisor Manual (6881013Y33).

A check box beside this command on the View menu indicates that the Activity Log 
window is currently open within the main window.

The Activity Log window lists all of the radio activity on the console. It also lets you 
quickly re-establish communications with previous callers by selecting the entry and 
pressing the Instant Transmit button. This is the window where you respond to 
emergency radio calls (silence the alarm, acknowledge the call and clear the emergency. 

Multiple tabs within the Activity Log window allow calls to be filtered by channel 
selection and emergency.

VOLUME WINDOW COMMAND

This command is only available to supervisors. For more information, see the MIP 5000 
VoIP Radio Console Supervisor Manual (6881013Y33).

A check box beside this command on the View menu indicates that the Volume 
window is currently open within the main window.

The Volume window lets you adjust the volume of the select, unselect and headset 
earpiece speakers.

INFORMATION WINDOW COMMAND

This command is only available to supervisors. For more information, see the MIP 5000 
VoIP Radio Console Supervisor Manual (6881013Y33).

A check box beside this command on the View menu indicates that the Information 
Window is currently open within the main window.

The default Page History window shows all of the pages that were sent from this 
console.

If it is enabled, the Radio Text window displays the text from the MOTOTRBO radio 
control head of a channel that is clicked and dragged into the window.
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NON-VISIBLE RESOURCES COMMAND

It is possible, by rearranging the resources on the screen (including buttons in the 
toolbar) or by using the Zoom feature, to end up with resource objects that are not 
visible and, therefore, cannot be accessed. This command on the View menu opens the 
Non-Visible Resources dialog box where you can see which resources are not visible. 
A supervisor can move the non-visible resources back into viewable range. For more 
information, see the MIP 5000 VoIP Radio Console Supervisor Manual (6881013Y33).

NON-VISIBLE RESOURCES DIALOG BOX

View > Non-Visible Resources

Use this dialog box to view a list of resources that are currently in a part of the Multiple 
Tab window or Miscellaneous window but are outside the boundaries of the main 
window. A supervisor’s assistance is required to bring the non-visible resources back 
into viewable range.

FIGURE 4-8  NON-VISIBLE RESOURCES DIALOG BOX

[NAME] TAB (S) 

Displays the currently non visible buttons or controls for a tab in the Multiple Tab 
window. This column is repeated for each tab in the Multiple Tab window that has non-
visible resources.

MISCELLANEOUS WINDOW TAB

Displays the currently non-visible buttons or controls in the Miscellaneous window.

BUTTONS

MAKE ALL RESOURCES VISIBLE

This button is only available to supervisors.
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REFRESH

Click the button to refresh the list of non visible resources after making another 
intervention (such as adding or removing resources or changing the zoom level).

CLOSE

Click the button to close the dialog box and return to the main window.

FOCUS IN MULTIPLE TAB WINDOW COMMAND

This command on the View menu focuses the program on the Multiple Tab window. 
The last-chosen button or control on a Multiple Tab window receives the focus and 
becomes highlighted. 

The Multiple Tab window, typically, contains the majority of the resources (for 
example, Radio Channel controls) that allow you to control all communications. It is 
the default window when the MIP 5000 VoIP Radio Console program first starts. This 
window is always present on the main window and cannot be removed. 

A supervisor assigns resources to this window. 

FOCUS IN MISCELLANEOUS WINDOW COMMAND

This command on the View menu focuses the program on the Miscellaneous window. 
The last-selected button or control in the Miscellaneous window receives the focus and 
becomes highlighted.

FOCUS IN TOOLBAR COMMAND

This command on the View menu focuses the program on the toolbar. The button with 
the focus the last time you were in the toolbar becomes the focus and is highlighted.

FOCUS IN ACTIVITY LOG WINDOW COMMAND

This command on the View menu focuses the program on the Activity Log window. 
The last-chosen call receives the focus and becomes highlighted.
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FOCUS IN VOLUME WINDOW COMMAND

This command on the View menu, focuses the program on the Volume window, which 
you can use to adjust the volume levels of the select, unselect, and headset earpiece 
speakers.

FOCUS IN INFORMATION WINDOW COMMAND

This command on the View menu, focuses the program on the Information Window, 
which consists of the default Page History window and the optional Radio Text 
window for MOTOTRBO radio head text display. The page with the focus the last time 
you were in the Information Window becomes the focus and is highlighted.

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

TOOLS MENU

The Tools menu accesses the tools that help you on your console, such as, immediate 
access to the Manual Page, Page List, Caller ID, plus Enable/Disable features and 
Enter RAC. Some of these features are accessible only by a supervisor.

The Tools menu contains the following commands:

• “Manual Page Command” on page 4-14

• “Page List Command” on page 4-17

• “Caller ID Command” for supervisors only

• “Enter RAC Command” on page 4-20

FIGURE 4-9  TOOLS MENU
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MANUAL PAGE COMMAND

This command on the Tools menu opens the Paging and Signaling dialog box where 
you can send a manual page on a radio channel. You can also use the Man Page button 
to open the Paging and Signaling dialog box.

FIGURE 4-10  MANUAL PAGE BUTTON

For more information about Manual Paging, see “Manual Page” on page 2-50 and “Left 
Arrow Control” on page 3-22.

PAGING AND SIGNALING DIALOG BOX

Tools > Manual Page

You use this dialog box to send manual pages. The program provides integrated paging 
features. Paging types include generic (using any tone sequence), customized or STAT-
ALERT signaling. The program sends the page signal over selected radio channels. You 
can define the specific frequency and transmitter that a page or signaling sequence is 
transmitted through.

The MDC Unit Alias is a list of pre-programmed alias' (names) associated with mobile 
radio IDs configured for STAT-ALERT signaling (MDC 1200). Each MDC Unit Alias is 
programmed (in the Caller ID Alias database) to communicate through a particular 
Radio Channel control. Selecting an Alias will send the associated MDC Unit ID with 
the transmission so only that mobile radio will receive the STAT-ALERT signal. This list 
is not associated with pagers.

You designate the customized 1+1 and 2+2 formats or STAT-ALERT (MDC 1200) 
formats at the CSDM.
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FIGURE 4-11  PAGING AND SIGNALING DIALOG BOX

PAGE CODE AREA (UPPER LEFT, NO LABEL)

PAGE CODE

Displays the pager-specific paging code or MDC Unit (mobile radio) ID you enter with 
the Tabbed Keypad.

PAGE CODE AREA BUTTONS

CLEAR

Click the button to clear the entire Page Code text box.

BACK

Click the button to clear the last entered character in the Page Code text box.

TABBED KEYPAD

Click the appropriate tab for the paging or STAT-ALERT signal (MDC 1200) type you 
wish to send. For a page type, enter the paging code for the specific pager you want to 
reach. Or for a STAT-ALERT type, enter the mobile radio (MDC Unit) ID. The 
characters you enter appear in the Page Code text box. The keypad changes to reflect 
the code for each kind of paging or signaling type.
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STEERING AREA

CHANNEL

Displays the available Radio Channel control labels. Click the down arrow and select 
the Radio Channel control containing the radio channel you wish to page on from the 
drop-down list. 

Only Radio Channel controls, configured (in the CSDM) for STAT-ALERT Signaling, 
appear in the list. The first choice in the list is Selected. Choosing this option steers the 
page to all the Radio Channel controls that are selected at the console. In this case, the 
Frequency scroll list is forced to Default and cannot be changed as long as the Channel 
is set to Selected.

FREQUENCY

Displays the frequency label. Click the down arrow and select the frequency (radio 
channel) you wish to page on from the drop-down list. The number of frequencies 
available depends on the configuration of the radio connected to the console’s audio 
channel (Radio Channel control) you select in the Channels list). 

You have the following possible choices: Default, Frequencies 1 through 16. Choosing 
Default steers the page to the frequency that is currently used by the system for the 
Radio Channel control. Choosing one of Frequencies 1 through 16 steers the page to 
that particular frequency.

If you choose an invalid entry the program uses the default value.

MDC UNIT ALIAS AREA

MDC UNIT LIST

Displays a list of pre-programmed MDC Unit Alias’ specific to the selected Radio 
Channel control, and in some cases the signaling type (tab) selected in the Tabbed 
Keypad. Highlight your choice before clicking the Select Alias button. The MDC Unit 
list is maintained in the Caller ID Alias database.

MDC UNIT ALIAS AREA BUTTONS

SELECT ALIAS

Click the button to select the MDC Unit Alias for the page. The MDC Unit (mobile 
radio) ID displays in the Page Code text box. 

STATUS AREA

STATUS

Displays a text message about the status of the page. 
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STATUS AREA BUTTONS

CLEAR

Click the button to clear the Status text box.

BUTTONS

SEND

Click the button to send the page and remain in the Paging and Signaling dialog box. 
The Transmit indicator appears on the selected Radio Channel control and in the status 
area of the Paging and Signaling dialog box.

When the Transmit indicator on the Radio Channel control disappears or, if configured, 
a green Talkdown indicator appears in the status area of the Paging and Signaling 
dialog box, you can send a voice message:

Click the Common Transmit button or the press the Instant Transmit button or 
footswitch and speak into your headset or microphone.

To end the voice message, release the Common Transmit button or the Instant 
Transmit button or footswitch.

ABORT

Click the button to cancel this page and remain in the Paging and Signaling dialog box.

CLOSE

Click the button to close the dialog box.

PAGE LIST COMMAND

This command on the Tools menu opens the Paging Facility dialog box that lets you 
send pre-programmed paging and signaling tones over all selected radio channels to 
programmed paging groups. You can also use the Page List function button to open the 
Paging Facility dialog box.

FIGURE 4-12  PAGE LIST BUTTON
6881013Y34-D    OCTOBER 2010 4-17



TOOLS MENU CHAPTER 4: MENU COMMANDS
PAGING FACILITY DIALOG BOX

Tools > Page List

A dispatcher uses this dialog box to page a predetermined list (stack) of pagers. Paging 
types include generic (using any tone sequence), customized or pre-programmed, as 
well as group pages. The page list is maintained by the supervisor. For more 
information, see the MIP 5000 VoIP Radio Console Supervisor Manual (6881013Y33).

FIGURE 4-13  PAGING FACILITY DIALOG BOX

STACK AREA

STACK LIST 

Displays the participants/groups who are paged when you click the Send button. You 
customize this list by choosing the participants/groups from the Page List tabs.

STACK AREA BUTTONS

STACK DELETE 

Click the button to delete the highlighted participant/group in the Stack list.

STACK DOWN 

Click the button to move the highlighted participant/group down one position in the 
Stack list.

STACK UP 

Click the button to move the highlighted participant/group up one position in the 
Stack list.
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SEND

Click the button to send the page. The Transmit indicator appears on the selected Radio 
Channel control(s) and a text message appears in the Status area.

When the Transmit indicator on the Radio Channel control disappears or, if configured, 
a green Talkdown indicator appears on the Man Page button, you can send a voice 
message:

Click the Common Transmit button or press the PTT button or footswitch and speak 
into your headset or microphone. To end the voice message, release the Common 
Transmit button or the PTT button or the footswitch.

ABORT

Click the button to cancel this page and remain in the Paging Facility dialog box.

CLEAR STACK

Click the button to remove all participants in the Stack list.

PAGE LIST AREA (RIGHT OF STACK AREA, NO LABEL)

PAGE LIST TABS 

Displays all available participants/groups in the tabbed group. The participants/
groups are customizable when in Edit Mode. Highlight participants/groups you wish 
to put in the Stack list. The highlighted participants/groups automatically appear in 
the Stack list.

STATUS AREA

STATUS

Displays a text message about the status of the page.

STATUS AREA BUTTONS

CLEAR

Click the button to clear the Status text box.

BUTTONS

CLOSE

Click the button to close the Paging Facility dialog box.
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CALLER ID COMMAND

This command is only available to supervisors. For more information, see the MIP 5000 
VoIP Radio Console Supervisor Manual (6881013Y33).

ENTER RAC COMMAND

If configured at the CSDM (Auto RAC), choosing the Enter RAC (repeater access code) 
command from the Tools menu opens the Enter RAC dialog box where you can 
establish communication through a repeater.

The specific RAC chooses which repeater is accessed. The program stores the RAC in 
memory and uses it each time you transmit, so that each transmission accesses the 
same repeater. See “Establishing Communications Through a RAC-enabled Repeater” 
on page 2-77 for more information.

ENTER RAC DIALOG BOX

Tools > Enter RAC

You use this dialog box to enter a repeater access code (RAC) on a per Radio Channel 
control basis to establish communication through a repeater, either manually or via pre-
programmed codes (MDC Unit Alias).

FIGURE 4-14  ENTER RAC DIALOG BOX
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CODE AREA

CODE

Displays the current repeater access code, the MDC Unit (repeater) RAC or the code 
you enter with the Keypad.

CODE AREA BUTTONS

CLEAR

Click the button to clear the entire Code text box.

BACK

Click the button to clear the last entered character in the Code text box.

KEYPAD AREA

KEYPAD

Enter the repeater access code for the repeater you wish to access. The characters you 
enter appear in the Code text box.

CHANNEL AREA

CHANNEL

Displays the available Radio Channel control labels. Click the down arrow and from 
the drop-down list select the Radio Channel control you wish to access a repeater with. 

Only Radio Channel controls configured for STAT-ALERT signaling (in the CSDM) 
appear in this list. 

The MDC Unit Alias list displays all the MDC Unit aliases associated with this Radio 
Channel control.

MDC UNIT ALIAS AREA

MDC UNIT LIST

Displays a list of MDC Unit aliases available for this Radio Channel control. Highlight 
your choice before clicking the Select Alias button. The MDC Unit list is maintained in 
the Caller ID database.

MDC UNIT ALIAS AREA BUTTONS

SELECT ALIAS

Click the button to select the MDC Unit Alias for the repeater. The RAC associated with 
this alias displays in the Code text box.
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BUTTONS

OK

Click the button to save the newly entered RAC and close the Enter RAC dialog box.

CANCEL

Click the button to close the dialog box without changing the RAC.
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HELP MENU

The Help menu provides access to the online help, search capabilities and information 
about the program.

The Help menu contains the following commands:

• “What’s This Command” on page 4-23

• “Help Topics Command” on page 4-23

• “About Command” on page 4-23

FIGURE 4-15  HELP MENU

WHAT’S THIS COMMAND

Selecting the What’s This? command places a question mark next to your cursor. Select 
a section of an open dialog box or window that you need help with and the relevant 
help topic is opened in the Help Topics dialog box.

HELP TOPICS COMMAND

The Help Topics command opens the Help Topics window, which offers the Contents, 
Index, Search, and Favorites tabs to help you find the information you need. 

ABOUT COMMAND

This command on the Help menu opens the About dialog box where the program 
information, version number, and copyright information regarding the MIP 5000 VoIP 
Radio Console program is displayed. 

This online help file was built on Friday, October 1, 2010.
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ABOUT DIALOG BOX

Help > About

You use this dialog box to display program information, license information, version 
number and copyright information regarding the MIP 5000 VoIP Radio Console 
program.

FIGURE 4-16  ABOUT DIALOG BOX

This dialog box also gives you information about:

• License status — indicates a license status of: Trial Period, Trial Period Expired, 
or Activated.

• Number of channels — identifies number of channels this console is licensed for

• Console version — identifies the software version number and date

• User Name — identifies the user currently logged in at this console

• Configuration file — identifies the name of the current configuration file

• DCPM version — identifies this console’s identification number

BUTTONS

CLOSE

Click this button to close the About dialog box.

This online help file was built on Friday, October 1, 2010.
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ABS — Acrylonitrile-Butadiene-Styrene, a durable, fire-resistant plastic.

AC — See Alternating current.

ACO — Alarm cut off.

AGC — Automatic gain control.

APB — All points bulletin.

Alternating current — Electrical current that flows in alternately in one direction then 
the other, such as supplied by most electrical power grids for public consumption.

Channel — The radio's channel communication is one of the following:

• transmit frequency only-for one-way communication

• receive frequency only-for one-way communication

• simplex frequency-using one frequency for two-way communication, one-way at 
a time

• half-duplex or two frequency simplex-using a separate transmit and receive 
frequency for two-way communication, one-way at a time 

• full-duplex frequencies-using a separate transmit and receive frequency for two-
way simultaneous communication

COM, Com — Usually “communications” as in the COM port on a PC, a serial 
communications port; also “common ground” as in the Com port on an I/O module.

Console System Database Manager (CSDM) — A configuration and maintenance 
tool for the MIP 5000 system. The CSDM is used to configure MIP 5000 VoIP Radio 
Consoles and MIP 5000 Gateways.

CPU — Central processing unit

CSDM — See Console System Database Manager (CSDM).

CTCSS — Continuous tone carrier squelch system.

Data root path — The route to the top-level folder of a folder structure for storing data 
files. The top-level folder is intended to hold subfolders, not data files. When first 
created, it is empty. For example, the following is a MIP 5000 data root path:

• C:\Documents and Settings\All Users\Application Data

Following are examples of two separate data branches from this data root path:

• C:\Documents and Settings\All Users\Application Data\Motorola\MIP 5000\OIM

• C:\Documents and Settings\All Users\Application Data\Motorola\MIP 5000\DCPM
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dB — Decibel; a unit used to express relative difference in power, usually between 
acoustic or electric signals, equal to ten times the common logarithm of the ratio of the 
two levels.

dBm — Decibel relative to 1 milliwatt.

DC — See Direct current.

Deskmic — Desktop microphone

Direct current — Electrical current that flows in one direction only, such as supplied 
by a battery

DTMF — Dual tone multiple frequency.

Emerg — Emergency.

EMI — Electromagnetic interference.

ESD — Electrostatic discharge.

Feedback — The return of some of the output of a system to the input of the same 
system. In the case of audio systems, feedback can cause speakers to emit a high-
pitched squeal or an echo that severely impairs sound quality from the speakers.

Frequency Coupled — The radio channel has a fixed transmit and receive frequency 
pair for simplex or duplex operation. For more information, see Radio channel.

Graphical User Interface (GUI) — An icon-based user interface.

GUI — See Graphical User Interface (GUI).

Hangover delay — The hangover delay is a period of time after incoming audio has 
stopped that the system will consider that the channel is still in use.

HASP key — A proprietary, hardware-based, cross-platform software copy protection 
and licensing system that plugs into a USB port. (HASP stands for Hardware Against 
Software Piracy.)

Hz — A measure of frequency equal to the number of cycles per second.

Internet Protocol (IP) — A protocol used for carrying packets of data primarily in 
Ethernet based systems.

IP, Ip — See Internet Protocol (IP).

IP Multicast — A protocol for efficiently sending to multiple receivers at the same time 
on a TCP/IP network, by use of a multicast address. It is a feature used especially in 
RTP. Multicasting permits a message that is transmitted once to be received at many 
network nodes.

Jitter — The unwanted, abrupt variation of one or more signal characteristics, such as 
frequency or phase of successive cycles.

k — Kilo (1,000)

kHz — Kilohertz; that is, one thousand Hertz (1,000 cycles per second)

LAN — See Local area network (LAN).

LED — Light emitting diode
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Local area network (LAN) — A network that connects computers together within an 
office complex

mA — Milli-Amperes.

MAC Address — A Media access control (MAC) address is a network address that 
uniquely identifies each node of a network. The MAC addresses used by the MIP 5000 
system are based on the Ethernet MAC-48 specification. Each MAC address uses 48 
bits, which provides a range of 281,474,976,710,656 possible addresses.

Mbps — Megabits (millions of bits) per second.

MDC — Mobile data communications.

MIC  — Microphone.

ms — Millisecond (1/1000 of a second).

Multicast address — An identifier for a group of hosts that have joined a multicast 
group.

Multi-Sel — Multiple selection.

PC — See Personal computer (PC).

Personal computer (PC) — An IBM-compatible single-user computer.

Prog — Program.

PTT — See Push-to-talk (PTT).

Push-to-talk (PTT) — The way a subscriber initiates a call. When the PTT switch on a 
radio is pressed (also known as keying up), this indicates that a call is being initiated by 
a user. Also known as press-to-talk.

Radio frequency (RF) — General term for the range of frequencies at which used in 
radio communication systems. 

RAC — Repeater access code.

Radio channel — In radio technology, the radio's channel communication is one of the 
following:

• transmit frequency only—for one-way communication

• receive frequency only—for one-way communication

• simplex frequency—using one frequency for two-way communication, one-way 
at a time

• half-duplex or two frequency simplex—using a separate transmit and receive 
frequency for two-way communication, one-way at a time 

• full-duplex frequencies—using a separate transmit and receive frequency for two-
way simultaneous communication

RCU — Remote control unit

Real-time transport control protocol (RTCP) — An Internet protocol for providing 
out-of-band control information about RTP flows, such as quality of service feedback.

Real-time transport protocol (RTP) — An Internet protocol for transmitting real-time 
data, such as audio or video.
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Resources — A general term for network infrastructure and radio channels. Also 
buttons that executes features related to network infrastructure and radio channels.

RF — See Radio frequency (RF).

RFI — Radio frequency interference.

RTCP — See Real-time transport control protocol (RTCP).

RTP — See Real-time transport protocol (RTP).

RX, Rx — Receive/received/receiving.

SVGA — Super video graphics array.

Talkaround — Use of radio channel by a mobile radio to communicate directly to other 
mobile radios on the system by bypassing (or talking around) the repeater.

Talkdown — A period of time following a page when the microphone of the console 
issuing the page is keyed. During this time period, a dispatcher can add a voice 
annotation to the page by speaking into the microphone. In the MIP 5000 VoIP Radio 
Console, the talkdown (or voice annotation) period is set in the CSDM.

TCP/IP — Transmission Control Protocol/Internet Protocol.

TX, Tx — Transmit/transmitted/transmitting.

Universal serial bus (USB) — An external data bus supporting high-speed data 
transfer rates. A USB port on a computer can be used to connect a large and varied 
range of peripheral equipment.

UPS — Uninterruptable power supply.

USB — See Universal serial bus (USB).

VDC — DC volts.

Voice annotation delay — The time that the radio channel is held open (keyed) for the 
dispatcher to send a voice message.

Voice over Internet Protocol (VoIP) — A method of transmitting audio signals, 
including the human voice on IP networks.

VOL — Volume.

VOX — voice operated switch.

VU — Volume Unit; a volume meter that visually indicates the volume over time, 
usually by means of green, red, and amber rectangles that form a bar graph.
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